Excel Dashboards & Reports for Dummies

Learn to:
- Analyze data and report it in a way that makes sense
- Slice and dice data from different perspectives
- Create eye-catching and understandable reports, visualizations, and dashboards
- Automate redundant reporting

Michael Alexander
Microsoft MVP
Excel®
Dashboards & Reports
FOR DUMMIES
3rd Edition
Contents at a Glance

Introduction ................................................................ 1

Part I: Getting Started with Excel
Dashboards & Reports.................................................. 7
Chapter 1: Getting In the Dashboard State of Mind................................. 9
Chapter 2: Building a Super Model............................................................ 25

Part II: Building Basic Dashboard Components .......... 51
Chapter 3: Dressing Up Your Data Tables ............................................ 53
Chapter 4: Sparking Inspiration with Sparklines .................................. 69
Chapter 5: Formatting Your Way to Visualizations............................... 83
Chapter 6: The Pivotal Pivot Table............................................................ 115

Part III: Building Advanced Dashboard Components ... 151
Chapter 7: Charts That Show Trending .................................................... 153
Chapter 8: Grouping and Bucketing Data .............................................. 179
Chapter 9: Displaying Performance against a Target............................ 201

Part IV: Advanced Reporting Techniques ..................... 217
Chapter 10: Macro-Charged Dashboarding ............................................. 219
Chapter 11: Giving Users an Interactive Interface................................ 233
Chapter 12: Adding Interactivity with Pivot Slicers .............................. 255

Part V: Working with the Outside World .................. 273
Chapter 13: Using External Data for Your Dashboards and Reports .......... 275
Chapter 14: Sharing Your Workbook with the Outside World.............. 301

Part VI: The Part of Tens .......................................... 323
Chapter 15: Ten Chart Design Principles ............................................. 325
Chapter 16: Ten Excel Chart Types and When to Use Them ................. 339

Index ...................................................................... 345
# Table of Contents

## Introduction ........................................................................................................... 1

- About This Book ........................................................................................................ 2
- Foolish Assumptions .................................................................................................. 3
- How This Book Is Organized ...................................................................................... 3
  - Part I: Getting Started with Excel Dashboards & Reports .......................... 3
  - Part II: Building Basic Dashboard Components ......................................... 4
  - Part III: Building Advanced Dashboard Components ................................... 4
  - Part IV: Advanced Reporting Techniques ....................................................... 4
  - Part V: Working with the Outside World ......................................................... 4
  - Part VI: The Part of Tens ................................................................................. 5

## Icons Used In This Book ....................................................................................... 5

## Beyond the Book ...................................................................................................... 6

## Where to Go from Here ........................................................................................... 6

## Part I: Getting Started with Excel Dashboards & Reports ...................................... 7

### Chapter 1: Getting In the Dashboard State of Mind ................................................. 9

- Defining Dashboards and Reports ......................................................................... 9
- Defining reports ....................................................................................................... 10
- Defining dashboards ............................................................................................... 10
- Preparing for Greatness .......................................................................................... 11
  - Establish the audience for, and purpose of, the dashboard ......................... 12
  - Delineate the measures for the dashboard ....................................................... 13
  - Catalog the required data sources ................................................................... 14
  - Define the dimensions and filters for the dashboard ....................................... 15
  - Determine the need for drill-down features ..................................................... 15
  - Establish the refresh schedule ......................................................................... 16
- A Quick Look at Dashboard Design Principles ...................................................... 16
  - Rule number 1: Keep it simple ........................................................................... 17
  - Use layout and placement to draw focus .......................................................... 18
  - Format numbers effectively .............................................................................. 19
  - Use titles and labels effectively ........................................................................ 20
- Key Questions to Ask Before Distributing Your Dashboard .................................. 21
  - Does my dashboard present the right information? ......................................... 21
  - Does everything on my dashboard have a purpose? ....................................... 21
  - Does my dashboard prominently display the key message? .......................... 21

www.allitebooks.com
Can I maintain this dashboard? .........................................................22
Does my dashboard clearly display its scope and shelf life?........22
Is my dashboard well documented? ..................................................23
Is my dashboard user-friendly?..........................................................23
Is my dashboard accurate?.................................................................24

Chapter 2: Building a Super Model ....................................................25
Data Modeling Best Practices ..............................................................25
Separating data, analysis, and presentation ....................................26
Starting with appropriately structured data ..................................29
Avoiding turning your data model into a database .........................32
Using tabs to document and organize your data model .................33
Testing your data model before building reporting
components on top of it..................................................................35
Excel Functions That Really Deliver ....................................................35
The VLOOKUP function ..................................................................36
The HLookup function ...................................................................39
The Sumproduct function ...............................................................41
The Choose function ......................................................................44
Using Smart Tables That Expand with Data .....................................46
Converting a range to an Excel table .............................................47
Converting an Excel table back to a range ....................................49

Part II: Building Basic Dashboard Components .......................51

Chapter 3: Dressing Up Your Data Tables ..................................53
Table Design Principles ....................................................................53
Use colors sparingly ........................................................................54
De-emphasize borders ....................................................................55
Use effective number formatting ....................................................58
Subdue your labels and headers ......................................................59
Getting Fancy with Custom Number Formatting .........................61
Number formatting basics ...............................................................61
Formatting numbers in thousands and millions .........................63
Hiding and suppressing zeroes .......................................................65
Applying custom format colors .......................................................66
Formatting dates and times ..............................................................67

Chapter 4: Sparking Inspiration with Sparklines ........................69
Introducing Sparklines .................................................................69
Understanding Sparklines ..............................................................71
Creating sparklines ........................................................................72
Understanding sparkline groups ....................................................74
Customizing Sparklines ................................................................. 75
Sizing and merging sparkline cells .................................................. 75
Handling hidden or missing data .................................................... 76
Changing the sparkline type .......................................................... 77
Changing sparkline colors and line width ....................................... 77
Using color to emphasize key data points ...................................... 77
Adjusting sparkline axis scaling ..................................................... 78
Faking a reference line .................................................................. 79
Specifying a date axis .................................................................... 80
Autoupdating sparkline ranges ...................................................... 82

Chapter 5: Formatting Your Way to Visualizations ......................... 83
Enhancing Reports with Conditional Formatting ............................... 83
Applying basic conditional formatting .......................................... 84
Adding your own formatting rules manually ................................. 92
Showing only one icon .................................................................. 97
Showing Data Bars and icons outside of cells ............................... 99
Representing trends with Icon Sets ............................................... 101
Using Symbols to Enhance Reporting .......................................... 103
Wielding the Magical Camera Tool .............................................. 107
Finding the Camera tool ............................................................... 107
Using the Camera tool ................................................................. 108
Enhancing a dashboard with the Camera tool .............................. 110
Making Waffles with Conditional Formatting and the Camera Tool ................................................................. 111

Chapter 6: The Pivotal Pivot Table .................................................. 115
An Introduction to the Pivot Table .................................................. 115
The Four Areas of a Pivot Table ..................................................... 116
Values area .................................................................................. 116
Row area ...................................................................................... 116
Column area ................................................................................ 117
Filter area .................................................................................... 118
Creating Your First Pivot Table ..................................................... 118
Changing and rearranging your pivot table ................................... 122
Adding a report filter ................................................................... 124
Keeping your pivot table fresh ..................................................... 124
Customizing Pivot Table Reports .................................................. 126
Changing the pivot table layout .................................................... 126
Customizing field names ............................................................. 127
Applying numeric formats to data fields ...................................... 129
Changing summary calculations ................................................... 130
Suppressing subtotals ................................................................. 131
Showing and hiding data items ..................................................... 134
Hiding or showing items without data ......................................... 136
Sorting your pivot table ............................................................... 138
Creating Useful Pivot-Driven Views ........................................................... 139
Producing top and bottom views ............................................................ 139
Creating views by month, quarter, and year ........................................ 143
Creating a percent distribution view ..................................................... 146
Creating a YTD totals view ................................................................. 147
Creating a month-over-month variance view ..................................... 148

Part III: Building Advanced Dashboard Components .... 151

Chapter 7: Charts That Show Trending ................................................. 153
  Trending Dos and Don’ts ................................................................. 153
  Using chart types appropriate for trending ..................................... 154
  Starting the vertical scale at zero .................................................... 156
  Leveraging Excel’s logarithmic scale .............................................. 158
  Applying creative label management .............................................. 159
  Comparative Trending ................................................................. 162
  Creating side-by-side time comparisons ......................................... 162
  Creating stacked time comparisons ............................................... 165
  Trending with a secondary axis ...................................................... 166
  Emphasizing Periods of Time ........................................................ 168
  Formatting specific periods ........................................................... 169
  Using dividers to mark significant events ...................................... 170
  Representing forecasts in your trending components ..................... 171
  Other Trending Techniques .......................................................... 173
  Avoiding overload with directional trending ..................................... 173
  Smoothing data ........................................................................... 174

Chapter 8: Grouping and Bucketing Data ............................................. 179
  Creating Top and Bottom Displays ................................................... 179
  Incorporating top and bottom displays into dashboards ................. 180
  Using pivot tables to get top and bottom views ............................. 181
  Top Values in Charts ................................................................... 184
  Using Histograms to Track Relationships and Frequency .............. 188
  Creating a formula-driven histogram ............................................. 189
  Adding a cumulative percent ........................................................ 191
  Using a pivot table to create a histogram ...................................... 195
  Using Excel’s Histogram statistical chart ...................................... 197

Chapter 9: Displaying Performance against a Target ............................ 201
  Showing Performance with Variances ............................................. 201
  Showing Performance against Organizational Trends ..................... 202
  Using a Thermometer-Style Chart ............................................... 204
Using a Bullet Graph................................................................. 205
Creating a bullet graph............................................................ 206
Adding data to your bullet graph ............................................. 210
Final thoughts on formatting bullet graphs............................. 210
Showing Performance against a Target Range ....................... 213

Part IV: Advanced Reporting Techniques ......................... 217

Chapter 10: Macro-Charged Dashboarding .............................. 219
Why Use a Macro? ................................................................. 219
Recording Your First Macro ..................................................... 220
Running Your Macros ............................................................ 224
Enabling and Trusting Macros ................................................ 227
Understanding macro-enabled file extensions ....................... 227
Enabling macro content ....................................................... 228
Setting up trusted locations ................................................... 228
Examining Some Macro Examples ........................................ 229
Building navigation buttons .................................................. 229
Dynamically rearranging pivot table data ............................... 230
Offering one-touch reporting options .................................... 231

Chapter 11: Giving Users an Interactive Interface ................. 233
Getting Started with Form Controls ...................................... 233
Finding Form controls ........................................................... 234
Adding a control to a worksheet ............................................ 236
Using the Button Control ....................................................... 237
Using the Check Box Control ................................................ 238
Toggling a Chart Series On and Off ...................................... 239
Using the Option Button Control .......................................... 242
Showing Many Views through One Chart ............................... 243
Using the Combo Box Control .............................................. 246
Changing Chart Data with a Drop-Down Selector .................. 247
Using the List Box Control .................................................... 249
Controlling Multiple Charts with One Selector ...................... 250

Chapter 12: Adding Interactivity with Pivot Slicers ............... 255
Understanding Slicers .......................................................... 255
Creating a Standard Slicer ..................................................... 258
Getting Fancy with Slicer Customizations ......................... 260
Size and placement ............................................................. 260
Data item columns .............................................................. 261
Other slicer settings .......................................................... 262
Creating your own Slicer Style ............................................. 262
Controlling Multiple Pivot Tables with One Slicer .................................. 265
Creating a Timeline Slicer ........................................................................... 266
Using Slicers as Form Controls .................................................................. 269

**Part V: Working with the Outside World** ..................... 273

**Chapter 13: Using External Data for Your Dashboards and Reports** .......................... 275
- Importing Data from Microsoft Access ..................................................... 275
  - The drag-and-drop method .............................................................. 276
  - The Microsoft Access Export wizard ............................................... 277
  - The Get External Data icon ............................................................... 278
- Importing Data from SQL Server .......................................................... 283
- Leveraging Power Query to Extract and Transform Data ...................... 286
  - Reviewing Power Query basics ........................................................ 287
  - Understanding query steps .............................................................. 292
  - Refreshing Power Query data ............................................................ 294
  - Managing existing queries .............................................................. 296
- Examining Power Query connection types ........................................... 298

**Chapter 14: Sharing Your Workbook with the Outside World** ...... 301
- Protecting Your Dashboards and Reports ................................................. 301
  - Securing access to the entire workbook ............................................ 302
  - Limiting access to specific worksheet ranges ...................................... 305
  - Protecting the workbook structure ..................................................... 308
- Linking Your Excel Dashboards to PowerPoint ....................................... 310
  - Creating a link between Excel and PowerPoint .................................... 310
  - Manually updating links to capture updates ....................................... 312
  - Automatically updating links ............................................................ 313
- Distributing Your Dashboards via a PDF ............................................... 315
- Distributing Your Dashboards to OneDrive ............................................. 317
- Limitations When Publishing to the Web ............................................... 320

**Part VI: The Part of Tens** ........................................... 323

**Chapter 15: Ten Chart Design Principles** ................................. 325
- Avoid Fancy Formatting .............................................................................. 325
- Skip the Unnecessary Chart Junk ............................................................. 327
- Format Large Numbers Where Possible .................................................. 329
- Use Data Tables Instead of Data Labels .................................................. 330
- Make Effective Use of Chart Titles .......................................................... 332
- Sort Your Data before Charting .............................................................. 333
Introduction

The term business intelligence (BI), coined by Howard Dresner of Gartner, Inc., describes the set of concepts and methods to improve business decision-making by using fact-based support systems. Practically speaking, BI is what you get when you analyze raw data and turn that analysis into knowledge. BI can help an organization identify cost-cutting opportunities, uncover new business opportunities, recognize changing business environments, identify data anomalies, and create widely accessible reports.

Over the past few years, the BI concept has overtaken corporate executives who are eager to turn impossible amounts of data into knowledge. As a result of this trend, whole industries have been created. Software vendors that focus on BI and dashboarding are coming out of the woodwork. New consulting firms touting their BI knowledge are popping up virtually every week. And even the traditional enterprise solution providers, like Business Objects and SAP, are offering new BI capabilities.

This need for BI has manifested itself in many forms. Most recently, it has come in the form of dashboard fever. Dashboards are reporting mechanisms that deliver business intelligence in a graphical form.

Maybe you’ve been hit with dashboard fever. Or maybe your manager is hitting you with dashboard fever. Nevertheless, you’re probably holding this book because you’re being asked to create BI solutions (that is, dashboards) in Excel.

Although many IT managers would scoff at the thought of using Excel as a BI tool, Excel is inherently part of the enterprise BI tool portfolio. Whether or not IT managers are keen to acknowledge it, most of the data analysis and reporting done in business today is done by using a spreadsheet. You have several significant reasons to use Excel as the platform for your dashboards and reports, including

- **Tool familiarity:** If you work in corporate America, you are conversant in the language of Excel. You can send even the most seasoned of senior vice presidents an Excel-based reporting tool and trust that he will know what to do with it. With an Excel reporting process, your users spend less time figuring out how to use the tool and more time looking at the data.

- **Built-in flexibility:** In most enterprise dashboarding solutions, the capability to perform analyses outside the predefined views is either disabled or unavailable. How many times have you dumped
enterprise-level data into Excel so that you can analyze it yourself? I know I have. You can bet that if you give users an inflexible reporting mechanism, they’ll do what it takes to create their own usable reports. In Excel, features such as pivot tables, autofilters, and Form controls let you create mechanisms that don’t lock your audience into one view. And because you can have multiple worksheets in one workbook, you can give your audience space to do their own side analysis as needed.

❖ **Rapid development**: Building your own reporting capabilities in Excel can liberate you from the IT department’s resource and time limitations. With Excel, not only can you develop reporting mechanisms faster, but you also have the flexibility to adapt more quickly to changing requirements.

❖ **Powerful data connectivity and automation capabilities**: Excel is not the toy application some IT managers make it out to be. With its own native programming language and its robust object model, Excel can be used to automate processes and even connect to various data sources. With a few advanced techniques, you can make Excel a hands-off reporting mechanism that practically runs on its own.

❖ **Little to no incremental costs**: Not all of us can work for multibillion-dollar companies that can afford enterprise-level reporting solutions. In most companies, funding for new computers and servers is limited, let alone funding for expensive BI reporting packages. For those companies, leveraging Microsoft Office is frankly the most cost-effective way to deliver key business reporting tools without compromising too deeply on usability and functionality.

All that being said, it’s true that Excel has so many reporting functions and tools that it’s difficult to know where to start. Enter your humble author, spirited into your hands via this book. Here, I show you how you can turn Excel into your own, personal BI tool. Using a few fundamentals and some of the new BI functionality that Microsoft has included in this latest version of Excel, you can go from reporting data with simple tables to creating meaningful reporting components that are sure to wow management.

**About This Book**

The goal of this book is to show you how to leverage Excel functionality to build and manage better reporting mechanisms. Each chapter in this book provides a comprehensive review of the technical and analytical concepts that help you create better reporting components — components that can be used for both dashboards and reports. It’s important to note that this book is not a guide to visualizations or dashboarding best practices — although those subjects are worthy of their own book. This book is focused on the technical aspects of using Excel’s various tools and functionality and applying them to reporting.
The chapters in this book are designed to be stand-alone chapters that you can selectively refer to as needed. As you move through this book, you’ll be able to create increasingly sophisticated dashboard and report components. After reading this book, you’ll be able to

✓ Analyze large amounts of data and report them in a meaningful way.
✓ Gain better visibility into data from different perspectives.
✓ Quickly slice data into various views on the fly.
✓ Automate redundant reporting and analyses.
✓ Create interactive reporting processes.

Foolish Assumptions

I make three assumptions about you as the reader. I assume that you

✓ Have already installed Microsoft Excel.
✓ Have some familiarity with the basic concepts of data analysis, such as working with tables, aggregating data, and performing calculations.
✓ Have a strong grasp of basic Excel concepts such as managing table structures, creating formulas, referencing cells, filtering, and sorting.

How This Book Is Organized

The chapters in this book are organized into six parts. Each of these parts includes chapters that build on the previous chapters’ instruction. The idea is that as you go through each part, you will be able to build dashboards of increasing complexity until you’re an Excel reporting guru.

Part I: Getting Started with Excel Dashboards & Reports

Part I is all about helping you think about your data in terms of creating effective dashboards and reports. Chapter 1 introduces you to the topic of dashboards and reports, giving you some of the fundamentals and basic ground rules for creating effective dashboards and reports. Chapter 2 shows you a few concepts around data structure and layout. In this chapter, you will learn the impact of a poorly planned data set and will discover the best practices for setting up the source data for your dashboards and reports.
Part II: Building Basic Dashboard Components

In Part II, you take an in-depth look at some of the basic dashboard components you can create using Excel. Chapter 3 starts you off with some fundamentals around designing effective data tables. Chapter 4 shows you how you can leverage the Sparkline functionality found in Excel. Chapter 5 provides a look at the various techniques that you can use to visualize data without the use of charts or graphs. Chapter 6 rounds out this section of the book by introducing you to pivot tables and discussing how a pivot table can play an integral role in Excel-based dashboards.

Part III: Building Advanced Dashboard Components

In Part III you go beyond the basics to take a look at some of the advanced chart components you can create with Excel. This part consists of three chapters, starting with Chapter 7, where I demonstrate how to represent time trending, seasonal trending, moving averages and other types of trending in dashboards. In Chapter 8, you explore the many methods used to bucket data — putting data into groups for reporting, in other words. Finally, Chapter 9 demonstrates some of charting techniques that can help you display and measure values versus goals.

Part IV: Advanced Reporting Techniques

Part IV focuses on techniques that can help you automate your reporting processes, and give your users an interactive user interface. Chapter 10 provides a clear understanding of how macros can be leveraged to supercharge and automate your reporting systems. Chapter 11 illustrates how you can provide your clients with a simple interface, allowing them to easily navigate through (and interact with) their reporting systems. Chapter 12 shows you how pivot slicers can add interactive filtering capabilities to your pivot reporting.

Part V: Working with the Outside World

The theme in Part V is importing and exporting information to and from Excel. Chapter 13 explores some of the ways to incorporate data that does not originate in Excel. In this chapter, you find out how to import data from
external sources as well as create systems that allow for dynamic refreshing of external data sources. Chapter 14 wraps up this book on Excel dashboards and reports by showing you the various ways to distribute and present your work.

**Part VI: The Part of Tens**

Part VI is the classic Part of Tens section found in *Dummies* series titles. The chapters found here each present ten or more pearls of wisdom, delivered in bite sized pieces. In Chapter 15, I share with you ten or so chart-building best practices, helping you design more effective charts. Chapter 16 offers a rundown of the ten most commonly used chart types, along with advice on when to use each one.

**Icons Used In This Book**

As you read this book, you’ll see icons in the margins that indicate material of interest (or not, as the case may be). This section briefly describes each icon in this book.

Tips are nice because they help you save time or perform a task without having to do a lot of extra work. The tips in this book are time-saving techniques or pointers to resources that you should try in order to get the maximum benefit from Excel.

Try to avoid doing anything marked with a Warning icon, which (as you might expect) represents a danger of one sort or another.

Whenever you see this icon, think *advanced* tip or technique. You might find these tidbits of useful information too boring for words, or they could contain the solution you need to get a program running. Skip these bits of information whenever you like.

If you don’t get anything else out of a particular chapter or section, remember the material marked by this icon. This text usually contains an essential process or a bit of information you ought to remember.
Beyond the Book

A lot of extra content that you won’t find in this book is available at www.dummies.com. Go online to find the following:

✓ Excel files used in the examples in this book can be found at
  www.dummies.com/extras/exceldashboardsreports

This book contains a lot of exercises in which you create and modify tables and Excel workbook files. If you want to follow the exercise but don’t have time to, say, create your own data table, just download the data from the Dummies.com website at www.dummies.com/extras/exceldashboardsreports. The files are organized by chapter.

✓ Online articles covering additional topics at
  www.dummies.com/extras/exceldashboardsreports

At this page, you’ll find out how to use conditional formatting to build annotations into your charts, add an extra dynamic layer of analysis to your charts, and create dynamic labels, among other details to aid you in your Excel dashboards journey.

✓ The Cheat Sheet for this book is at
  www.dummies.com/cheatsheet/exceldashboardsreports

Here, you’ll find an extra look at how you can use fancy fonts like Wingdings and Webdings to add visualizations to your dashboards and reports. You’ll also find a list of websites you can visit to get ideas and fresh new perspectives on building dashboards.

✓ Updates to this book, if we have any, are also available at
  www.dummies.com/extras/exceldashboardsreports

Where to Go from Here

It’s time to start your Excel dashboarding adventure! If you’re a complete dashboard novice, start with Chapter 1 and progress through the book at a pace that allows you to absorb as much of the material as possible. If you’re an Excel whiz, skip to Part III, which covers advanced topics.
Part I

Getting Started with Excel
Dashboard & Reports

goinging started with Excel
Dashboard & Reports

Go to www.dummies.com for great Dummies content online.
In this part . . .

- Discover how to think about your data in terms of creating effective dashboards and reports.
- Get a solid understanding of the fundamentals and basic ground rules for creating effective dashboards and reports.
- Uncover the best practices for setting up the source data for your dashboards and reports.
- Explore the key Excel functions that help you build effective dashboard models.
Chapter 1

Getting In the Dashboard State of Mind

In This Chapter
▶ Comparing dashboards to reports
▶ Getting started on the right foot
▶ Dashboarding best practices

In his song “New York State of Mind,” Billy Joel laments the differences between California and New York. In this homage to the Big Apple, he implies a mood and a feeling that come with thinking about New York. I admit it’s a stretch, but I’ll extend this analogy to Excel — don’t laugh.

In Excel, the differences between building a dashboard and creating standard table-driven analyses are as great as the differences between California and New York. To approach a dashboarding project, you truly have to get into the dashboard state of mind. As you’ll come to realize in the next few chapters, dashboarding requires far more preparation than standard Excel analyses. It calls for closer communication with business leaders, stricter data modeling techniques, and the following of certain best practices. It’s beneficial to have a base familiarity with fundamental dashboarding concepts before venturing off into the mechanics of building a dashboard.

In this chapter, you get a solid understanding of these basic dashboard concepts and design principles as well as what it takes to prepare for a dashboarding project.

Defining Dashboards and Reports

It isn’t difficult to use report and dashboard interchangeably. In fact, the line between reports and dashboards frequently gets muddied. I’ve seen countless reports referred to as dashboards just because they included a few charts. Likewise, I’ve seen many examples of what could be considered dashboards but have been called reports.
Now, this may all seem like semantics to you, but it's helpful to clear the air and understand the core attributes of what are considered to be reports and dashboards.

**Defining reports**

The report is probably the most common application of business intelligence. A report can be described as a document that contains data used for reading or viewing. It can be as simple as a data table or as complex as a subtotaled view with interactive drill-downs, similar to Excel’s Subtotal or Pivot Table functionality.

The key attribute of a report is that it doesn’t lead a reader to a predefined conclusion. Although reports can include analysis, aggregations, and even charts, reports often allow for the end users to apply their own judgment and analysis to the data.

To clarify this concept, Figure 1-1 shows an example of a report. This report shows the National Park overnight visitor statistics by period. Although this data can be useful, it’s clear this report isn’t steering the reader toward any predefined judgment or analysis; it’s simply presenting the aggregated data.

![Figure 1-1: Reports present data for viewing but don’t lead readers to conclusions.](image)

**Defining dashboards**

A dashboard is a visual interface that provides at-a-glance views into key measures relevant to a particular objective or business process. Dashboards have three main attributes:

- Dashboards are typically graphical in nature, providing visualizations that help focus attention on key trends, comparisons, and exceptions.
Chapter 1: Getting In the Dashboard State of Mind

- Dashboards often display only data that are relevant to the goal of the dashboard.

- Because dashboards are designed with a specific purpose or goal, they inherently contain predefined conclusions that relieve the end user from performing his own analysis.

Figure 1-2 illustrates a dashboard that uses the same data shown in Figure 1-1. This dashboard displays key information about the national park overnight-visitor stats. As you can see, this presentation has all the main attributes that define a dashboard. First, it’s a visual display that allows you to quickly recognize the overall trending of the overnight-visitor stats. Second, you can see that not all the detailed data is shown here — you see only the key pieces of information relevant to support the goal of this dashboard, which in this case would be to get some insights on which parks would need some additional resources to increase visitor rates. Finally, by virtue of its objective, this dashboard effectively presents you with analysis and conclusions about the trending of overnight visitors.

Preparing for Greatness

Imagine that your manager asks you to create a dashboard that tells him everything he should know about monthly service subscriptions. Do you jump to action and slap together whatever comes to mind? Do you take a guess at what he wants to see and hope it’s useful? These questions sound ridiculous, but these types of situations happen more than you think. I’m
Part I: Getting Started with Excel Dashboards & Reports

continually called to create the next great reporting tool but am rarely provided the time to gather the true requirements for it. Between limited information and unrealistic deadlines, the end product often ends up being unused or having little value.

This brings me to one of the key steps in preparing for dashboarding: collecting user requirements.

In the non-IT world of the Excel analyst, user requirements are practically useless because of sudden changes in project scope, constantly changing priorities, and shifting deadlines. The gathering of user requirements is viewed to be a lot of work and a waste of valuable time in the ever-changing business environment. But as I mention at the start of this chapter, it’s time to get into the dashboard state of mind.

Consider how many times a manager has asked you for an analysis and then said “No, I meant this.” Or “Now that I see it, I realize I need this.” As frustrating as this can be for a single analysis, imagine running into it again and again during the creation of a complex dashboard with several data integration processes. The question is, would you rather spend your time on the front end gathering user requirements or spend time painstakingly redesigning the dashboard you’ll surely come to hate?

The process of gathering user requirements doesn’t have to be an overly complicated or formal one. Here are some simple things you can do to ensure you have a solid idea of the purpose of the dashboard.

**Establish the audience for, and purpose of, the dashboard**

Chances are your manager has been asked to create the reporting mechanism and he has passed the task to you. Don’t be afraid to ask about the source of the initial request. Talk to the requesters about what they’re asking for. Discuss the purpose of the dashboard and the triggers that caused them to ask for a dashboard in the first place. You may find, after discussing the matter, that a simple Excel report meets their needs, foregoing the need for a full-on dashboard.

If a dashboard is indeed warranted, talk about who the end users are. Take some time to meet with a few of the end users to talk about how they’d use the dashboard. Will the dashboard be used as a performance tool for regional managers? Will the dashboard be used to share data with external customers? Talking through these fundamentals with the right people helps
align your thoughts and avoids the creation of a dashboard that doesn’t fulfill
the necessary requirements.

**Delineate the measures for the dashboard**

Most dashboards are designed around a set of measures, or *key performance
indicators (KPIs)*. A KPI is an indicator of the performance of a task deemed
to be essential to daily operations or processes. The idea is that a KPI reveals
performance that is outside the normal range for a particular measure, so it
therefore often signals the need for attention and intervention. Although the
measures you place into your dashboards may not officially be called KPIs, they
undoubtedly serve the same purpose — to draw attention to problem areas.

The topic of creating effective KPIs for your organization is a subject
worthy of its own book and is out of the scope of this endeavor. For a
detailed guide on KPI development strategies, pick up David Parmenter’s
*Key Performance Indicators: Developing, Implementing, and Using Winning
approach to developing and implementing KPIs.

The measures used on a dashboard should absolutely support the initial pur-
pose of that dashboard. For example, if you’re creating a dashboard focused on
supply chain processes, it may not make sense to have human resources head-
count data incorporated. It’s generally good practice to avoid nice-to-know data
in your dashboards simply to fill white space or because the data is available. If
the data doesn’t support the core purpose of the dashboard, leave it out.

Here’s another tip: When gathering the measures required for the dashboard,
I find that it often helps to write a sentence to describe the measure needed.
For example, rather than simply add the word *Revenue* into my user require-
ments, I write what I call a *component question*, such as “What is the overall
revenue trend for the past two years?” I call it a *component question* because
I intend to create a single component, such as a chart or a table, to answer
the question. For instance, if the component question is “What is the overall
revenue trend for the past two years?” you can imagine a chart component
answering this question by showing the two-year revenue trend.

I sometimes take this a step further and actually incorporate the component
questions into a mock layout of the dashboard to get a high-level sense of the
data the dashboard will require. Figure 1-3 illustrates an example.

Each box in this dashboard layout mockup represents a component on the
dashboard and its approximate position. The questions within each box
provide a sense of the types of data required to create the measures for the
dashboard.
Part I: Getting Started with Excel Dashboards & Reports

Catalog the required data sources

When you have the list of measures that need to be included on the dashboard, it’s important to take a tally of the available systems to determine whether the data required to produce those measures is available. Ask yourself the following questions:

- Do you have access to the data sources necessary?
- How often are those data sources refreshed?
- Who owns and maintains those data sources?
- What are the processes to get the data from those resources?
- Does the data even exist?

These are all questions you need answered when negotiating dashboard development time, data refresh intervals, and change management.

Conventional wisdom says that the measures on your dashboard shouldn’t be governed by the availability of data. Instead, you should let dashboard KPIs and measures govern the data sources in your organization. Although I agree with the spirit of that statement, I’ve been involved in too many...
dashboard projects that have fallen apart because of lack of data. Real-world experience has taught me the difference between the *ideal* and the *ordeal*.

If your organizational strategy requires that you collect and measure data that is nonexistent or not available, press Pause on the dashboard project and turn your attention to creating a data collection mechanism that will get the data you need.

**Define the dimensions and filters for the dashboard**

In the context of reporting, a *dimension* is a data category used to organize business data. Examples of dimensions are Region, Market, Branch, Manager, or Employee. When you define a dimension in the user requirements stage of development, you’re determining how the measures should be grouped or distributed. For example, if your dashboard should report data by employee, you need to ensure that your data collection and aggregation processes include employee detail. As you can imagine, adding a new dimension after the dashboard is built can get complicated, especially when your processes require many aggregations across multiple data sources. The bottom line is that locking down the dimensions for a dashboard early in the process definitely saves you headaches.

Along those same lines, you want to get a clear sense of the types of filters that are required. In the context of dashboards, *filters* are mechanisms that allow you to narrow the scope of the data to a single dimension. For example, you can filter on Year, Employee, or Region. Again, if you don’t account for a particular filter while building your dashboarding process, you’ll likely be forced into an unpleasant redesign of both your data collection processes and your dashboard.

If you’re confused by the difference between dimensions and filters, think about a simple Excel table. A dimension is like a column of data (such as a column containing employee names) in an Excel table. A filter, then, is the mechanism that allows you to narrow your table to show only the data for a particular employee. For example, if you apply Excel’s AutoFilter to the Employee column, you are building a filter mechanism into your table.

**Determine the need for drill-down features**

Many dashboards provide *drill-down features* that allow users to “drill” into the details of a specific measure. You want to get a clear understanding of the types of drill-downs your users have in mind.
To most users, *drill-down feature* means the ability to get a raw data table supporting the measures shown on the dashboard. Although getting raw data isn’t always practical or possible, discussing these requests will, at minimum, allow you to talk to your users about additional reporting, links to other data sources, and other solutions that may help them get the data they need.

**Establish the refresh schedule**

A *refresh schedule* refers to the schedule by which a dashboard is updated to show the latest information available. Because you’re the one responsible for building and maintaining the dashboard, you should have a say in the refresh schedules — your manager may not know what it takes to refresh the dashboard in question.

While you’re determining the refresh schedule, keep in mind the refresh rates of the different data sources whose measures you need to get. You can’t refresh your dashboard any faster than your data sources. Also, negotiate enough development time to build macros that aid in automation of redundant and time-consuming refresh tasks.

**A Quick Look at Dashboard Design Principles**

When collecting user requirements for your dashboarding project, there’s a heavy focus on the data aspects of the dashboard: the types of data needed, the dimensions of data required, the data sources to be used, and so on. This is a good thing — without solid data processes, your dashboards won’t be effective or maintainable. That being said, here’s another aspect to your dashboarding project that calls for the same fervor in preparation: the *design aspect*.

Excel users live in a world of numbers and tables, not visualization and design. Your typical Excel analysts have no background in visual design and are often left to rely on their own visual instincts to design their dashboards. As a result, most Excel-based dashboards have little thought given to effective visual design, often resulting in overly cluttered and ineffective user interfaces.

The good news is that dashboarding has been around for such a long time that there’s a vast knowledge base of prescribed visualization and dashboard design principles. Many of these principles seem like common sense; even so, these are concepts that Excel users don’t often find themselves thinking about. Because this chapter is about getting into the dashboard state of mind, I break that trend and review a few dashboard design principles that improve the look and feel of your Excel dashboards.
Chapter 1: Getting In the Dashboard State of Mind

Many of the concepts in this section come from the work of Stephen Few, a visualization expert and the author of several books and articles on dashboard design principles. This book is primarily focused on the technical aspects of building reporting components in Excel, but this section offers a high-level look at dashboard design. If you find that you’re captivated by the subject, feel free to visit Stephen Few’s website at www.perceptualedge.com.

Rule number 1: Keep it simple

Dashboard design expert Stephen Few has the mantra, “Simplify, simplify, simplify.” The basic idea is that dashboards cluttered with too many measures or too much eye candy can dilute the significant information you’re trying to present. How many times has someone told you that your reports look “busy”? In essence, this complaint means that too much is going on in the page or screen, making it hard to see the actual data.

Here are a few actions you can take to ensure simpler and more effective dashboard designs.

Don’t turn your dashboard into a data repository

Admit it. You include as much information in a report as possible, primarily to avoid being asked for additional information. We all do it. But in the dashboard state of mind, you have to fight the urge to force every piece of data available onto your dashboards.

Overwhelming users with too much data can cause them to lose sight of the primary goal of the dashboard and focus on inconsequential data. The measures used on a dashboard should support the initial purpose of that dashboard. Avoid the urge to fill white space for the sake of symmetry and appearances. Don’t include nice-to-know data just because the data is available. If the data doesn’t support the core purpose of the dashboard, leave it out.

Avoid the fancy formatting

The key to communicating effectively with your dashboards is to present your data as simply as possible. There’s no need to wrap it in eye candy to make it more interesting. It’s okay to have a dashboard with little to no color or formatting. You’ll find that the lack of fancy formatting only serves to call attention to the actual data. Focus on the data and not the shiny happy graphics. Here are a few guidelines:

✓ Avoid using colors or background fills to partition your dashboards. Colors, in general, should be used sparingly, reserved for providing information about key data points. For example, assigning the colors red, yellow, and green to measures traditionally indicates performance level. Adding these colors to other sections of your dashboard only serves to distract your audience.
De-emphasize borders, backgrounds, and other elements that define dashboard areas. Try to use the natural white space between components to partition the dashboard. If borders are necessary, format them to hues lighter than the ones you’ve used for your data. Light grays are typically ideal for borders. The idea is to indicate sections without distracting from the information displayed.

Avoid applying fancy effects such as gradients, pattern fills, shadows, glows, soft edges, and other formatting. Excel makes it easy to apply effects that make everything look shiny, glittery, and generally happy. Although these formatting features make for great marketing tools, they don’t do your reporting mechanisms any favors.

Don’t try to enhance your dashboards with clip art or pictures. They not only do nothing to further data presentation, but they also often just look tacky.

Limit each dashboard to one printable page

Dashboards, in general, should provide at-a-glance views into key measures relevant to particular objectives or business processes. This implies that all the data is immediately viewable on the one page. Although including all your data on one page isn’t always the easiest thing to do, there’s much benefit to being able to see everything on one page or screen. You can compare sections more easily, you can process cause-and-effect relationships more effectively, and you rely less on short-term memory. When a user has to scroll left, right, or down, these benefits are diminished. Furthermore, users tend to believe that when information is placed out of normal view (areas that require scrolling), it’s somehow less important.

But what if you can’t fit all the data on one sheet? First, review the measures on your dashboard and determine whether they really need to be there. Next, format your dashboard to use less space (format fonts, reduce white space, and adjust column and row widths). Finally, try adding interactivity to your dashboard, allowing users to dynamically change views to show only those measures that are relevant to them.

Use layout and placement to draw focus

As I discuss earlier in this chapter, only measures that support the dashboard’s utility and purpose should be included on the dashboard. However, it should be said that just because all measures on your dashboard are significant, they may not always have the same level of importance. In other words, you’ll frequently want one component of your dashboard to stand out from the others.
Instead of using bright colors or exaggerated sizing differences, you can leverage location and placement to draw focus to the most important components on your dashboard.

Various studies have shown that readers have a natural tendency to focus on particular regions of a document. For example, researchers at the Poynter Institute’s Eyetrack III project have found that readers view various regions on a screen in a certain order, paying particular attention to specific regions onscreen. They use the diagram in Figure 1-4 to illustrate what they call priority zones. Regions with the number 1 in the diagram seem to have high prominence, attracting the most attention for longer periods. Meanwhile, number 3 regions seem to have low prominence.

You can leverage these priority zones to promote or demote certain components based on significance. If one of the charts on your dashboard warrants special focus, you can simply place that chart in a region of prominence.

Note that surrounding colors, borders, fonts, and other formatting can affect the viewing patterns of your readers, deemphasizing a previously high-prominence region.

**Format numbers effectively**

There will undoubtedly be lots of numbers on your dashboards. Some of them will be in charts, and others will be in tables. Remember that every piece of information on your dashboard should have a reason for being there. It’s important that you format your numbers effectively to allow your users to understand the information they represent without confusion or hindrance.
Here are some guidelines to keep in mind when formatting the numbers on your dashboards and reports:

- **Always use commas to make numbers easier to read.** For example, instead of 2345, show 2,345.
- **Use decimal places only if that level of precision is required.** For instance, there’s rarely a benefit to showing the decimal places in a dollar amount, such as $123.45. In most cases, the $123 will suffice. Likewise in percentages, use only the minimum number of decimals required to represent the data effectively. For example, instead of 43.21%, you may be able to get away with 43%.
- **Use the dollar symbol only when you need to clarify that you’re referring to monetary values.** If you have a chart or table that contains all revenue values, and there’s a label clearly stating this, you can save room and pixels by leaving out the dollar symbol.
- **Format very large numbers to the thousands or millions place.** For instance, rather than display 16,906,714, you can format the number to read 17M.

In Chapter 3 of this book, you explore how to leverage number-formatting tricks to enhance the readability of your dashboards and reports.

### Use titles and labels effectively

It’s common sense, but many people often fail to label items on dashboards effectively. If your manager looks at your dashboard and asks you, “What is this telling me?” you likely have labeling issues. Here are a few guidelines for effective labeling on your dashboards and reports:

- **Always include a timestamp on your reporting mechanisms.** This minimizes confusion when distributing the same dashboard or report in monthly or weekly installments.
- **Always include some text indicating when the data for the measures was retrieved.** In many cases, the timing of the data is a critical piece of information when analyzing a measure.
- **Use descriptive titles for each component on your dashboard.** This allows users to clearly identify what they’re looking at. Be sure to avoid cryptic titles with lots of acronyms and symbols.
- **Although it may seem counterintuitive, it’s generally good practice to de-emphasize labels by formatting them to hues lighter than the ones used for your data.** Lightly colored labels give your users the information they need without distracting them from the information displayed. Ideal colors for labels are colors commonly found in nature: soft grays, browns, blues, and greens.
Key Questions to Ask Before Distributing Your Dashboard

Before you send out your finished dashboard, it’s worth your time to step back and measure it against some of the design principles discussed in this chapter. Here are some key questions you can use as a checklist before distributing your dashboard.

Does my dashboard present the right information?

Look at the information you are presenting and determine whether it meets the purpose of the dashboard identified during requirements gathering. Don’t be timid about clarifying the purpose of the dashboard again with your core users. You want to avoid building the dashboard in a vacuum. Allow a few test users to see iterations as you develop it. This way, communication remains open, and you won’t go too far in the wrong direction.

Does everything on my dashboard have a purpose?

Take an honest look at how much information on your dashboard doesn’t support its main purpose. To keep your dashboard as valuable as possible, you don’t want to dilute it with nice-to-know data that’s interesting but not actionable.

If the data does not support the core purpose of the dashboard, leave it out. Nothing says you have to fill every bit of white space on the page.

Does my dashboard prominently display the key message?

Every dashboard has one or more key messages. You want to ensure that these messages are prominently displayed. To test whether the key messages in a dashboard are prominent, stand back and squint while you look at the dashboard. Look away and then look at the dashboard several times. What jumps out at you first? If it’s not the key components you want to display, you’ll have to change something. Here are a few actions you can take to ensure that your key components have prominence.
Place the key components of your dashboard in the upper left or middle left of the page. Studies show that these areas attract the most attention for longer periods.

De-emphasize borders, backgrounds, and other elements that define dashboard areas. Try to use the natural white space between your components to partition your dashboard. If borders are necessary, format them to lighter hues than your data.

Format labels and other text to lighter hues than your data. Lightly colored labels give your users the information they need without distracting them from the information displayed.

Can I maintain this dashboard?

There is a big difference between updating a dashboard and rebuilding a dashboard. Before you excitedly send out the sweet-looking dashboard you just built, take a moment to think about the maintenance of such a dashboard. You want to think about the frequency of updates and what processes you need to go through each time you update the data. If it’s a one-time reporting event, set that expectation with your users. If you know it will become a recurring report, you’ll want to really negotiate development time, refresh intervals, and phasing before agreeing to any timetable.

Does my dashboard clearly display its scope and shelf life?

A dashboard should clearly specify its scope and shelf life. That is to say, anyone should be able to look at your dashboard and know the period it’s relevant to and the scope of the information on the dashboard. This comes down to a few simple things you can do to effectively label your dashboards and reports.

Always include a timestamp on your dashboard. This minimizes confusion when distributing the same dashboard or report in monthly or weekly installments.

Always include some text indicating when the data for the measures was retrieved. In many cases, timing of the data is a critical piece of information when analyzing a measure.

Use descriptive titles for each component on your dashboard. Be sure to avoid cryptic titles with lots of acronyms and symbols.
Is my dashboard well documented?

It’s important to document your dashboard and the data model behind it. Anyone who has ever inherited an Excel worksheet knows how difficult it can be to translate the various analytical gyrations that go into a report. If you’re lucky, the data model will be small enough to piece together in a week or so. If you’re not so lucky, you’ll have to ditch the entire model and start from scratch. By the way, that troublesome Excel data model doesn’t even have to be someone else’s. I’ve actually gone back to a model that I built, and after six or so months I had forgotten what I had done. Without documentation, it took me a few days to remember and decipher my own work.

The documentation doesn’t even have to be hifalutin fancy stuff. A few simple things can help in documenting your dashboard.

- **Add a Model Map tab to your data model.** The Model Map tab is a separate sheet you can use to summarize the key ranges in the data model and spell out how each range interacts with the reporting components in the final presentation layer.

- **Use comments and labels liberally.** It’s amazing how a few explanatory comments and labels can help clarify your model even after you’ve been away from your data model for a long time.

- **Use colors to identify the ranges in your data model.** Using colors in your data model enables you to quickly look at a range of cells and get a basic indication of what that range does. Each color can represent a range type. For example, yellow could represent staging tables, gray could represent formulas, and purple could represent reference tables.

Is my dashboard user-friendly?

Before you distribute your dashboard, you want to ensure that it’s user-friendly. It’s not difficult to guess what user-friendly means:

- **Intuitive:** Your dashboard should be intuitive to someone who has never seen it. Test it out on someone and ask that person whether it makes sense. If you have to start explaining what the dashboard says, something is wrong. Does the dashboard need more labels, less complicated charts, a better layout, more data, less data? It’s a good idea to get feedback from several users.

- **Easy to navigate:** If your dashboard is dynamic, allowing for interactivity with macros or pivot tables, make sure that the navigation works well. Does the user have to click in several places to get to her data? Is the
Part I: Getting Started with Excel Dashboards & Reports

number of drill-downs appropriate? Does it take too long to switch from one view to another? Again, test your dashboard on several users. And be sure to test any interactive dashboard features on several computers other than yours.

✓ **Prints properly:** Nothing is more annoying than printing a dashboard only to find that the person who created the dashboard didn’t take the time to ensure that it prints correctly. Be sure to set the print options on your Excel files so that your dashboards print properly.

**Is my dashboard accurate?**

Nothing kills a dashboard or report faster than the perception that the data in it is inaccurate. It’s not within my capabilities to tell you how to determine whether your data is accurate. I can, however, highlight three factors establishing the perception that a dashboard is accurate:

✓ **Consistency with authoritative sources:** It’s obvious that if your data does not match other reporting sources, you’ll have a data credibility issue — especially if those other sources are deemed to be the authoritative sources. Be aware of the data sources that are considered to be gospel in your organization. If your dashboard contains data associated with an authoritative source, compare your data with that source to ensure consistency.

✓ **Internal consistency:** It’s never fun to explain why one part of your dashboard doesn’t jibe with other parts of the same dashboard. You want to ensure some level of internal consistency within your dashboard. Be sure that comparable components in different areas of your dashboard are consistent with each other. If there is a reason for inconsistency, clearly notate those reasons. It’s amazing how well a simple notation clears up questions about the data.

✓ **Personal experience:** Have you ever seen someone look at a report and say “That doesn’t look right?” They are using what some people call “gut feel” to evaluate the soundness of the data. None of us looks at numbers in a vacuum. When we look at any analysis, we bring with us years of personal knowledge, interaction, and experience. We subconsciously use these experiences in our evaluation of information. When determining the accuracy of your dashboard, take into consideration organizational “anecdotal knowledge.” If possible, show your dashboard to a few content experts in your company.
One of Excel’s most attractive features is its flexibility. You can create an intricate system of interlocking calculations, linked cells, and formatted summaries that work together to create a final analysis. However, years of experience have brought me face to face with an ugly truth: Excel is like the cool gym teacher who lets you do anything you want — the freedom can be fun, but a lack of structure in your data models can lead to some serious headaches in the long run.

What’s a data model? A data model provides the foundation upon which your reporting mechanism is built. When you build a spreadsheet that imports, aggregates, and shapes data, you’re essentially building a data model that feeds your dashboards and reports.

Creating a poorly designed data model can mean hours of manual labor maintaining and refreshing your reporting mechanisms. On the other hand, creating an effective model allows you to easily repeat monthly reporting processes without damaging your reports or your sanity.

The goal of this chapter is to show you the concepts and techniques that help you build effective data models. In this chapter, you discover that creating a successful reporting mechanism requires more than slapping data onto a spreadsheet. Although you see how to build cool dashboard components in later chapters, those components won’t do you any good if you can’t effectively manage your data models. On that note, let’s get started.

Data Modeling Best Practices

Building an effective model isn’t as complicated as you may think. It’s primarily a matter of thinking about your reporting processes differently. Most people spend very little time thinking about the supporting data model
behind a reporting process. If they think about it at all, they usually start by imagining a mock-up of the finished dashboard and work backward from there.

Rather than see only the finished dashboard in your head, try to think of the end-to-end process. Where will you get the data? How should the data be structured? What analysis will need to be performed? How will the data be fed to the dashboard? How will the dashboard be refreshed?

Obviously, the answers to these questions are highly situation-specific. However, some data modeling best practices will guide you to a new way of thinking about your reporting process. These are discussed in the next few sections.

**Separating data, analysis, and presentation**

One of the most important concepts in a data model is the separation of data, analysis, and presentation. The fundamental idea is that you don’t want your data to become too tied into any one particular way of presenting that data.

To wrap your mind around this concept, think about an invoice. When you receive an invoice, you don’t assume that the financial data on the invoice is the true source of your data. It’s merely a presentation of data that’s actually stored in a database. That data can be analyzed and presented to you in many other manners: in charts, in tables, or even on websites. This sounds obvious, but Excel users often fuse data, analysis, and presentation.

For instance, I’ve seen Excel workbooks that contain 12 tabs, each representing a month. On each tab, data for that month is listed along with formulas, pivot tables, and summaries. Now what happens when you’re asked to provide a summary by quarter? Do you add more formulas and tabs to consolidate the data on each of the month tabs? The fundamental problem in this scenario is that the tabs actually represent data values that are fused into the presentation of your analysis.

For an example more in line with reporting, take a look at Figure 2-1. Hard-coded tables like this one are common. This table is an amalgamation of data, analysis, and presentation. Not only does this table tie you to a specific analysis, but there’s little to no transparency into what the analysis exactly consists of. Also, what happens when you need to report by quarter or when another dimension of analysis is needed? Do you import a table that consists of more columns and rows? How does that affect your model?
Chapter 2: Building a Super Model

The alternative is to create three layers in your data model: a data layer, an analysis layer, and a presentation layer. You can think of these layers as three different spreadsheets in an Excel workbook: one sheet to hold the raw data that feeds your report, one sheet to serve as a staging area where the data is analyzed and shaped, and one sheet to serve as the presentation layer. Figure 2-2 illustrates the three layers of an effective data model.

As you can see in Figure 2-2, the raw dataset is located on its own sheet. Although the dataset has some level of aggregation applied to keep it manageable, no further analysis is done on the Data sheet.

The analysis layer consists primarily of formulas that analyze and pull data from the data layer into formatted tables commonly referred to as staging tables. These staging tables ultimately feed the reporting components in your presentation layer. In short, the sheet that contains the analysis layer becomes the staging area where data is summarized and shaped to feed the reporting components. Notice on the Analysis tab in Figure 2-2, the formula bar illustrates that the table consists of formulas that reference the Data tab.

There are a couple of benefits to this setup. First, the entire reporting model can be refreshed easily by simply replacing the raw data with an updated dataset. The formulas on the Analysis tab continue to work with the latest data. Second, any additional analysis can easily be created by using different combinations of formulas on the Analysis tab. If you need data that doesn’t exist in the Data sheet, you can easily append a column to the end of the raw dataset without disturbing the Analysis or Presentation sheets.

You don’t necessarily have to place your data, analysis, and presentation layers on different spreadsheets. In small data models, you may find it easier to place your data in one area of a spreadsheet while building staging tables in another area of the same spreadsheet.

Along those same lines, remember that you’re not limited to three spreadsheets, either. That is to say, you can have several sheets that provide the raw data, several sheets that analyze, and several that serve as the presentation layer.
Wherever you choose to place the different layers, keep in mind that the idea remains the same. The analysis layer should primarily consist of formulas that pull data from the Data sheets into staging tables used to feed your presentation. Later in this chapter, you explore some of the formulas that can be used in your analysis sheets.
Chapter 2: Building a Super Model

Starting with appropriately structured data

Not all datasets are created equal. Although some datasets work in a standard Excel environment, they may not work for data modeling purposes. Before building your data model, ensure that your source data is appropriately structured for dashboarding purposes.

At the risk of oversimplification, I assert that datasets typically used in Excel come in three fundamental forms:

- ✓ The spreadsheet report
- ✓ The flat data file
- ✓ The tabular dataset

The punch line is that only flat data files and tabular datasets make for effective data models. I review and discuss each of these different forms in the next few sections.

Spreadsheet reports make for ineffective data models

Spreadsheet reports display highly formatted, summarized data and are often designed as presentation tools for management or executive users. A typical spreadsheet report makes judicious use of empty space for formatting, repeats data for aesthetic purposes, and presents only high-level analysis. Figure 2-3 illustrates a spreadsheet report.

Although a spreadsheet report may look nice, it doesn’t make for an effective data model. Why? The primary reason is that these reports offer you no separation of data, analysis, and presentation. You’re essentially locked into one analysis.

Although you could make charts from the report shown in Figure 2-3, it’d be impractical to apply any analysis outside what’s already there. For instance, how would you calculate and present the average of all bike sales using this particular report? How would you calculate a list of the top ten best-performing markets?

With this setup, you’re forced into very manual processes that are difficult to maintain month after month. Any analysis outside the high-level ones already in the report is basic at best — even with fancy formulas. Furthermore, what happens when you’re required to show bike sales by month? When your data model requires analysis with data that isn’t in the spreadsheet report, you’re forced to search for another dataset.
Flat data files lend themselves nicely to data models

Another type of file format is a flat file. Flat files are data repositories organized by row and column. Each row corresponds to a set of data elements, or a record. Each column is a field. A field corresponds to a unique data element in a record. Figure 2-4 contains the same data as the report in Figure 2-3 but expressed in a flat data file format.

Notice that every data field has a column, and every column corresponds to one data element. Furthermore, there’s no extra spacing, and each row (or record) corresponds to a unique set of information. But the key attribute that makes this a flat file is that no single field uniquely identifies a record. In fact, you’d have to specify four separate fields (Region, Market, Business Segment, and a month’s sales amount) before you could uniquely identify the record.
Flat files lend themselves nicely to data modeling in Excel because they can be detailed enough to hold the data you need and still be conducive to a wide array of analysis with simple formulas — SUM, AVERAGE, VLOOKUP, and SUMIF, just to name a few. Later in this chapter, you explore formulas that come in handy in a reporting data model.

**Tabular datasets are perfect for pivot table–driven data models**

Many effective data models are driven primarily by pivot tables. Pivot tables (which I cover in Chapter 6) are Excel’s premier analysis tools. For those of you who have used pivot tables, you know they offer an excellent way to summarize and shape data for use by reporting components, such as charts and tables.

*Tabular datasets* are ideal for pivot table–driven data models. Figure 2-5 illustrates a tabular dataset. Note that the primary difference between a tabular dataset, as shown in Figure 2-5, and a flat data file is that in tabular datasets the column labels don’t double as actual data. For instance, in Figure 2-4, the month identifiers are integrated into the column labels. In Figure 2-5, the Sales Period column contains the month identifier. This subtle difference in structure is what makes tabular datasets optimal data sources for pivot tables. This structure ensures that key pivot table functions, such as sorting and grouping, work the way they should.

![Figure 2-5: A tabular dataset.](image)

The attributes of a tabular dataset are as follows:

- The first row of the dataset contains field labels that describe the information in each column.
- The column labels don’t pull double duty as data items that can be used as filters or query criteria (such as months, dates, years, regions, or markets).
There are no blank rows or columns — every column has a heading, and a value is in every row.

Each column represents a unique category of data.

Each row represents individual items in each column.

**Avoiding turning your data model into a database**

In Chapter 1, you might have read that measures used on a dashboard should absolutely support the initial purpose of that dashboard. The same concept applies to the back-end data model. You should only import data that’s necessary to fulfill the purpose of your dashboard or report.

In an effort to have as much data as possible at their fingertips, many Excel users bring into their spreadsheets every piece of data they can get their hands on. You can spot these people by the 40-megabyte files they send through email. You’ve seen these spreadsheets — two tabs that contain some reporting or dashboard interface and then six hidden tabs that contain thousands of lines of data (most of which isn’t used). They essentially build a database in their spreadsheet.

What’s wrong with utilizing as much data as possible? Well, here are a few issues:

**Aggregating data within Excel increases the number of formulas.** If you’re bringing in all raw data, you have to aggregate that data in Excel. This inevitably causes you to exponentially increase the number of formulas you have to employ and maintain. Remember that your data model is a vehicle for presenting analyses, not processing raw data. The data that works best in reporting mechanisms is what’s already been aggregated and summarized into useful views that can be navigated and fed to dashboard components. Importing data that’s already been aggregated as much as possible is far better. For example, if you need to report on Revenue by Region and Month, there’s no need to import sales transactions into your data model. Instead, use an aggregated table consisting of Region, Month, and Sum of Revenue.

**Your data model will be distributed with your dashboard.** In other words, because your dashboard is fed by your data model, you need to maintain the model behind the scenes (likely in hidden tabs) when distributing the dashboard. Besides the fact that it causes the file size to be unwieldy, including too much data in your data model can actually degrade the performance of your dashboard. Why? When you open an Excel file, the entire file is loaded into memory to ensure quick data processing and access. The drawback to this behavior is that Excel requires a great deal of RAM to process even the smallest change in your spreadsheet.
You may have noticed that when you try to perform an action on a large, formula-intensive dataset, Excel is slow to respond, giving you a Calculating indicator on the status bar. The larger your dataset is, the less efficient the data crunching in Excel is.

- **Large datasets can cause difficulty in scalability.** Imagine that you’re working in a small company and you’re using monthly transactions in your data model. Each month holds 80,000 lines of data. As time goes on, you build a robust process complete with all the formulas, pivot tables, and macros you need to analyze the data that’s stored on your neatly maintained tab. Now what happens after one year? Do you start a new tab? How do you analyze two datasets on two different tabs as one entity? Are your formulas still good? Do you have to write new macros?

These are all issues that can be avoided by importing only aggregated and summarized data that’s useful to the core purpose of your reporting needs.

**Using tabs to document and organize your data model**

Wanting to keep your data model limited to one worksheet tab is natural. In my mind, keeping track of one tab is much simpler than using different tabs. However, limiting your data model to one tab has its drawbacks, including the following:

- **Using one tab typically places limits on your analysis.** Because only so many datasets can fit on a tab, using one tab limits the number of analyses that can be represented in your data model. This in turn limits the analysis your dashboard can offer. Consider adding tabs to your data model to provide additional data and analysis that may not fit on just one tab.

- **Too much on one tab makes for a confusing data model.** When working with large datasets, you need plenty of staging tables to aggregate and shape the raw data so that it can be fed to your reporting components. If you use only one tab, you’re forced to position these staging tables below or to the right of your datasets. Although this may provide all the elements needed to feed your presentation layer, a good deal of scrolling is necessary to view all the elements positioned in a wide range of areas. This makes the data model difficult to understand and maintain. Use separate tabs to hold your analysis and staging tables, particularly in data models that contain large datasets occupying a lot of real estate.

- **Using one tab limits the amount of documentation you can include.** You’ll find that your data models easily become a complex system of intertwining links among components, input ranges, output ranges, and formulas. Sure, it all makes sense while you’re building your data model, but try coming back to it after a few months. You’ll find you’ve forgotten
what each data range does and how each range interacts with the final presentation layer. To avoid this problem, consider adding a Model Map tab to your data model. The Model Map tab essentially summarizes the key ranges in the data model and allows you to document how each range interacts with the reporting components in the final presentation layer. As you can see in Figure 2-6, the model map is nothing fancy — just a table that lists key information about each range in the model.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Range</th>
<th>Purpose</th>
<th>Linked Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis 1</td>
<td>A2:A11</td>
<td>Provides the data source for the trend graph component</td>
<td>United States trend 1</td>
</tr>
<tr>
<td>Analysis 2</td>
<td>A3:A11</td>
<td>Data source for the List Box component</td>
<td>List Box 1</td>
</tr>
<tr>
<td>Analysis 2</td>
<td>C1</td>
<td>Output range for the selected item in the List Box component</td>
<td>Conditional trend icon</td>
</tr>
<tr>
<td>Analysis 2</td>
<td>D1:R1</td>
<td>Vlookup formulas that reference cell C1. This range also serves as the source data for the Combination Chart component</td>
<td>Combination Chart 1</td>
</tr>
<tr>
<td>Data</td>
<td>C6:R49</td>
<td>Main data set for this data model</td>
<td></td>
</tr>
</tbody>
</table>

You can include any information you think appropriate in your model map. The idea is to give yourself a handy reference that guides you through the elements in your data model.

**Speaking of documenting your data model . . .**

Another way to document the logic in your data model is to use comments and labels liberally. It’s amazing how a few explanatory comments and labels can help clarify your spreadsheets.

The general idea here is that the logic in your model should be clear to you even after you’ve been away from your data model for a long time.

Also, consider using colors to identify the ranges in your data model. Using colors in your data model enables you to quickly look at a range of cells and get a basic indication of what that range does. The general concept behind this best practice is that each color represents a range type. For example, you could use yellow to represent staging tables used to feed the charts and the tables in your presentation layer. You could use gray to represent formulas that aren’t to be altered or touched, or purple to represent reference tables used for lookups and drop-down lists.

You can use any color you want; it’s up to you to give these colors meaning. The important thing is that you have a visual distinction between the various ranges being used in your data model.
Testing your data model before building reporting components on top of it

This best practice is simple. Make sure your data model does what it’s supposed to do before building dashboard components on top of it. In that vein, here are a few things to watch for:

- **Test your formulas to ensure they’re working properly.** Make sure your formulas don’t produce errors and that each formula outputs expected results.

- **Double-check your main dataset to ensure it’s complete.** Check that your data table was not truncated when transferring to Excel. Also, be sure that each column of data is present with appropriate data labels.

- **Make sure all numeric formatting is appropriate.** Be sure that the formatting of your data is appropriate for the field. For example, check to see that dates are formatted as dates, currency values are formatted properly, and the correct number of decimal places is displayed where needed.

The obvious goal here is to eliminate easily avoidable errors that may cause complications later.

Excel Functions That Really Deliver

As you discover in this chapter, the optimal data model for any reporting mechanism is one in which data, analysis, and presentation are separated into three layers. Although all three layers are important, the analysis layer is where the real art comes into play. The fundamental task of the analysis layer is to pull information from the data layer and then create staging tables that feed your charts, tables, and other reporting components. To do this effectively, you need to employ formulas that serve as data delivery mechanisms — formulas that deliver data to a destination range.

You see, the information you need lives in the data layer (typically, a table containing aggregated data). *Data delivery formulas* are designed to get that data and deliver it to the analysis layer so it can be analyzed and shaped. The cool thing is that after you’ve set up the data delivery formulas, the analysis layer automatically updates each time the data layer is refreshed.

Confused? Don’t worry — in this section, I show you a few Excel functions that work particularly well in data delivery formulas. As you complete the examples here, you’ll start to see how these concepts come together.
The VLOOKUP function

The VLOOKUP function is the king of all lookup functions in Excel. I’d be willing to bet you’ve at least heard of VLOOKUP, if not used it a few times yourself. The purpose of VLOOKUP is to find a specific value from a column of data where the leftmost row value matches a given criterion.

VLOOKUP basics

Take a look at Figure 2-7 to get the general idea. The table on the left shows sales by month and product number. The bottom table translates those product numbers to actual product names. The VLOOKUP function can help in associating the appropriate name to each respective product number.

To understand how VLOOKUP formulas work, take a moment to review the basic syntax. A VLOOKUP formula requires four arguments:

\[
\text{VLOOKUP}(\text{Lookup\_value}, \text{Table\_array}, \text{Col\_index\_num}, \text{Range\_lookup})
\]

- **Lookup\_value**: The Lookup\_value argument identifies the value being looked up. This is the value that needs to be matched to the lookup table. In the example in Figure 2-7, the Lookup\_value is the product number. Therefore, the first argument for all the formulas shown in Figure 2-7 references column C (the column that contains the product number).
Table_array: The Table_array argument specifies the range that contains the lookup values. In Figure 2-7, that range is D16:E22. Here are a couple of points to keep in mind with this argument. First, for a VLOOKUP to work, the leftmost column of the table must be the matching value. For instance, if you’re trying to match product numbers, the leftmost column of the lookup table must contain product numbers. Second, notice that the reference used for this argument is an absolute reference. This means the column and row references are prefixed with dollar ($$) signs — as in $$D$16:$$E$22. This ensures that the references don’t shift while you copy the formulas down or across.

Col_index_num: The Col_index_num argument identifies the column number in the lookup table that contains the value to be returned. In the example in Figure 2-7, the second column contains the product name (the value being looked up), so the formula uses the number 2. If the product name column were the fourth column in the lookup table, the number 4 would be used.

Range_lookup: The Range_lookup argument specifies whether you’re looking for an exact match or an approximate match. If an exact match is needed, you’d enter FALSE for this argument. If the closest match will do, you’d enter TRUE or leave the argument blank.

Applying VLOOKUP formulas in a data model

As you can imagine, there are countless ways to apply a VLOOKUP in all kinds of analyses. Let’s take a moment to walk through a scenario where using a VLOOKUP can help enhance your dashboard model.

With a few VLOOKUP formulas and a simple drop-down list, you can create a data model that not only delivers data to the appropriate staging table, but also allows you to dynamically change data views based on a selection you make. Figure 2-8 illustrates the setup.

To see this effect in action, get the Chapter 2 Samples.xlsx workbook from this book’s companion website. Open that workbook to see a VLOOKUP1 tab.

The data layer in the model shown in Figure 2-8 resides in the range A9:F209. The analysis layer is held in range E2:F6. The data layer consists of all formulas that extract and shape the data as needed. As you can see, the VLOOKUP formulas use the Customer Name value in cell C3 to look up the appropriate data from the data layer. So if you entered Chevron in cell C3, the VLOOKUP formulas would extract the data for Chevron.

You may have noticed that the VLOOKUP formulas in Figure 2-8 specify a Table_array argument of $$C$9:$$F$5000. This means that the lookup table they’re pointing to stretches from C9 to F5000. That seems strange because the table ends at F209. Why would you force your VLOOKUP formulas to look at a range far past the end of the data table?
Well, remember that the idea behind separating the data layer and the analysis layer is so that the analysis layer can be automatically updated when the data is refreshed. When you get new data next month, you should be able to simply replace the data layer in the model without having to rework the analysis layer. Allowing for more rows than necessary in your \texttt{VLOOKUP} formulas ensures that if the data layer grows, records won’t fall outside the lookup range of the formulas.

Later in this chapter, I show you how to automatically keep up with growing data tables by using smart tables.

\textbf{Using data validation drop-down lists in the data model}

In the example illustrated in Figure 2-8, the data model allows you to select customer names from a drop-down list when you click cell C3. The customer name serves as the lookup value for the \texttt{VLOOKUP} formulas. Changing the customer name extracts a new set of data from the data layer. This allows you to quickly switch from one customer to another without having to remember and type the customer name.

Now, as cool as this seems, the reasons for this setup aren’t all cosmetic. There are practical reasons for adding drop-down lists to your data models.

Many of your models consist of multiple analytical layers in which each shows a different set of analyses. Although each analysis layer is different, they often need to revolve around a shared dimension, such as the same customer name, the same market, or the same region. For instance, when you have a data model that reports on Financials, Labor Statistics, and Operational Volumes, you want to make certain that when the model is reporting financials for the South region, the Labor Statistics are for the South region as well.
An effective way to ensure this happens is to force your formulas to use the same dimension references. If cell C3 is where you switch customers, every analysis that is customer-dependent should reference cell C3. Drop-down lists allow you to have a predefined list of valid variables located in a single cell. With a drop-down list, you can easily switch dimensions while building and testing multiple analysis layers.

Adding a drop-down list is relatively easy with Excel’s Data Validation functionality. To add a drop-down list, follow these steps:

1. Select the Data tab on the Ribbon.
2. Click the Data Validation button.
3. Select the Settings tab in the newly activated Data Validation dialog box. (See Figure 2-9.)
4. In the Allow drop-down list, choose List.
5. In the Source input box, reference the range of cells that contain your predefined selection list.
   In our example, this would be the list of customers you want exposed through the dashboard.
6. Click OK.

---

**The HLookup function**

The HLOOKUP function is the less popular cousin of the VLOOKUP function. The H in HLOOKUP stands for horizontal. Because Excel data is typically vertically oriented, most situations require a vertical lookup, or VLOOKUP. However, some data structures are horizontally oriented, requiring a horizontal lookup; thus, the HLOOKUP function comes in handy. The HLOOKUP searches a lookup table to find a single value from a row of data where the column label matches a given criterion.
**HLOOKUP basics**

Figure 2-10 demonstrates a typical scenario in which HLOOKUP formulas are used. The table in C5 requires quarter-end numbers (March and June) for 2011. The HLOOKUP formulas use the column labels to find the correct month columns and then locate the 2011 data by moving down the appropriate number of rows. In this case, 2011 data is in row 4, so the number 4 is used in the formulas.

![Figure 2-10: HLOOKUP formulas help to find March and June numbers from the lookup table.](image)

To get your mind around how this works, take a look at the basic syntax of the HLOOKUP function.

```
HLOOKUP(Lookup_value, Table_array, Row_index_num, Range_lookup)
```

**Lookup_value**: The *Lookup_value* argument identifies the value being looked up. In most cases, these values are column names. In the example in Figure 2-10, the column labels are being referenced for the *Lookup_value*. This points the HLOOKUP function to the appropriate column in the lookup table.

**Table_array**: The *Table_array* argument identifies the range that contains the lookup table. In Figure 2-10, that range is B9:H12. Like the VLOOKUP examples earlier in this chapter, notice that the references used for this argument are absolute. This means the column and row references are prefixed with dollar ($) signs — as in $B$9:$H$12. This ensures that the reference doesn’t shift while you copy the formula down or across.

**Row_index_num**: The *Row_index_num* argument identifies the row number that contains the value you’re looking for. In the example in Figure 2-10, the 2011 data is located in row 4 of the lookup table. Therefore, the formulas use the number 4.

**Range_lookup**: The *Range_lookup* argument specifies whether you’re looking for an exact match or an approximate match. If an exact match is needed, you’d enter *FALSE* for this argument. If the closest match will do, you’d enter *TRUE* or leave the argument blank.
Applying HLOOKUP formulas in a data model

HLOOKUPs are especially handy for shaping data into structures appropriate for charting or other types of reporting. A simple example is demonstrated in Figure 2-11. With HLOOKUPs, the data shown in the raw data table at the bottom of the figure is reoriented in a staging table at the top. When the raw data is changed or refreshed, the staging table captures the changes.

The Sumproduct function

The SUMPRODUCT function is actually listed under the math and trigonometry category of Excel functions. Because the primary purpose of SUMPRODUCT is to calculate the sum product, most people don’t know you can actually use it to look up values. In fact, you can use this versatile function quite effectively in most data models.

SUMPRODUCT basics

The SUMPRODUCT function is designed to multiply values from two or more ranges of data and then add the results together to return the sum of the products. Take a look at Figure 2-12 to see a typical scenario in which the SUMPRODUCT is useful.

In Figure 2-12, you see a common analysis in which you need the total sales for the years 2011 and 2012. As you can see, to get the total sales for each year, you first have to multiply Price by the number of Units to get the total for each Region. Then you have to sum those results to get the total sales for each year.
With the **SUMPRODUCT** function, you can perform the two-step analysis with just one formula. Figure 2-13 shows the same analysis with **SUMPRODUCT** formulas. Rather than use 11 formulas, you can accomplish the same analysis with just 3!

The syntax of the **SUMPRODUCT** function is fairly simple:

```
SUMPRODUCT(Array1, Array2, ...)
```

**Array**: Array represents a range of data. You can use anywhere from 2 to 255 arrays in a **SUMPRODUCT** formula. The arrays are multiplied together and then added. The only hard-and-fast rule you have to remember is that all arrays must have the same number of values. That is to say, you can’t use the **SUMPRODUCT** if range X has 10 values and range Y has 11 values. Otherwise, you get the #VALUE! error.
A twist on the SUMPRODUCT function

The interesting thing about the SUMPRODUCT function is that it can be used to filter out values. Take a look at Figure 2-14 to see what I mean.

![Figure 2-14: The SUMPRODUCT function can be used to filter data based on criteria.](image)

The formula in cell E12 is pulling the sum of total units for just the North region. Meanwhile, cell E13 is pulling the units logged for the North region in the year 2011.

To understand how this works, take a look at the formula in cell E12, shown in Figure 2-14. That formula reads \( \text{SUMPRODUCT((C3:C10=“North”)*(E3:E10))} \).

In Excel, TRUE evaluates to 1 and FALSE evaluates to 0. Every value in column C that equals North evaluates to TRUE or 1. Where the value is not North, it evaluates to FALSE or 0. The part of the formula that reads \( (C3:C10=“North”) \) enumerates through each value in the range \( C3:C10 \), assigning a 1 or 0 to each value. Then internally, the SUMPRODUCT formula translates to

\[
(1*E3)+(0*E4)+(0*E5)+(0*E6)+(1*E7)+(0*E8)+(0*E9)+(0*E10).
\]

This gives you the answer of 1628 because

\[
(1*751)+(0*483)+(0*789)+(0*932)+(1*877)+(0*162)+(0*258)+(0*517)
\]

equals 1628.

Applying SUMPRODUCT formulas in a data model

As always in Excel, you don’t have to hard-code the criteria in your formulas. Rather than explicitly use "North" in the SUMPRODUCT formula, you could reference a cell that contains the filter value. You can imagine that cell A3 contains the word North, in which case you can use \( (C3:C10=A3) \) instead...
of \((C3:C10="North")\). This way, you can dynamically change your filter criteria, and your formula keeps up.

Figure 2-15 demonstrates how you can use this concept to pull data into a staging table based on multiple criteria. Note that each of the \texttt{SUMPRODUCT} formulas shown here references cells B3 and C3 to filter on Account and Product Line. Again, you can add data validation drop-down lists to cells B3 and C3, allowing you to easily change criteria.

The \texttt{CHOOSE} function

The \texttt{CHOOSE} function returns a value from a specified list of values based on a specified position number. For instance, if you enter the formulas

\[
\text{CHOOSE}(3, "Red", "Yellow", "Green", "Blue")
\]

into a cell, Excel returns \texttt{Green} because Green is the third item in the list of values. The formula

\[
\text{CHOOSE}(1, "Red", "Yellow", "Green", "Blue")
\]

would return \texttt{Red}. Although this may not look useful on the surface, the \texttt{CHOOSE} function can dramatically enhance your data models.

\textit{CHOOSE basics}

Figure 2-16 illustrates how \texttt{CHOOSE} formulas can help pinpoint and extract numbers from a range of cells. Note that instead of using hard-coded values, like \texttt{Red}, \texttt{Green}, and so on, you can use cell references to list the choices.
Chapter 2: Building a Super Model

Take a moment to review the basic syntax of the **CHOOSE** function:

```
CHOOSE(Index_num, Value1, Value2, ...)
```

**Index_num**: The *Index_num* argument specifies the position number of the chosen value in the list of values. If the third value in the list is needed, the *Index_num* is 3. The *Index_num* argument must be an integer between one and the maximum number of values in the defined list of values. That is to say, if there are ten choices defined in the **CHOOSE** formula, the *Index_num* argument can’t be more than ten.

**Value**: Each *Value* argument represents a choice in the defined list of choices for that **CHOOSE** formula. The *Value* arguments can be hard-coded values, cell references, defined names, formulas, or functions. You can have up to 255 choices listed in your **CHOOSE** formulas.

**Applying CHOOSE formulas in a data model**

The **CHOOSE** function is especially valuable in data models in which multiple layers of data need to be brought together. Figure 2-17 illustrates an example in which **CHOOSE** formulas help pull data together.

In this example, you have two data tables: one for Revenues and one for Net Income. Each contains numbers for separate regions. The idea is to create a staging table that pulls data from both tables so that the data corresponds to a selected region.

To understand what’s going on, focus on the formula in cell F3, shown in Figure 2-17. The formula is **CHOOSE($C$2,F7,F8,F9,F10)$. The *Index_num* argument is actually a cell reference that looks at the value in cell C2, which happens to be the number 2. As you can see, cell C2 is actually a **VLOOKUP** formula that pulls the appropriate index number for the selected region. The
list of defined choices in the \texttt{CHOOSE} formula is essentially the cell references that make up the revenue values for each region: F7, F8, F9, and F10. So the formula in cell F3 translates to \texttt{CHOOSE(2, 27474, 41767, 18911, 10590)}. The answer is 41,767.

![Figure 2-17: The \texttt{CHOOSE} formulas ensure that the appropriate data is synchronously pulled from multiple data feeds.](image)

\section*{Using Smart Tables That Expand with Data}

One of the challenges you can encounter when building data models is a data table that expands over time. That is to say, the table grows in the number of records it holds due to new data being added. To get a basic understanding of this challenge, take a look at Figure 2-18. In this figure, you see a simple table that serves as the source for the chart. Notice that the table lists data for January through June.

Imagine that next month, this table expands to include July data. You'll have to manually update your chart to include July data. Now imagine you had this same issue across your data model, with multiple data tables that link to multiple staging tables and dashboard components. You can imagine it'd be an extremely painful task to keep up with changes each month.

To solve this issue, you can use Excel's Table feature (you can tell they spent all night coming up with that name). The \textit{Table feature} allows you to convert a range of data into a defined table that's treated independently of other rows and columns on the worksheet. After a range is converted to a table, Excel views the individual cells in the table as a single object with functionality that a typical data range doesn't have.
Chapter 2: Building a Super Model

For instance, Excel tables offer the following features:

- They’re automatically enabled with Filter drop-down headers so that you can filter and sort easily.
- They come with the ability to quickly add a Total row with various aggregate functions.
- You can apply special formatting to Excel tables independent of the rest of the spreadsheet.
- Most important for data modeling purposes, they automatically expand to allow for new data.

The Table feature exists in Excel 2003 under a different name: the List feature (found on Excel’s Data menu). The benefit of this fact is that Excel tables are fully compatible with Excel 2003 Lists.

**Converting a range to an Excel table**

To convert a range of data to an Excel table, follow these steps:

1. **Highlight the range of cells that contain the data you want included in your Excel table.**
2. **On the Insert tab of the Ribbon, click the Table button.**

   This step opens the Create Table dialog box, as shown in Figure 2-19.
3. In the Create Table dialog box, verify the range for the table and specify whether the first row of the selected range is a header row.

4. Click OK to apply the changes.

After the conversion takes place, notice a few small changes. Excel has put autofilter drop-downs on the header rows, the rows in the table now have alternate shading, and any header that didn’t have a value has been named by Excel.

You can use Excel tables as the source for charts, pivot tables, list boxes, or anything else for which you’d typically use a data range. In Figure 2-20, a chart has been linked to the Excel table.
Here’s the impressive bit. When data is added to the table, Excel automatically expands the range of the table and incorporates the new range into any linked object. That’s just a fancy way of saying that any chart or pivot table tied to an Excel table automatically captures new data without manual intervention.

For example, if I add July and August data to the end of the Excel table, the chart automatically updates to capture the new data. In Figure 2-21, I added July with no data and August with data to show you that the chart captures any new records and automatically plots the data given.

![Figure 2-21: Excel tables automatically expand when new data is added.](image)

Take a moment to think about what Excel tables mean to a data model. They mean pivot tables that never have to be reconfigured, charts that automatically capture new data, and ranges that automatically keep up with changes.

**Converting an Excel table back to a range**

If you want to convert an Excel table back to a range, you can follow these steps:

1. **Place the cursor in any cell inside the Excel table and select the Table Tools’ Design subtabs on the Ribbon.**
2. Click the Convert to Range button, as shown in Figure 2-22.
3. When asked if you’re sure (via a message box), click the Yes button.
## Top 10 Domestic Routes by Revenue

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Revenue Dollars</th>
<th>Revenue Percent</th>
<th>Margin Dollars</th>
<th>Margin Percent</th>
<th>Per Passenger Revenue per Passenger</th>
<th>Margin per Passenger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlanta</td>
<td>New York</td>
<td>$3,602,000</td>
<td>8.09%</td>
<td>$955,000</td>
<td>9%</td>
<td>245</td>
<td>65</td>
</tr>
<tr>
<td>Chicago</td>
<td>New York</td>
<td>$4,674,000</td>
<td>10.50%</td>
<td>$336,000</td>
<td>3%</td>
<td>222</td>
<td>16</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
<td>New York</td>
<td>$2,483,000</td>
<td>5.58%</td>
<td>$1,536,000</td>
<td>14%</td>
<td>202</td>
<td>125</td>
</tr>
<tr>
<td>New York</td>
<td>Detroit</td>
<td>$12,180,000</td>
<td>27.35%</td>
<td>$2,408,000</td>
<td>23%</td>
<td>177</td>
<td>35</td>
</tr>
<tr>
<td>New York</td>
<td>Washington</td>
<td>$6,355,000</td>
<td>14.27%</td>
<td>$1,230,000</td>
<td>12%</td>
<td>186</td>
<td>36</td>
</tr>
<tr>
<td>New York</td>
<td>Philadelphia</td>
<td>$3,582,000</td>
<td>8.04%</td>
<td>-$716,000</td>
<td>-7%</td>
<td>125</td>
<td>-25</td>
</tr>
<tr>
<td>New York</td>
<td>San Francisco</td>
<td>$3,221,000</td>
<td>7.23%</td>
<td>$1,856,000</td>
<td>18%</td>
<td>590</td>
<td>340</td>
</tr>
<tr>
<td>New York</td>
<td>Phoenix</td>
<td>$2,846,000</td>
<td>6.39%</td>
<td>$1,436,000</td>
<td>14%</td>
<td>555</td>
<td>280</td>
</tr>
<tr>
<td>New York</td>
<td>Toronto</td>
<td>$2,799,000</td>
<td>6.29%</td>
<td>$1,088,000</td>
<td>10%</td>
<td>450</td>
<td>175</td>
</tr>
<tr>
<td>New York</td>
<td>Seattle</td>
<td>$2,792,000</td>
<td>6.27%</td>
<td>$467,000</td>
<td>4%</td>
<td>448</td>
<td>75</td>
</tr>
<tr>
<td><strong>Total Routes</strong></td>
<td></td>
<td><strong>$44,534,000</strong></td>
<td></td>
<td><strong>$10,596,000</strong></td>
<td></td>
<td><strong>272</strong></td>
<td><strong>53</strong></td>
</tr>
</tbody>
</table>

## Top 10 Domestic Routes by Revenue

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Revenue Dollars (1000's)</th>
<th>Revenue %</th>
<th>Margin Dollars (1000's)</th>
<th>Margin %</th>
<th>Per Passenger s per Passenger</th>
<th>Margin S per Passenger</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>Detroit</td>
<td>12,180</td>
<td>27%</td>
<td>2,408</td>
<td>23%</td>
<td>177</td>
<td>35</td>
</tr>
<tr>
<td>New York</td>
<td>Washington</td>
<td>6,355</td>
<td>14%</td>
<td>1,230</td>
<td>12%</td>
<td>186</td>
<td>36</td>
</tr>
<tr>
<td>Chicago</td>
<td>New York</td>
<td>4,674</td>
<td>10%</td>
<td>336</td>
<td>3%</td>
<td>222</td>
<td>16</td>
</tr>
<tr>
<td>Atlanta</td>
<td>New York</td>
<td>3,802</td>
<td>8%</td>
<td>955</td>
<td>9%</td>
<td>245</td>
<td>65</td>
</tr>
<tr>
<td>New York</td>
<td>Philadelphia</td>
<td>5,582</td>
<td>8%</td>
<td>-716</td>
<td>-7%</td>
<td>125</td>
<td>-25</td>
</tr>
<tr>
<td>New York</td>
<td>San Francisco</td>
<td>3,221</td>
<td>7%</td>
<td>1,856</td>
<td>18%</td>
<td>590</td>
<td>340</td>
</tr>
<tr>
<td>New York</td>
<td>Phoenix</td>
<td>2,846</td>
<td>6%</td>
<td>1,436</td>
<td>14%</td>
<td>555</td>
<td>280</td>
</tr>
<tr>
<td>New York</td>
<td>Toronto</td>
<td>2,799</td>
<td>6%</td>
<td>1,088</td>
<td>10%</td>
<td>450</td>
<td>175</td>
</tr>
<tr>
<td>New York</td>
<td>Seattle</td>
<td>2,792</td>
<td>6%</td>
<td>467</td>
<td>4%</td>
<td>448</td>
<td>75</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
<td>New York</td>
<td>2,483</td>
<td>6%</td>
<td>1,536</td>
<td>14%</td>
<td>202</td>
<td>125</td>
</tr>
<tr>
<td><strong>Total Routes</strong></td>
<td></td>
<td><strong>44,534</strong></td>
<td></td>
<td><strong>10,596</strong></td>
<td></td>
<td><strong>272</strong></td>
<td><strong>53</strong></td>
</tr>
</tbody>
</table>
In this part . . .

- Uncover the best practices for designing effective data tables.
- See how you can leverage the Sparkline functionality found in Excel.
- Look at the various techniques you can use to visualize data without the use of charts or graphs.
- Explore how pivot tables can enhance your analytical and reporting capabilities as well as your dashboards.
Chapter 3
Dressing Up Your Data Tables

In This Chapter
▶ The principles of table design
▶ Custom number formatting
▶ Applying custom format colors
▶ Applying custom format conditions

The Excel table is the perfect way to consolidate and relay information. Data tables are quite common — you’ll find one in any Excel report. Yet the concept of making tables easier to read and more visually appealing escapes most of us.

Maybe it’s because the nicely structured rows and columns of a table lull us into believing that the data is already presented in the best way possible. Maybe the options of adding color and borders make the table seem nicely packaged. Excel makes table creation easy, but even so, you can use several design principles to make your Excel table a more effective platform for conveying your data.

In this chapter, you explore how easy it is to apply a handful of table design best practices. The tips found here ultimately help you create visually appealing tables that make the data within them easier to consume and comprehend.

Table Design Principles

Table design is one of the most underestimated endeavors in Excel reporting. How a table is designed has a direct effect on how well an audience absorbs and interprets the data in that table. Unfortunately, putting together a data table with an eye for economy and ease of consumption is an uncommon skill.
For example, the table shown in Figure 3-1 is similar to many found in Excel reports. The thick borders, the variety of colors, and the poorly formatted numbers are all unfortunate trademarks of tables that come from the average Excel analyst.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Revenue Dollars</th>
<th>Revenue Percent</th>
<th>Margin Dollars</th>
<th>Margin Percent</th>
<th>Per Passenger Revenue per Passenger</th>
<th>Margin per Passenger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlanta</td>
<td>New York</td>
<td>$3,602,000</td>
<td>8.09%</td>
<td>$955,000</td>
<td>9%</td>
<td>245</td>
<td>65</td>
</tr>
<tr>
<td>Chicago</td>
<td>New York</td>
<td>$4,474,000</td>
<td>10.30%</td>
<td>$330,000</td>
<td>3%</td>
<td>222</td>
<td>16</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
<td>New York</td>
<td>$2,483,000</td>
<td>5.56%</td>
<td>$1,536,000</td>
<td>14%</td>
<td>202</td>
<td>135</td>
</tr>
<tr>
<td>New York</td>
<td>Detroit</td>
<td>$12,180,000</td>
<td>27.35%</td>
<td>$2,408,000</td>
<td>23%</td>
<td>177</td>
<td>35</td>
</tr>
<tr>
<td>New York</td>
<td>Washington</td>
<td>$5,355,000</td>
<td>14.27%</td>
<td>$1,230,000</td>
<td>12%</td>
<td>189</td>
<td>36</td>
</tr>
<tr>
<td>New York</td>
<td>Philadelphia</td>
<td>$5,582,000</td>
<td>8.04%</td>
<td>$716,000</td>
<td>7%</td>
<td>123</td>
<td>25</td>
</tr>
<tr>
<td>New York</td>
<td>San Francisco</td>
<td>$1,221,000</td>
<td>7.23%</td>
<td>$1,856,000</td>
<td>18%</td>
<td>590</td>
<td>140</td>
</tr>
<tr>
<td>New York</td>
<td>Phoenix</td>
<td>$2,846,000</td>
<td>6.39%</td>
<td>$1,435,000</td>
<td>14%</td>
<td>555</td>
<td>280</td>
</tr>
<tr>
<td>New York</td>
<td>Toronto</td>
<td>$2,799,000</td>
<td>6.25%</td>
<td>$1,088,000</td>
<td>10%</td>
<td>459</td>
<td>175</td>
</tr>
<tr>
<td>New York</td>
<td>Seattle</td>
<td>$2,782,000</td>
<td>6.27%</td>
<td>$407,000</td>
<td>4%</td>
<td>448</td>
<td>70</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>Domestic routes</strong></td>
<td><strong>$44,534,000</strong></td>
<td><strong>$10,596,000</strong></td>
<td><strong>272</strong></td>
<td><strong>53</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Throughout this chapter, you improve on this table by applying these four basic design principles:

- **Use colors sparingly**, reserving them only for information about key data points.
- **De-emphasize borders**, using the natural white space between the components to partition your dashboard.
- **Use effective number formatting** to avoid inundating your table with too much ink.
- **Subdue your labels and headers**.

**Use colors sparingly**

Color is most often used to separate the various sections of a table. The basic idea is that the colors applied to a table suggest the relationship between the rows and columns. The problem is that colors often distract and draw attention away from the important data. In addition, printed tables with dark-colored cells are notoriously difficult to read (especially on black-and-white printers). They are also hard on the toner budget, if that holds any importance to you.

Colors in general should be used sparingly, reserved for providing information about key data points. The headers, labels, and natural structure of your table are more than enough to guide your audience. There is no real need to add a layer of color as demarcation for your rows and columns.
Figure 3-2 shows the table from Figure 3-1 with the colors removed. As you can see, it’s already easier to read.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Revenue Dollars</th>
<th>Revenue Percent</th>
<th>Margin Dollars</th>
<th>Margin Percent</th>
<th>Per Passenger Revenue per Passenger</th>
<th>Margin per Passenger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlanta</td>
<td>New York</td>
<td>$3,102,000</td>
<td>8.05%</td>
<td>$955,000</td>
<td>9%</td>
<td>245</td>
<td>65</td>
</tr>
<tr>
<td>Chicago</td>
<td>New York</td>
<td>$4,874,000</td>
<td>10.50%</td>
<td>$336,000</td>
<td>3%</td>
<td>222</td>
<td>16</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
<td>New York</td>
<td>$2,483,000</td>
<td>5.58%</td>
<td>$1,536,000</td>
<td>14%</td>
<td>202</td>
<td>125</td>
</tr>
<tr>
<td>New York</td>
<td>Detroit</td>
<td>$12,180,000</td>
<td>27.35%</td>
<td>$1,208,000</td>
<td>23%</td>
<td>177</td>
<td>35</td>
</tr>
<tr>
<td>New York</td>
<td>Washington</td>
<td>$6,355,000</td>
<td>14.37%</td>
<td>$1,230,000</td>
<td>12%</td>
<td>186</td>
<td>36</td>
</tr>
<tr>
<td>New York</td>
<td>Philadelphia</td>
<td>$3,582,000</td>
<td>8.04%</td>
<td>-$716,000</td>
<td>-7%</td>
<td>125</td>
<td>-25</td>
</tr>
<tr>
<td>New York</td>
<td>San Francisco</td>
<td>$3,221,000</td>
<td>7.23%</td>
<td>$1,656,000</td>
<td>18%</td>
<td>590</td>
<td>340</td>
</tr>
<tr>
<td>New York</td>
<td>Phoenix</td>
<td>$2,846,000</td>
<td>6.39%</td>
<td>$1,436,000</td>
<td>14%</td>
<td>555</td>
<td>280</td>
</tr>
<tr>
<td>New York</td>
<td>Toronto</td>
<td>$2,799,000</td>
<td>6.29%</td>
<td>$1,088,000</td>
<td>10%</td>
<td>450</td>
<td>175</td>
</tr>
<tr>
<td>New York</td>
<td>Seattle</td>
<td>$2,792,000</td>
<td>6.27%</td>
<td>$467,000</td>
<td>4%</td>
<td>448</td>
<td>75</td>
</tr>
<tr>
<td><strong>Total Domestic</strong></td>
<td><strong>Revenue per</strong></td>
<td><strong>Total Domestic</strong></td>
<td><strong>Revenue</strong></td>
<td><strong>Margin</strong></td>
<td><strong>Per Passenger</strong></td>
<td><strong>Margin per Passenger</strong></td>
<td><strong>Total Domestic</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>$44,534,000</td>
<td>$10,596,000</td>
<td>272</td>
<td>53</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If you’re working with a table that contains colored cells, you can quickly remove the color by highlighting the cells and choosing the No Fill option under the Theme Colors drop-down menu on the Home tab. See Figure 3-3.

**De-emphasize borders**

Believe it or not, borders get in the way of quickly reading the data in a table. Because borders help separate data in nicely partitioned sections, this may seem counterintuitive, but the reality is that a table’s borders are the first thing your eyes see when you look at a table. Don’t believe it? Stand back a bit from an Excel table and squint. The borders will come popping out at you.
You should always endeavor to de-emphasize borders and gridlines wherever you can. Try to use the natural white space between the columns to partition sections. If borders are necessary, format them to lighter hues than your data; light grays are typically ideal. The idea is to indicate sections without distracting from the information displayed.

Figure 3-4 demonstrates these concepts with the table from Figure 3-1. Notice how the numbers are no longer caged in gridlines and that headings now jump out at you with the addition of Single Accounting underlines.

<table>
<thead>
<tr>
<th>Top 10 Domestic Routes by Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Atlanta</td>
</tr>
<tr>
<td>Chicago</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td><strong>Total Domestic routes</strong></td>
</tr>
</tbody>
</table>

Single accounting underlines are different from the standard underlining you typically apply by pressing Ctrl+U on the keyboard. Standard underlines draw a line only as far as the text goes — that is to say, if you underline the word YES, standard underlines give you a line under the three letters. Single accounting underlines, on the other hand, draw a line across the entire column, regardless of how big or small the word is. This makes for a minimal, but apparent visual demarcation that calls out column headers nicely.

You can format borders by first highlighting the cells you are working with, right-clicking to bring up the contextual menu, and then selecting the Format Cells option. This will activate the Format Cells dialog box shown in Figure 3-5. From here, take the following steps:

1. **Select an appropriate line thickness.**
   Typically, you should select the line with the lightest weight.

2. **Select an appropriate color.**
   Again, lighter hues are the best options.

3. **Use the border buttons to control where the borders are placed.**
To apply the single accounting underline, right-click the column headings and select Format Cells. Click the Font tab of the Format Cells dialog box and in the Underline drop-down menu, choose the Single Accounting option, as demonstrated in Figure 3-6.

Figure 3-5: Use the Border tab of the Format Cells dialog box to customize your borders.

Choose a line style.

Choose a color.

Place your borders.

Figure 3-6: Single accounting underlines effectively call out your column headers.
Use effective number formatting

Every piece of information in your table should have a reason for being there. In an effort to clarify, tables often inundate the audience with superfluous ink that doesn’t add value to the information. For example, you’ll often see tables that show a number like $145.57 when a simple 145 would be just fine. Why include the extra decimal places, which serve only to add to the mass of numbers that the audience has to plow through?

Here are some guidelines to keep in mind when applying formats to the numbers in the table:

▶✓ Use decimal places only if that level of precision is required.
▶✓ In percentages, use only the minimum number of decimals required to represent the data effectively.
▶✓ Rather than use currency symbols (like $ or £), let labels clarify that you are referring to monetary values.
▶✓ Format very large numbers to the thousands or millions place.
▶✓ Right-align numbers so that they are easier to read and compare.

Figure 3-7 shows the table from Figure 3-1 with appropriate number formatting applied. Notice that the large revenue and margin dollar amounts have been converted to the thousands place. In addition, the labels above the numbers now clearly indicate as such.

<table>
<thead>
<tr>
<th>Top 10 Domestic Routes by Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Atlanta</td>
</tr>
<tr>
<td>Chicago</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>New York</td>
</tr>
<tr>
<td>Total Domestic routes</td>
</tr>
</tbody>
</table>

The percentages have been truncated to show no decimal places. Also, the color coding draws attention to the Margin % column, the key metric in this table.
Amazingly, all of these improvements have been made simply with number formatting. That’s right: No formulas were used to convert large numbers to the thousands place, no conditional formatting was used to color code the Margin % field, and there were no other peripheral tricks of any kind.

### Subdue your labels and headers

No one would argue that the labels and headers of a table aren’t important. On the contrary, they provide the audience with the guidance and structure needed to make sense of the data within. However, many of us have a habit of overemphasizing labels and headers to the point that they overshadow the data within the table. How many times have you seen a bold or oversized font applied to headers? The reality is that your audience will benefit more with subdued labels.

De-emphasizing labels by formatting them to lighter hues actually makes the table easier to read and draws more attention to the data within the table. Lightly colored labels give users the information they need without distracting them from the information being presented. Ideal colors to use for labels are soft grays, light browns, soft blues, and greens.

Font size and alignment also factor into the effective display of tables. Aligning column headers to the same alignment as the numbers beneath them helps reinforce the column structures in your table. Keeping the font size of your labels close to that of the data within the table helps keep your eyes focused on the data — not the labels.

Figure 3-8 illustrates how the original table from Figure 3-1 looks with subdued headers and labels. Note how the data now becomes the focus while the muted labels work in the background.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Revenue $ (000's)</th>
<th>% Revenue</th>
<th>Margin $ (000's)</th>
<th>% Margin</th>
<th>Revenue $ per Passenger</th>
<th>Margin $ per Passenger</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>Detroit</td>
<td>12,180</td>
<td>27%</td>
<td>2,408</td>
<td>23%</td>
<td>177</td>
<td>85</td>
</tr>
<tr>
<td>New York</td>
<td>Washington</td>
<td>6,555</td>
<td>14%</td>
<td>1,230</td>
<td>18%</td>
<td>188</td>
<td>56</td>
</tr>
<tr>
<td>Chicago</td>
<td>New York</td>
<td>4,674</td>
<td>10%</td>
<td>536</td>
<td>3%</td>
<td>212</td>
<td>62</td>
</tr>
<tr>
<td>Atlanta</td>
<td>New York</td>
<td>5,002</td>
<td>8%</td>
<td>555</td>
<td>9%</td>
<td>245</td>
<td>65</td>
</tr>
<tr>
<td>New York</td>
<td>Philadelphia</td>
<td>5,582</td>
<td>8%</td>
<td>-716</td>
<td>-7%</td>
<td>155</td>
<td>25</td>
</tr>
<tr>
<td>New York</td>
<td>San Francisco</td>
<td>5,221</td>
<td>7%</td>
<td>1,856</td>
<td>18%</td>
<td>590</td>
<td>540</td>
</tr>
<tr>
<td>New York</td>
<td>Phoenix</td>
<td>2,846</td>
<td>6%</td>
<td>1,436</td>
<td>14%</td>
<td>555</td>
<td>280</td>
</tr>
<tr>
<td>New York</td>
<td>Tacoma</td>
<td>2,799</td>
<td>6%</td>
<td>1,088</td>
<td>10%</td>
<td>450</td>
<td>175</td>
</tr>
<tr>
<td>New York</td>
<td>Seattle</td>
<td>2,792</td>
<td>6%</td>
<td>467</td>
<td>6%</td>
<td>448</td>
<td>75</td>
</tr>
<tr>
<td>Columbus (Ohio)</td>
<td>New York</td>
<td>2,463</td>
<td>6%</td>
<td>1,536</td>
<td>20%</td>
<td>202</td>
<td>125</td>
</tr>
<tr>
<td>Total Domestic routes</td>
<td></td>
<td>44,534</td>
<td></td>
<td>10,556</td>
<td></td>
<td>272</td>
<td>53</td>
</tr>
</tbody>
</table>
Sorting is another key factor in the readability of your data. Many tables sort based on labels (alphabetical by route, for example). Sorting the table based on a key data point within the data helps establish a pattern the audience can use to quickly analyze the top and bottom values. Note in Figure 3-8 that the data has been sorted by the Revenue dollars. This again adds a layer of analysis, providing a quick look at the top- and bottom-generating routes.

Figure 3-9 illustrates the difference these simple improvements can make in the readability of your data tables. It’s easy to see how a few table design principles can greatly enhance your ability to present table-driven data.

### Figure 3-9: Before and after applying table design principles.

If possible, consider using modern-looking fonts such as Calibri and Segoe UI in your reports and dashboards. Fonts such as Times New Roman or Arial can make your reports look old compared with the rounded edges of the more trendy fonts used now. This change in font perception is primarily driven by popular online sites that often use fonts with rounded edges.
Getting Fancy with Custom Number Formatting

You can apply number formatting to cells in several ways. Most people simply use the convenient number commands found on the Home tab. By using these commands, you can quickly apply some default formatting (number, percent, currency, and so on) and just be done with it, but a better way is to use the Format Cells dialog box, in which you have the ability to create your own custom number formatting.

Number formatting basics

Follow these steps to apply basic number formatting:

1. Right-click a range of cells and select Format Cells from the menu that appears.
   The Format Cells dialog box appears.

2. Open the Number tab and choose a starting format that makes the most sense for your scenario.
   In Figure 3-10, the format chosen is Number and the selected options are to use a comma separator, to include no decimal places, and to enclose negative numbers in parentheses.

3. Click the Custom option, as shown in Figure 3-11.
   Excel takes you to a screen that exposes the syntax that makes up the format you selected. Here, you can edit the syntax in the Type input box to customize the number format.
The number formatting syntax tells Excel how a number should look in various scenarios. Number formatting syntax consists of different individual number formats separated by semicolons.

In this case, you see

```
#,##0_);(#,##0)
```

Here, you see two different formats: the format to the left of the semicolon and the format to the right of the semicolon.

By default, any formatting to the left of the first semicolon is applied to positive numbers and any formatting to the right of the first semicolon is applied to negative numbers. So with this choice, positive numbers will be formatted as a simple number, whereas negative numbers will be formatted with parentheses, like this:

```
1,982
```

```
(1,890)
```

Note that the syntax for the positive formatting in the previous example ends with an underscore and a closing parenthesis: `_)`. This tells Excel to leave a space the width of a parenthesis character at the end of positive numbers, which ensures that positive and negative numbers align nicely when negative numbers are wrapped in parentheses.

You can edit the syntax in the Type input box so that the numbers are formatted differently. For example, try changing the syntax to

```
+#,##0;-,##0
```
When this syntax is applied, positive numbers will start with the + symbol and negative numbers will start with the – symbol, like so:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>+1,200</td>
<td>-15,000</td>
</tr>
</tbody>
</table>

This comes in handy when formatting percentages. For instance, you can apply a custom percent format by entering the following syntax into the Type input box:

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>+0%;-0%</td>
</tr>
</tbody>
</table>

This syntax gives you percentages that look like this:

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>+43%</td>
</tr>
</tbody>
</table>

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>-54%</td>
</tr>
</tbody>
</table>

You can get fancy and wrap your negative percentages with parentheses with this syntax:

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0%_;(0%)</td>
</tr>
</tbody>
</table>

This syntax gives you percentages that look like this:

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>43%</td>
</tr>
</tbody>
</table>

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(54%)</td>
</tr>
</tbody>
</table>

If you include only one format syntax (meaning you don’t add a second formatting option with the use of a semicolon separator), that single format will be applied to all numbers — negative or positive.

**Formatting numbers in thousands and millions**

Earlier in this chapter, you format your revenue numbers to appear in thousands. This allows you to present cleaner numbers and avoid inundating the audience with overlarge numbers. To show your numbers in thousands, highlight them, right-click, and select Format Cells from the menu that appears.

After the Format Cells dialog box opens, click the Custom option to get to the screen shown in Figure 3-12.
In the Type input box, add a comma after the format syntax:

#,##0,

After confirming your changes, your numbers will automatically appear in the thousands place!

The beautiful thing here is that this technique doesn’t change the integrity or truncate the numeric values in any way. Excel is simply applying a cosmetic effect to the number. To see what this means, take a look at Figure 3-13.

The selected cell has been formatted to show in thousands; you see 118. But if you look on the formula bar above it, you’ll see the real unformatted number (117943.605787004). The 118 you are seeing in the cell is a cosmetically formatted version of the real number shown on the formula bar.
Custom number formatting has obvious advantages over using other techniques to format numbers to thousands. For instance, many beginning analysts would convert numbers to thousands by dividing them by 1,000 in a formula. But that changes the integrity of the number dramatically. When you perform a mathematical operation into a cell, you are literally changing the value represented in that cell. This forces you to carefully keep track of and maintain the formulas you introduced to simply achieve a cosmetic effect. Using custom number formatting avoids that by changing only how the number looks, keeping the actual number intact.

If needed, you can even indicate that the number is in thousands by adding “k” to the number syntax:

```
#,##0,"k"
```

This would show your numbers like this:

- 118k
- 318k

You can use this technique on both positive and negative numbers:

```
#,##0,"k"; (#,##0,"k")
```

After applying this syntax, your negative numbers also appear in thousands:

- 118k
- (318k)

Need to show numbers in millions? Easy. Simply add two commas to the number format syntax in the Type input box:

```
#,##0.00,, "m"
```

Note the use of the extra decimal places (.00). When converting numbers to millions, it’s often useful to show additional precision points, as in

- 24.65 m

**Hiding and suppressing zeroes**

In addition to formatting positive and negative numbers, Excel allows you to provide a format for zeroes. You do this by adding another semicolon to your custom number syntax. By default, any format syntax placed after the second semicolon is applied to any number that evaluates to zero.
For example, the following syntax applies a format that shows n/a for any cells that contain zeroes:

```
#,##0_);(#,##0);"n/a"
```

You can also use this to suppress zeroes entirely. If you add the second semicolon but don’t follow it with any syntax, cells containing zeroes will appear blank:

```
#,##0_);(#,##0);
```

Again, custom number formatting only affects the cosmetic look of the cell. The actual data in the cell is not affected. Figure 3-14 demonstrates this. The selected cell is formatted so that zeroes appear as n/a, but if you look at the formula bar, you can see the actual unformatted cell contents.

**Applying custom format colors**

Have you ever set the formatting on a cell so that negative numbers appear in red? If you have, you essentially applied a custom format color. In addition to controlling the look of your numbers with custom number formatting, you can control their color.

In this example, you format the percentages so that positive percentages appear blue with a + symbol, whereas negative percentages appear red with a – symbol. Enter this syntax in the Type input box shown in Figure 3-11:

```
[Blue]+0%;[Red]-0%
```

Notice that all it takes to apply a color is to enter the color name wrapped in square brackets [ ].
Now, there are only certain colors — the eight Visual Basic colors — you can call out by name like this. These colors make up the first eight colors of the default Excel color palette:

- Black
- Blue
- Cyan
- Green
- Magenta
- Red
- White
- Yellow

### Formatting dates and times

Custom number formatting isn’t just for numbers. You can also format dates and times. As you can see in Figure 3-15, you use the same dialog box to apply date and time formats using the Type input box.

Figure 3-15 demonstrates that date and time formatting involves little more than stringing together date-specific or time-specific syntax. The syntax used is fairly intuitive. For example, `ddd` is the syntax for the 3-letter day, `mmm` is the syntax for the 3-letter month, and `yyyy` is the syntax for the 4-digit year.
There are several variations on the format for days, months, years, hours, and minutes. It’s worthwhile to take some time and experiment with different combinations of syntax strings.

Table 3-1 lists some common date and time format codes you can use as starter syntax for your reports and dashboards.

<table>
<thead>
<tr>
<th>Format Code</th>
<th>1/31/2014 7:42:53 PM Displays As</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>1</td>
</tr>
<tr>
<td>Mm</td>
<td>01</td>
</tr>
<tr>
<td>mmm</td>
<td>Jan</td>
</tr>
<tr>
<td>mmmm</td>
<td>January</td>
</tr>
<tr>
<td>mmmmm</td>
<td>J</td>
</tr>
<tr>
<td>dd</td>
<td>31</td>
</tr>
<tr>
<td>ddd</td>
<td>Thu</td>
</tr>
<tr>
<td>dddd</td>
<td>Thursday</td>
</tr>
<tr>
<td>yy</td>
<td>14</td>
</tr>
<tr>
<td>yyyy</td>
<td>2014</td>
</tr>
<tr>
<td>mmm-yy</td>
<td>Jan-14</td>
</tr>
<tr>
<td>dd/mm/yyyy</td>
<td>31/01/2014</td>
</tr>
<tr>
<td>dddd mmm yyyy</td>
<td>Thursday Jan 2014</td>
</tr>
<tr>
<td>mm-dd-yyyy hh:mm AM/PM</td>
<td>01-31-2014 7:42 PM</td>
</tr>
<tr>
<td>h hh:mm AM/PM</td>
<td>7 PM</td>
</tr>
<tr>
<td>h:mm AM/PM</td>
<td>7:42 PM</td>
</tr>
<tr>
<td>h:mm:ss AM/PM</td>
<td>7:42:53 PM</td>
</tr>
</tbody>
</table>
This chapter introduces you to sparklines. These magically named visualizations are essentially mini word-size charts placed in and among the textual data in tables. Sparklines enable you to see, at a glance, trends and patterns within your data using minimal real estate on your dashboard.

Before getting into the nuts-and-bolts of using sparklines, you should understand exactly how they can enhance your reporting. This chapter introduces you to the concept of sparklines and then shows you how to customize and add them to tables.

Introducing Sparklines

As I mention in Chapter 3, much of the reporting done in Excel is table-based, in which precise numbers are more important than pretty charts. However, in table-based reporting, you often lose the ability to show important aspects of the data such as trends. The number of columns needed to show adequate trend data in a table makes it impractical to do so. Any attempt to add trend data to a table usually does nothing more than render your report unreadable.
In the example in Figure 4-1, the data represents a compact KPI (key performance indicator) summary designed to be an at-a-glance view of key metrics. Although the table compares various time periods (in columns D, E, and F), it does so only by averaging, which tells you nothing about trends over time. It quickly becomes evident that seeing a full-year trend would be helpful.

Figure 4-1: Although this KPI summary is useful, it cannot show a full-year trend.

<table>
<thead>
<tr>
<th>Compact KPI Summary</th>
<th>Current Month</th>
<th>Last 3 Mo Avg</th>
<th>Last 12 mo Avg</th>
<th>Target</th>
<th>% of Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 Revenues</td>
<td>$18,134 K</td>
<td>$17,985 K</td>
<td>$17,738 K</td>
<td>$18,000 K</td>
<td>101%</td>
</tr>
<tr>
<td>5 Expenses</td>
<td>$11,358 K</td>
<td>$11,186 K</td>
<td>$11,580 K</td>
<td>$11,600 K</td>
<td>90%</td>
</tr>
<tr>
<td>5 Profits</td>
<td>$6,776 K</td>
<td>$6,799 K</td>
<td>$6,147 K</td>
<td>$5,400 K</td>
<td>125%</td>
</tr>
<tr>
<td>% Market Share</td>
<td>44%</td>
<td>46%</td>
<td>45%</td>
<td>53%</td>
<td>85%</td>
</tr>
<tr>
<td>Flights</td>
<td>446</td>
<td>447</td>
<td>446</td>
<td>500</td>
<td>89%</td>
</tr>
<tr>
<td>Passengers</td>
<td>63 K</td>
<td>62 K</td>
<td>61 K</td>
<td>65 K</td>
<td>97%</td>
</tr>
<tr>
<td>Miles</td>
<td>346 K</td>
<td>347 K</td>
<td>349 K</td>
<td>395 K</td>
<td>88%</td>
</tr>
<tr>
<td>Passenger Miles</td>
<td>$1,206 K</td>
<td>$1,376 K</td>
<td>$1,510 K</td>
<td>$6,000 K</td>
<td>87%</td>
</tr>
<tr>
<td>Cancelled Flights</td>
<td>9</td>
<td>9</td>
<td>10</td>
<td>15</td>
<td>60%</td>
</tr>
<tr>
<td>Late Arrivals</td>
<td>63</td>
<td>71</td>
<td>64</td>
<td>45</td>
<td>141%</td>
</tr>
<tr>
<td>Minutes Late</td>
<td>1,302</td>
<td>1,472</td>
<td>1,537</td>
<td>1,000</td>
<td>150%</td>
</tr>
<tr>
<td>5 Fuel Costs</td>
<td>$1,293 K</td>
<td>$1,352 K</td>
<td>$1,318 K</td>
<td>$1,080 K</td>
<td>120%</td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>4.52</td>
<td>4.5</td>
<td>4.5</td>
<td>4.80</td>
<td>94%</td>
</tr>
<tr>
<td>Flight Utilization</td>
<td>92%</td>
<td>91%</td>
<td>91%</td>
<td>94%</td>
<td>98%</td>
</tr>
</tbody>
</table>

Figure 4-2 illustrates the same KPI summary with Excel sparklines added to visually show the 12-month trend. With the sparklines added, you can see the broader story behind each metric. For example, based solely on the numbers, the Passengers metric appears to be up slightly from the average. But the sparkline tells the story of a heroic comeback from a huge hit at the beginning of the year.

Again, it’s not about adding flash and pizzazz to your tables. It’s about building the most effective message in the limited space you have. Sparklines are another tool you can use to add another dimension to your table-based reports.

Sparklines are available only with Excel 2010-subsequent versions. When you open a workbook with sparklines using a pre-2010 version of Excel, the sparkline cells are empty. If your organization is not fully using Excel 2010 or greater, you may want to search for alternatives to the built-in Excel sparklines. Many third-party add-ins bring sparkline features to earlier versions of Excel. Some of these products support additional sparkline types, and most have customization options. Search the web for sparklines excel, and you’ll find several add-ins to choose among.
Chapter 4: Sparking Inspiration with Sparklines

Understanding Sparklines

Although sparklines look like miniature charts (and can sometimes take the place of a chart), this feature is completely separate from the Excel chart feature (covered in Chapters 7, 8, and 9 of this book). For example, charts are placed on a worksheet’s drawing layer, and a single chart can display several series of data. In contrast, a sparkline is displayed inside a worksheet cell and displays only one series of data.

Excel supports three types of sparklines: Line, Column, and Win/Loss. Figure 4-3 shows examples of each type of sparkline graphic, displayed in column H. Each sparkline depicts the six data points to the left.

- **Line:** Similar to a line chart, the Line type of sparkline can appear with or without a marker for each data point. The first group in Figure 4-3 shows Line sparklines with markers. A quick glance reveals that with the exception of Fund Number W-91, the funds have been losing value over the 6-month period.

- **Column:** Similar to a column chart, the second group shows the same data with Column sparklines.

- **Win/Loss:** A Win/Loss sparkline is a binary-type chart that displays each data point as a high block or a low block. The third group shows Win/Loss sparklines. Notice that the data is different. Each cell displays the change from the previous month. In the sparkline, each data point is depicted as a high block (win) or a low block (loss). In this example, a positive change from the previous month is a win, and a negative change from the previous month is a loss.
Part II: Building Basic Dashboard Components

Creating sparklines

Figure 4-4 shows some weather data that you can summarize with sparklines. To create sparkline graphics for the values in these nine rows, follow these steps:

1. Select the data range that you want to summarize. In this example, select B4:M12.

   If you are creating multiple sparklines, select all the data.

2. With the data selected, click the Insert tab on the Ribbon and find the Sparklines group.

   Figure 4-3:
   Three types of sparklines.

   Figure 4-4:
   Data that you want to summarize with sparkline graphics.
Chapter 4: Sparking Inspiration with Sparklines

3. On the Insert tab, select any one of the three sparkline types — Line, Column, or Win/Loss — from the Sparklines group. In this case, select the Column option.

Excel displays the Create Sparklines dialog box, as shown in Figure 4-5.

4. Specify the data range and the location for the sparklines. For this example, specify N4:N12 as the Location Range.

Typically, you put the sparklines next to the data, but that’s not required. Most of the time, you use an empty range to hold the sparklines. However, Excel does not prevent you from inserting sparklines into filled-in cells. The sparkline location that you specify must match the source data in terms of number of rows or number of columns.

5. Click OK.

Excel creates the sparklines graphics of the type you specified, as shown in Figure 4-6.

The sparklines are linked to the data, so if you change any of the values in the data range, the sparkline graphic will update.
Most of the time, you’ll create sparklines on the same sheet that contains the data. If you want to create sparklines on a different sheet, start by activating the sheet where the sparklines will be displayed. Then, in the Create Sparklines dialog box, specify the source data either by selecting the cell range or by typing the complete sheet reference (for example, Sheet1!A1:C12). The Create Sparklines dialog box lets you specify a different sheet for the Data Range, but not for the Location Range.

**Understanding sparkline groups**

Most of the time, you’ll probably create a group of sparklines — one for each row or column of data. A worksheet can hold any number of sparkline groups. Excel remembers each group, and you can work with the group as a single unit. For example, you can select one sparkline in a group and then modify the formatting of all sparklines in the group. When you select one sparkline cell, Excel displays an outline of all other sparklines in the group.

You can, however, perform some operations on an individual sparkline in a group:

- **Change the sparkline’s data source.** Click the sparkline cell and go to the Sparkline Tools tab on the Ribbon. There, you can click Design ➔ Sparkline ➔ Edit Data ➔ Edit Single Sparkline’s Data. Excel displays a dialog box that lets you change the data source for the selected sparkline.

- **Delete the sparkline.** Click the sparkline, click the Sparkline Tools tab on the Ribbon, and then select Design ➔ Group ➔ Clear ➔ Clear Selected Sparklines.

Both operations — changing the sparkline’s data source and deleting the sparkline — are available from the shortcut menu that appears when you right-click a sparkline cell.

You can also ungroup a set of sparklines. Select any sparkline in the group and choose Design ➔ Group ➔ Ungroup from the Sparkline Tools tab. After you ungroup a set of sparklines, you can work with each sparkline individually.

You can add a new sparkline to an existing group by first selecting any sparkline in the existing group and then choosing Design ➔ Edit Data ➔ Edit Group Location & Data. This opens the Edit Sparklines dialog box. Simply edit the Data Range and Location Range to include the new data you want to add.
**Customizing Sparklines**

When you activate a cell that contains a sparkline, Excel displays an outline around all sparklines in its group. You can then use the commands on the Sparkline Tools ➪ Design tab to customize the group of sparklines.

**Sizing and merging sparkline cells**

When you change the width or height of a cell that contains a sparkline, the sparkline adjusts to fill the new cell size. In addition, you can put a sparkline into merged cells. To merge cells, select at least two cells and choose Home ➪ Alignment ➪ Merge & Center from the Ribbon.

Figure 4-7 shows the same sparkline displayed in four sizes, resulting from changing column width and row height and from merging cells.

It’s important to note that a skewed aspect ratio can distort your visualizations, exaggerating the trend in sparklines that are too tall and flattening the trend in sparklines that are too wide. Generally speaking, the most appropriate aspect ratio for a chart is one where the width of the chart is about twice as long as the height. In Figure 4-7, the sparkline with the most appropriate aspect ratio is the one located in cell M4.

If you merge cells and the merged cells occupy more than one row or one column, Excel doesn’t let you insert a group of sparklines into those merged cells. Rather, you need to insert the sparklines into a normal range (with no merged cells) and then merge the cells.
You can also put a sparkline in non-empty cells, including merged cells. Figure 4-8 shows two sparklines that occupy merged cells alongside text that describes the graphics.

Handling hidden or missing data

In some cases, you simply want to present a sparkline visualization without the numbers. One way to do this is to hide the rows or columns that contain the data. Figure 4-9 shows a table with the values displayed and the same table with the values hidden (by hiding the columns).

By default, if you hide rows or columns that contain data used in a sparkline graphic, the hidden data does not appear in the sparkline. In addition, blank cells are displayed as a gap in the graphic.

To change these default settings, go to the Sparkline Tools tab on the Ribbon and select Design ‒ Sparkline ‒ Edit Data ‒ Hidden & Empty Cells. In the Hidden and Empty Cell Settings dialog box, you can specify how to handle hidden data and empty cells.
Chapter 4: Sparking Inspiration with Sparklines

Changing the sparkline type

As mentioned earlier in this chapter, Excel supports three sparkline types: Line, Column, and Win/Loss. After you create a sparkline or group of sparklines, you can easily change the type by clicking the sparkline and selecting one of the three icons located under Sparkline Tools ➪ Design ➪ Type. If the selected sparkline is part of a group, all sparklines in the group are changed to the new type.

If you’ve customized the appearance, Excel remembers the customization settings for each sparkline type if you switch among different ones.

Changing sparkline colors and line width

After you create a sparkline, changing the color is easy. Simply click to select the sparkline, click to open the Sparkline Tools tab on the Ribbon, and select Design ➪ Style. There, you find various options to change the color and style of the sparkline.

For Line sparklines, you can also specify the line width. Choose Sparkline Tools ➪ Design ➪ Style ➪ Sparkline Color ➪ Weight.

Colors used in sparkline graphics are tied to the document theme. If you change the theme (by choosing Page Layout ➪ Themes ➪ Themes), the sparkline colors then change to the new theme colors.

Using color to emphasize key data points

Use the commands under Sparkline Tools ➪ Design ➪ Show to customize the sparklines to emphasize key aspects of the data. These options are in the Show group:

- **High Point**: Apply a different color to the highest data point in the sparkline.
- **Low Point**: Apply a different color to the lowest data point in the sparkline.
- **Negative Points**: Apply a different color to negative values in the sparkline.
- **First Point**: Apply a different color to the first data point in the sparkline.
**Part II: Building Basic Dashboard Components**

- **✓ Last Point:** Apply a different color to the last data point in the sparkline.
- **✓ Markers:** Show data markers in the sparkline. This option is available only for Line sparklines.

You can control the color of sparkline markers by using the Marker Color control in the Sparkline Tools ➪ Design ➪ Style group. Unfortunately, you cannot change the size of the markers in Line sparklines.

**Adjusting sparkline axis scaling**

When you create one or more sparklines, they all use (by default) automatic axis scaling. In other words, Excel determines the minimum and maximum vertical axis values for each sparkline in the group based on the numeric range of the sparkline data.

The Sparkline Tools ➪ Design ➪ Group ➪ Axis command lets you override this automatic behavior and control the minimum and maximum values for each sparkline or for a group of sparklines. For even more control, you can use the Custom Value option and specify the minimum and maximum for the sparkline group.

Axis scaling can make a huge difference in the sparklines. Figure 4-10 shows two groups of sparklines. The group at the bottom uses the default axis settings (Automatic For Each Sparkline option). Each sparkline in this group shows the 6-month trend for the product but not the magnitude of the values.

![Figure 4-10: The bottom group of sparklines shows the effect of using the same axis minimum and maximum values for all sparklines in a group.](image)
Chapter 4: Sparking Inspiration with Sparklines

The sparkline group at the bottom (which uses the same data) uses the Same for All Sparklines setting for the minimum and maximum axis values. With these settings in effect, the magnitude of the values across the products is apparent — but the trend across the months within a product is not apparent.

The axis scaling option you choose depends on what aspect of the data you want to emphasize.

Faking a reference line

One useful feature that’s missing in sparklines is a reference line. For example, it might be useful to show performance relative to a goal. If the goal is displayed as a reference line in a sparkline, the viewer can quickly see whether the performance for a period exceeded the goal.

One approach is to write formulas that transform the data and then use a sparkline axis as a fake reference line. Figure 4-11 shows an example. Students have a monthly reading goal of 500 pages. The range of data shows the actual pages read, with sparklines in column H. The sparklines show the 6-month page data, but it’s impossible to tell who exceeded the goal or when they did it.

![Figure 4-11: Sparklines display the number of pages read per month.](image)

The lower set of sparklines in Figure 4-12 shows another approach: Transform the data such that meeting the goal is expressed as a 1, and failing to meet the goal is expressed as a –1. The following formula (in cell B18) transforms the original data:

```
=IF(B6>$C$2,1,-1)
```
This formula was copied to the other cells in the B18:G25 range.

Using the transformed data, Win/Loss sparklines are used to visualize the results. This approach is better than the original, but it doesn’t convey magnitude differences. For example, you cannot tell whether the student missed the goal by 1 page or by 500 pages.

Figure 4-13 shows a better approach. Here, the original data is transformed by subtracting the goal from the pages read. The formula in cell B30 is

\[ B6 - C2 \]

This formula was copied to the other cells in the B30:G37 range, and a group of Line sparklines displays the resulting values. This group has the Show Axis setting enabled and also uses Negative Point markers so that the negative values (failure to meet the goal) clearly stand out.

**Specifying a date axis**

By default, data displayed in a sparkline is assumed to be at equal intervals. For example, a sparkline might display a daily account balance, sales by month, or profits by year. But what if the data isn’t at equal intervals?
Figure 4-14 shows data, by date, along with a sparklines graphic created from column B. Notice that some dates are missing but that the sparkline shows the columns as though the values were spaced at equal intervals.

To better depict this type of time-based data, the solution is to specify a Date axis. Select the sparkline and choose Sparkline Tools ➤ Design ➤ Group ➤ Axis ➤ Date Axis Type.

Excel displays a dialog box asking for the range that contains the corresponding dates. In this example, specify range A2:A11.
Click OK, and the sparkline displays gaps for the missing dates, as shown in Figure 4-15.

**Figure 4-15:** After you specify a date axis, the sparkline shows the values accurately.

### Autoupdating sparkline ranges

If a sparkline uses data in a normal range of cells, adding new data to the beginning or end of the range does not force the sparkline to use the new data. You need to use the Edit Sparklines dialog box to update the data range (Sparkline Tools ➪ Design ➪ Sparkline ➪ Edit Data).

However, if the sparkline data is in a column within a table object (created using Insert ➪ Tables ➪ Table, as described in Chapter 2), the sparkline uses new data that’s added to the end of the table without requiring an update.

Figure 4-16 shows an example. The sparkline was created using the data in the Rate column of the table, which covers the range from January to August. If you were to add the new rate for September, the sparkline would automatically update its data range.

**Figure 4-16:** Creating a sparkline from data in a table.
Chapter 5
Formatting Your Way to Visualizations

In This Chapter
▶ Using conditional formatting
▶ Working with symbols in formulas
▶ Using the Camera tool
▶ Creating a waffle chart

Visualization is the presentation of abstract concepts or data in visual terms through some sort of graphical imagery. A traffic light, for example, is a visualization of the abstract concepts of stop-and-go.

In the business world, visualizations help us communicate and process the meaning of data faster than simple tables of numbers. Excel offers business analysts a wide array of features that can be used to add visualizations to dashboards and reports.

In this chapter, you explore some of the formatting techniques you can leverage to add layers of visualizations that can turn your data into meaningful views.

Enhancing Reports with Conditional Formatting

Conditional formatting is the term given to Excel’s capability to dynamically change the formatting of a value, cell, or range of cells based on a set of conditions you define. Conditional formatting adds a level of visualization that allows you to look at your Excel reports and make split-second
determinations on which values are “good” and which are “bad,” simply based on formatting.

In this section, you enter the world of conditional formatting as you see how to leverage this functionality to enhance your reports and dashboards.

**Applying basic conditional formatting**

Thanks to the many predefined scenarios that Excel offers, you can apply some basic conditional formatting with a few clicks of the mouse. To get a first taste of what you can do, click the Conditional Formatting button found on the Home tab of the Ribbon, as shown in Figure 5-1.

As you can see, Excel has five categories of predefined scenarios: Highlight Cells Rules, Top/Bottom Rules, Data Bars, Color Scales, and Icon Sets.

Take a moment to review what you can do by using each category of pre-defined scenario.

**Using the Highlight Cells Rules**

The formatting scenarios under the Highlight Cells Rules category, shown in Figure 5-2, allow you to highlight those cells whose values meet a specific condition.
Chapter 5: Formatting Your Way to Visualizations

The thing to remember about these scenarios is that they work much like an *If ... then ... else* statement. That is to say, if the condition is met, the cell is formatted and if the condition is not met, the cell remains untouched.

The scenarios under the Highlight Cells Rules category are self-explanatory. Here’s a breakdown of what you can conditionally format with each scenario:

- **Greater Than**: A cell whose value is greater than a specified amount. For instance, you can tell Excel to format those cells that contain a value greater than 50.
- **Less Than**: A cell whose value is less than a specified amount. For instance, you can tell Excel to format those cells that contain a value less than 100.
- **Between**: A cell whose value is between two given amounts. For example, you can tell Excel to format those cells that contain a value between 50 and 100.
- **Equal To**: A cell whose value is equal to a given amount. For example, you can tell Excel to format those cells that contain a value that is exactly 50.
- **Text That Contains**: A cell whose contents contain any form of a given text you specify as a criterion. For example, you can tell Excel to format those cells that contain the text *North*.
Part II: Building Basic Dashboard Components

- **A Date Occurring**: A cell whose contents contain a date occurring in a specified period relative to today's date. For example, Yesterday, Last Week, Last Month, Next Month, or Next Week.

- **Duplicate Values**: Both duplicate values and unique values in a given range of cells. This rule was designed more for data clean-up than for dashboarding, enabling you to quickly identify either duplicates or unique values in your dataset.

Take a moment to work the following example of how to apply one of these scenarios. In this simple example, you highlight all values greater than a certain amount.

1. Start by selecting the range of cells to which you need to apply the conditional formatting.

2. Choose the Greater Than scenario found under the Highlight Cells Rules category, shown in Figure 5-2.

   This step opens the dialog box shown in Figure 5-3. In this dialog box, the idea is to define a value that will trigger the conditional formatting.

   ![Figure 5-3: Each scenario has its own dialog box you can use to define the trigger values and the format for each rule.](image)

3. Either type the value (400 in this example) or reference a cell that contains the trigger value, and then use the box’s drop-down menu to specify the format you want applied.

4. Click the OK button.

   Immediately, Excel applies the formatting rule to the selected cells; see Figure 5-4.
The benefit of a conditional formatting rule is that Excel automatically reevaluates the rule every time a cell is changed (as long as that cell has a conditional formatting rule applied to it). For instance, if I were to change any of the low values to 450, the formatting for that value would automatically change because all cells in the dataset have the formatting applied to them.

**Applying Top/Bottom Rules**

The formatting scenarios under the Top/Bottom Rules category, shown in Figure 5-5, allow you to highlight those cells whose values meet a given threshold.
Like the Highlight Cells Rules, these scenarios work like If...then...else statements: If the condition is met, the cell is formatted; if the condition is not met, the cell remains untouched.

Here is a breakdown of each scenario under the Top/Bottom Rules category:

- **Top 10 Items**: Although the name doesn’t suggest it, this scenario allows you to specify any number of cells to highlight based on individual cell values (not just ten). For example, you can highlight the top five cells whose values are among the five largest numbers of all elected cells.

- **Top 10 %**: This scenario is similar to the Top 10 Items scenario: Only the selected cells are evaluated on a percentage basis. Again, don’t let the name fool you: The percent selection does not have to be ten. For instance, you can highlight the cells whose values make up the top 20 percent of the total values of all selected cells.

- **Bottom 10 Items**: You can use this scenario to specify the number of cells to highlight based on the lowest individual cell values. Again, don’t let the name fool you: You can specify any number of cells to highlight — not just 10. For example, you can highlight the bottom 15 cells whose values are within the 15 smallest numbers among all selected cells.

- **Bottom 10 %**: Though this scenario is similar to the Bottom 10 Items scenario, in this one, only selected cells are evaluated on a percentage basis. For instance, you can highlight the cells whose values make up the bottom 15 percent of the total values of all the selected cells.

- **Above Average**: This scenario allows you to conditionally format each cell whose value is above the average of all cells selected.

- **Below Average**: Allows you to conditionally format each cell whose value is below the average of all cells selected.

To avoid overlapping different conditional formatting scenarios, you may want to clear any conditional formatting you’ve previously applied before applying a new scenario. To clear the conditional formatting for a given range of cells, select the cells and select Conditional Formatting from the Home tab of the Ribbon. There, you find the Clear Rules selection. Click Clear Rules and select whether you want to clear conditional formatting for the entire sheet or only the selected workbook.

In the following example, you conditionally format all cells whose values are within the top 40 percent of the total values of all cells.

1. Start by selecting the range of cells to which you need to apply the conditional formatting.
2. Choose the Top 10% scenario found under the Top/Bottom Rules category; refer to Figure 5-5.

This step opens the Top 10% dialog box shown in Figure 5-6. The idea here is to define the threshold that will trigger the conditional formatting.

3. In this example, enter 40 and then use the box’s drop-down menu to specify the format you want applied.

4. Click OK.

Immediately, Excel applies the formatting scenario to the selected cells. See Figure 5-7.
Creating Data Bars

Data Bars fill each cell you are formatting with mini-bars in varying length, indicating the value in each cell relative to other formatted cells. Excel essentially takes the largest and smallest values in the selected range and calculates the length for each bar. To apply Data Bars to a range, do the following:

1. Select the target range of cells to which you need to apply the conditional formatting.
2. Choose Data Bars from the Conditional Formatting menu on the Home tab, as demonstrated in Figure 5-8.

As you can see in Figure 5-9, the result is essentially a mini-chart within the cells you selected. Also note that by default, the Data Bars scenario accounts for negative numbers nicely by changing the direction of the bar and inverting the color to red.
Chapter 5: Formatting Your Way to Visualizations

Applying Color Scales

Color Scales fill each cell you are formatting with a color varying in scale based on the value in each cell relative to other formatted cells. Excel essentially takes the largest and smallest values in the selected range and determines the color for each cell. To apply Color Scales to a range, do the following:

1. Select the target range of cells to which you need to apply the conditional formatting.

2. Choose Color Scales from the Conditional Formatting menu on the Home tab. (See Figure 5-10.)
As you can see in Figure 5-11, the result is a kind of heat-map within the cells you selected.

![Figure 5-11: Conditional formatting with Color Scales.](image)

### Using Icon Sets

Icon Sets are sets of symbols that are inserted in each cell you are formatting. Excel determines which symbol to use based on the value in each cell relative to other formatted cells. To apply an Icon Set to a range, do the following:

1. Select the target range of cells to which you need to apply the conditional formatting.

2. Choose Icon Sets from the Conditional Formatting menu on the Home tab.

As you can see in Figure 5-12, you can choose from a menu of Icon Sets varying in shape and color.

Figure 5-13 illustrates how each cell is formatted with a symbol indicating each cell’s value based on the other cells.

### Adding your own formatting rules manually

You don’t have to use one of the predefined scenarios offered by Excel. Excel gives you the flexibility to create your own formatting rules manually. Creating your own formatting rules helps you better control how cells are formatted and allows you to do things you wouldn’t be able to do with the predefined scenarios.
For example, a useful conditional formatting rule is to tag all above-average values with a Check icon and all below-average values with an X icon. Figure 5-14 demonstrates this rule.
Although it’s true that the Above Average and Below Average scenarios built into Excel allow you to format cell and font attributes, they don’t enable the use of Icon Sets. You can imagine why Icon Sets would be better on a dashboard than simply color variances. Icons and shapes do a much better job of conveying your message, especially when the dashboard is printed in black-and-white.

To get started in creating your first custom formatting rule, open the Chapter 5 Samples file found among the sample files on this book’s companion website. After the file is open, go to the Create Rule by Hand tab, and then follow these steps:

1. Select the target range of cells to which you need to apply the conditional formatting, and select New Rule from the Conditional Formatting menu, as demonstrated in Figure 5-15.
This step opens the New Formatting Rule dialog box shown in Figure 5-16. As you look at the rule types at the top of the dialog box, you may recognize some of them from the predefined scenario choices discussed earlier in this chapter. Here’s what each type does:

- **Format All Cells Based on Their Values**: Measures the values in the selected range against each other. This selection is handy for finding general anomalies in your dataset.

- **Format Only Cells That Contain**: Applies conditional formatting to those cells that meet specific criteria you define. This selection is perfect for comparing values against a defined benchmark.

- **Format Only Top or Bottom Ranked Values**: Applies conditional formatting to those cells that are ranked in the top or bottom Nth number or percent of all values in the range.

- **Format Only Values That Are Above or Below Average**: Applies conditional formatting to those values that are mathematically above or below the average of all values in the selected range.

- **Use a Formula to Determine Which Cells to Format**: Evaluates values based on a formula you specify. If a particular value evaluates to true, the conditional formatting is applied to that cell. This selection is typically used when applying conditions based on the results of an advanced formula or mathematical operation.

Data Bars, Color Scales, and Icon Sets can be used only with the Format All Cells Based on Their Values rule type.

2. Ensure that the Format All Cells Based on Their Values rule type is selected and then use the Format Style drop-down menu to switch to Icon Sets.

3. Click the Icon Style drop-down menu to select an Icon Set.
4. Change both Type drop-down menus to Formula.

5. In each Value box, enter =Average($C$2:$C$22).

   This step tells Excel that the value in each cell must be greater than the average of the entire dataset in order to get the Check icon.

   At this point, the dialog box looks similar to the one in Figure 5-17.

6. Click OK to apply your conditional formatting.

   ![Figure 5-17: Change the Type drop-down boxes to Formula and enter the appropriate formulas in the Value boxes.](image)

   It’s worth taking some time to understand how this conditional formatting rule works. Excel assesses every cell in the target range to see whether its contents match, in order (top box first), the logic in each Value box. If a cell contains a number or text that evaluates true to the first Value box, the first icon is applied and Excel moves on to the next cell in the range. If not, Excel continues down each Value box until one of them evaluates to true. If the cell being assessed does not fit any of the logic placed in the Value boxes, Excel automatically tags that cell with the last icon.

   In this example, you want a cell to get a Check icon only if the value of the cell is greater than (or equal to) the average of the total values. Otherwise, you want Excel to skip directly to the X icon and apply the X.
Showing only one icon

In many cases, you may not need to show all icons when applying the Icon Set. In fact, showing too many icons at one time may serve only to obstruct the data you’re trying to convey on the dashboard.

In the earlier example, you apply a Check icon to values above the average for the range and apply an X icon to all below-average values; see Figure 5-18. However, in the real world, you often need to bring attention to only the below-average values. This way, your eyes aren’t inundated with superfluous icons.

Excel provides a clever mechanism to allow you to stop evaluating and formatting values if a condition is true.

In this example, you want to remove the Check icons. The cells that contain those icons all have values above the average for the range. Therefore, you first need to add a condition for all cells whose values are above average. To do so, follow these steps:

1. Select the target range of cells, and then go to the Home tab and select Conditional Formatting ➤ Manage Rules.

   This step opens the Conditional Formatting Rules Manager dialog box shown in Figure 5-19.

2. Click the New Rule button to start a new rule.

   The New Formatting Rule dialog box appears.
3. Click the Format Only Cells That Contain rule type and then configure the rule so that the format applies only to cell values greater than the average; see Figure 5-20.

4. Click OK without changing any of the formatting options.

5. Back in the Conditional Formatting Rules Manager, click to select the Stop If True check box, as demonstrated on the right side of Figure 5-21.
6. Click OK to apply your changes.

As you can see in Figure 5-22, only the X icons are now shown. Again, this allows your audience to focus on the exceptions rather than determining which icons are good and bad.

**Showing Data Bars and icons outside of cells**

Bars and Icon Sets give you a snazzy way to add visualizations to your dashboards; you don’t have a lot of say in where they appear within the cell. Take a look at Figure 5-23 to see what I mean.
By default, the Data Bars are placed directly inside each cell, which in this case almost obfuscates the data. From a dashboarding perspective, this is less than ideal, for two reasons:

- The numbers can get lost in the colors of the Data Bars, making them difficult to read — especially when printed in black-and-white.
- It’s difficult to see the ends of each bar.

The solution to this problem is to show the Data Bars outside the cell that contains the value. Here’s how:

1. **To the right of each cell, enter a formula that references the cell containing the data value.**
   
   For example, if the data is in B2, go to cell C2 and enter =B2.

2. **Apply the Data Bar conditional formatting to the formulas you just created.**

3. **Select the formatted range of cells and select Manage Rules under the Conditional Formatting button on the Home tab of the Ribbon.**

4. In the dialog box that opens, click the Edit Rule button.

5. **Select the Show Bar Only option, as demonstrated in Figure 5-24.**

6. Click OK to apply the change.
Chapter 5: Formatting Your Way to Visualizations

The reward for your efforts is a cleaner view that’s much better suited for reporting in a dashboard environment. Figure 5-25 illustrates the improvement gained with this technique.

Using the same technique, you can separate Icon Sets from the data — allowing you to position the icons where they best suit your dashboard.

**Representing trends with Icon Sets**

A dashboard environment may not always have enough space available to add a chart that shows trending. In these cases, Icon Sets are ideal replacements, enabling you to visually represent the overall trending without taking up a lot of space. Figure 5-26 illustrates this concept with a table that provides a nice visual element, allowing for an at-a-glance view of which markets are up, down, or flat over the previous month.
You may want to do the same type of thing with your reports. The key is to create a formula that gives you a variance or trending of some sort.

To achieve this type of view, follow these steps:

1. Select the target range of cells to which you need to apply the conditional formatting.

   In this case, the target range will be the cells that hold your variance formulas.

2. Choose Icon Sets from the Conditional Formatting menu on the Home tab and then choose the most appropriate icons for your situation.

   For this example, choose the set with three arrows shown in Figure 5-27.
In most cases, you’ll adjust the thresholds that define what up, down, and flat mean. Imagine that you need any variance above 3 percent to be tagged with an up arrow, any variance below −3 percent to be tagged with a down arrow, and all others to show flat.

3. Select the target range of cells and select Manage Rules under the Conditional Formatting button on the Home tab of the Ribbon.

4. In the dialog box that opens, click the Edit Rule button.

5. Adjust the properties, as shown in Figure 5-28.

6. Click OK to apply the change.

Notice in Figure 5-28 that the Type property for the formatting rule is set to Number even though the data you’re working with (the variances) is percentages. You’ll find that working with the Number setting gives you more control and predictability when setting thresholds.

**Using Symbols to Enhance Reporting**

Symbols are essentially tiny graphics, not unlike those you see when you use Wingdings or Webdings or other fancy fonts. However, symbols are not really fonts. They’re Unicode characters. Unicode characters are a set of industry standard text elements designed to provide a reliable character set that remains viable on any platform regardless of international font differences.
One example of a commonly used symbol is the copyright symbol (©). This symbol is a Unicode character. You can use it on a Chinese, Turkish, French, or American PC, and it will reliably be available, with no international differences.

In terms of Excel presentations, Unicode characters (or symbols) can be used in places where conditional formatting cannot. For instance, in the chart labels you see in Figure 5-29, the x-axis shows some trending arrows that allow for an extra layer of analysis. This couldn't be done with conditional formatting.

Let me take some time now to review the steps that led to the chart in Figure 5-29.

![Figure 5-29: Use symbols to add an extra layer of analysis to charts.]

Start with the data shown in Figure 5-30. Note that you have a designated cell — C1 in this case — to hold any symbols you're going to use. This cell isn't all that important. It's just a holding cell for the symbols you'll insert.

![Figure 5-30: The starting data with a holding cell for symbols.]

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbols &gt;&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>vs. Prior Month</td>
<td>Market</td>
<td>Current Month</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>5%</td>
<td>Great Lakes</td>
<td>72,505</td>
<td></td>
</tr>
<tr>
<td>30%</td>
<td>New England</td>
<td>283,324</td>
<td></td>
</tr>
<tr>
<td>-6%</td>
<td>New York North</td>
<td>148,790</td>
<td></td>
</tr>
<tr>
<td>27%</td>
<td>New York South</td>
<td>68,009</td>
<td></td>
</tr>
<tr>
<td>-2%</td>
<td>Ohio</td>
<td>98,308</td>
<td></td>
</tr>
<tr>
<td>34%</td>
<td>Shenandoah Valley</td>
<td>200,076</td>
<td></td>
</tr>
</tbody>
</table>
Now follow these steps:

1. Click in C1 and then select the Symbol command on the Insert tab. The Symbol dialog box shown in Figure 5-31 opens.

2. Find and select symbols by clicking the Insert button after each symbol.
   In this scenario, select the down-pointing triangle and click Insert. Then click the up-pointing triangle and click Insert. Close the dialog box when you’re done.
   At this point, you have the up-triangle and down-triangle symbols in cell C1, as shown in Figure 5-32.
3. Click the C1 cell, go to the Formula bar, and copy the two symbols by highlighting them and pressing Ctrl+C on the keyboard.

4. Go to the data table, right-click the percentages, and then select Format Cells from the menu that appears.

5. In the Format Cells dialog box, create a new custom format by pasting the up- and down-triangle symbols into the appropriate syntax parts; see Figure 5-33.

   In this case, any positive percentage will be preceded by the up-triangle symbol, and any negative percentage will be preceded by the down-triangle symbol.

   Not familiar with custom number formatting? Chapter 3 covers the ins and outs of custom number formatting in detail.

6. Click OK.

   The symbols are now part of your number formatting! Figure 5-34 illustrates what the percentages look like. Change any number from positive to negative (or vice versa), and Excel automatically applies the appropriate symbol.
Because charts automatically adopt number formatting, a chart created from this data shows the symbols as part of the labels. Simply use this data as the source for the chart.

This is just one way to use symbols in your reporting. With this basic technique, you can insert symbols to add visual appeal to tables, pivot tables, formulas, or any other object you can think of.

**Wielding the Magical Camera Tool**

Excel’s Camera tool enables you to take a live picture of a range of cells that updates dynamically while the data in that range updates. If you’ve never heard of it, don’t feel bad. This nifty tool has been hidden away in the last few versions of Excel. Although Microsoft has chosen not to include this tool on the mainstream Ribbon, it’s actually quite useful if you’re building dashboards and reports.

**Finding the Camera tool**

Before you can use the Camera tool, you have to find it and add it to the Quick Access toolbar.

The *Quick Access toolbar* is a customizable toolbar on which you can store frequently used commands so that they’re always accessible with just one click. You can add commands to the Quick Access toolbar by dragging them directly from the Ribbon or by using the Customize menu.

Follow these steps to add the Camera tool to the Quick Access toolbar:

1. **Click the File button.**
2. **Open the Excel Options dialog box by clicking the Options button.**
3. **Click the Quick Access Toolbar button.**
4. **On the Choose Commands From drop-down list, select Commands Not in the Ribbon.**
5. **Scroll down the alphabetical list of commands shown in Figure 5-35 and find Camera; double-click it to add it to the Quick Access toolbar.**
6. **Click OK.**

After you’ve taken these steps, you see the Camera tool on the Quick Access toolbar, as shown in Figure 5-36.
Part II: Building Basic Dashboard Components

Using the Camera tool

To use the Camera tool, you simply highlight a range of cells to then capture everything in that range in a live picture. The cool thing about the Camera tool is that you’re not limited to showing a single cell’s value, as you are with a linked text box. And because the picture is live, any updates made to the source range automatically change the picture.

Take a moment to walk through this basic demonstration of the Camera tool. In Figure 5-37, you see some simple numbers and a chart based on those numbers. The goal here is to create a live picture of the range that holds both the numbers and the chart.
Follow these steps:

1. **Highlight the range that contains the information you want to capture.**
   
   In this scenario, you select B3:F13 to capture the area with the chart.

2. **Select the Camera tool icon on the Quick Access toolbar.**

   You added the Camera tool to the Quick Access toolbar in the preceding section.

3. **Click the worksheet in the location where you want to place the picture.**

   Excel immediately creates a live picture of the entire range, as shown in Figure 5-38.

   Changing any number in the original range automatically causes the picture to update.

By default, the picture that’s created has a border around it. To remove the border, right-click the picture and select Format Picture from the menu that appears. This opens the Format Picture dialog box. On the Colors and Lines tab, you see the Line Color drop-down list. There, you can select No Color, thereby removing the border. On a similar note, to get a picture without gridlines, simply remove the gridlines from the source range.
Enhancing a dashboard with the Camera tool

Here are a few ways to go beyond the basics and use the Camera tool to enhance your dashboards and reports:

✓ Consolidate disparate ranges into one print area. Sometimes a data model gets so complex that it’s difficult to keep the final data in one printable area. This often forces you to print multiple pages that are inconsistent in layout and size. Given that dashboards are most effective when contained in a compact area that can be printed in a page or two, complex data models prove to be problematic when it comes to layout and design.

You can use the Camera tool in these situations to create live pictures of various ranges that you can place on a single page. Figure 5-39 shows a workbook that contains data from various worksheets. The secret here is that these data ranges are nothing more than linked pictures created by the Camera tool.

As you can see, you can create and manage multiple analyses on different tabs and then bring together all your presentation pieces into a nicely formatted presentation layer.

![Figure 5-39: Use the Camera tool to get multiple source ranges into a compact area.](image)
Rotate objects to save time. Again, because the Camera tool outputs pictures, you can rotate the pictures in situations in which placing the copied range on its side can help save time. A great example is a chart: Certain charts are relatively easy to create in a vertical orientation but extremely difficult to create in a horizontal orientation.

It’s the Camera tool to the rescue! When the live picture of the chart is created, all you have to do is change the alignment of the chart labels and then rotate the picture using the rotate handle to create a horizontal version.

Create small charts. When you create pictures with the Camera tool, you can resize and move the pictures around freely. This gives you the freedom to test different layouts and chart sizes without the need to work around column widths, hidden rows, or other nonsense.

Making Waffles with Conditional Formatting and the Camera Tool

After you have a few tricks under your belt, you can have a bit of fun and use conditional formatting and the Camera tool together to make a waffle chart!

A waffle chart is an interesting visualization that helps display progress toward a goal. As you can see in Figure 5-40, a waffle chart is basically a square divided into a 10 x 10 grid. Each grid box represents 1 percent toward a goal of 100 percent. The number of grid boxes that are colored or shaded is determined by the associated metric. This kind of chart is a relatively effective option when you want to add an interesting visualization to the dashboard without distorting the data or taking up too much dashboard real estate.

Figure 5-40: Three waffle charts, side by side.
Waffle charts are relatively easy to build using a little conditional formatting know-how. Follow these steps to create your first waffle chart:

1. On a new worksheet, dedicate a cell for your actual metric and then create a 10 x 10 grid of percentages that range from 1% to 100%.

   Figure 5-41 demonstrates the initial setup you need.

2. Highlight the 10 x 10 grid and select Home \(\rightarrow\) Conditional Formatting \(\rightarrow\) New Rule.

3. Create a rule that colors each cell in the 10 x 10 grid if the cell value is less than or equal to the value shown in the metric cell (A2 in this example).

   Figure 5-42 illustrates what the formatting rule should look like.
4. **Click the OK button to confirm the conditional format.**

Be sure to apply the same color format for both the fill and the font. This ensures that the percentage values in the 10 x 10 grid are hidden.

Now make sure the grid has a clean background color when the boxes are not lit up by your conditional formatting.

5. **Highlight all cells in the 10 x 10 grid and apply a default gray color to the cells and font. Also apply a white border to all cells.**

At this point, the 10 x 10 grid should look similar to the one shown in Figure 5-43. When you change the metric or target percentages, the grid should automatically adjust colors to reflect the data change. It’s time to use the Camera tool to shape and position your waffle chart.

6. **Highlight the waffle chart and then select the Camera Tool icon on the Quick Access toolbar.**

You added the Camera tool to the Quick Access toolbar in the preceding section in this chapter.

7. **Click the worksheet in the location where you want to place the picture.**

Excel immediately creates a linked picture that can be resized and positioned where you need it.

8. **To add a label to the waffle chart, click on the Insert tab on the Ribbon, select the Text Box icon, and then click the worksheet to create an empty text box.**

9. While the text box is selected, place your cursor in the Formula bar, type the equal sign (=), and then click the cell that contains the metric cell.

10. **Overlay the text box containing your label on top of the waffle chart.**
You can repeat these steps to create a separate waffle chart for each of your metrics. After you’ve created each waffle chart, you can line them up to create an attractive graphic that helps your audience visualize performance against a goal for each metric. (See Figure 5-44.)
know what you’re thinking: “Am I supposed to be jumping right in with pivot tables?” My answer is an emphatic yes!

In Chapter 2, I introduce the concept of reporting models that separate the data, analysis, and presentation layers. As you discover in this chapter, pivot tables lend themselves nicely to this concept. With pivot tables, you can build reporting models that not only are easy to set up, but can also be refreshed with the simple press of a button. Then you can spend less time maintaining your dashboards and reports and more time doing other useful things. No utility in the whole of Excel allows you to achieve this efficient data model better than a pivot table.

Pivot tables have a reputation for being complicated, but if you’re new to pivot tables, relax a bit. After reading this introduction, you’ll be pleasantly surprised at how easy it is to create and use pivot tables. Later, you’ll find some time-saving techniques to help create useful pivot-driven views for your dashboards and reports.

An Introduction to the Pivot Table

A pivot table is a robust tool that allows you to create an interactive view of your dataset, commonly referred to as a pivot table report. With a pivot table report, you can quickly and easily categorize your data into groups, summarize large amounts of data into meaningful analyses, and interactively perform a wide variety of calculations.
Pivot tables get their name from the way they allow you to drag and drop fields within the pivot table report to dynamically change (or pivot) perspective and give you an entirely new analysis using the same data source.

Think of a pivot table as an object you can point at your dataset. When you look at your dataset through a pivot table, you can see your data from different perspectives. The dataset itself doesn’t change, and it’s not connected to the pivot table. The pivot table is simply a tool you’re using to dynamically change analyses, apply varying calculations, and interactively drill down to the detail records.

The reason a pivot table is so well suited for dashboarding and reporting is that you can refresh the analyses shown through the pivot table simply by updating the dataset it’s pointed to. This allows you to set up your analysis and presentation layers only one time; then, to refresh your reporting mechanism, all you have to do is press a button.

Let’s start this exploration of pivot tables with a lesson on the anatomy of a pivot table.

**The Four Areas of a Pivot Table**

A pivot table is composed of four areas. The data you place in these areas defines both the utility and appearance of the pivot table. Take a moment to understand the function of each of these four areas.

**Values area**

The *values area*, as shown in Figure 6-1, is the large rectangular area below and to the right of the column and row headings. In the example in Figure 6-1, the values area contains a sum of the values in the Sales Amount field.

The values area calculates and counts data. The data fields that you drag and drop here are typically those that you want to measure — fields such as Sum of Revenue, Count of Units, or Average of Price.

**Row area**

The *row area* is shown in Figure 6-2. Placing a data field into the row area displays the unique values from that field down the rows of the left side of the pivot table. The row area typically has at least one field, although it’s possible to have no fields.
Chapter 6: The Pivotal Pivot Table

The types of data fields that you would drop here include those that you want to group and categorize, such as Products, Names, and Locations.

**Column area**

The *column area* is composed of headings that stretch across the top of columns in the pivot table.

As you can see in Figure 6-3, the column area stretches across the top of the columns. In this example, it contains the unique list of business segments.

Placing a data field into the column area displays the unique values from that field in a column-oriented perspective. The column area is ideal for creating a data matrix or showing trends over time.
Part II: Building Basic Dashboard Components

Filter area

The filter area is an optional set of one or more drop-down menus at the top of the pivot table. In Figure 6-4, the filter area contains the Region field, and the pivot table is set to show all regions.

Placing data fields into the filter area allows you to filter the entire pivot table based on your selections. The types of data fields that you’d drop here include those that you want to isolate and focus on — for example, Region, Line of Business, and Employees.

Creating Your First Pivot Table

If you’ve followed along in this chapter, you now have a good understanding of the basic structure of a pivot table, so let’s quit all the talking and use the following instructions to walk through the creation of your first pivot table.
Chapter 6: The Pivotal Pivot Table

You can find the sample file for this chapter on this book’s companion website.

Follow these steps:

1. Click any single cell inside the data source — the table you’ll use to feed the pivot table.

2. Select the Insert tab on the Ribbon and then click the PivotTable icon, as shown in Figure 6-5.

3. From the drop-down menu that appears, choose PivotTable.

   This step activates the Create PivotTable dialog box, as shown in Figure 6-6. As you can see, this dialog box asks you to specify the location of your source data and the place you want to put the pivot table.

   Notice that in the Create PivotTable dialog box, Excel makes an attempt to fill in the range of your data for you. In most cases, Excel gets this right. However, always make sure the correct range is selected.

![Image of Figure 6-5: Start a pivot table via the Insert tab.]

![Image of Figure 6-6: The Create PivotTable dialog box.]
You will also note in Figure 6-6 that the default location for a new pivot table is New Worksheet. This means the pivot table will be placed in a new worksheet within the current workbook. You can change this by selecting the Existing Worksheet option and specifying the worksheet where you want the pivot table placed.

4. Click OK.

At this point, you have an empty pivot table report on a new worksheet. Next to the empty pivot table, you see the PivotTable Fields dialog box, shown in Figure 6-7.

Figure 6-7: The PivotTable Fields dialog box.

The idea here is to add the fields you need into the pivot table by using the four drop zones found in the PivotTable Field List — Filters, Columns, Rows, and Values. Pleasantly enough, these drop zones correspond to the four areas of the pivot table you review at the beginning of this chapter.

If clicking the pivot table doesn’t activate the PivotTable Fields dialog box, you can manually activate it by right-clicking anywhere inside the pivot table and selecting Show Field List from the menu that appears.

Now, before you go wild and start dropping fields into the various drop zones, you should ask yourself two questions: “What am I measuring?” and “How do I want to see it?” The answers to these questions give you some guidance when determining which fields go where.
For your first pivot table report, you measure the dollar sales by market. This automatically tells you that you will need to work with the Sales Amount field and the Market field.

How do you want to see that? You want markets to go down the left side of the report and sales amounts to be calculated next to each market. Remembering the four areas of the pivot table, you’ll need to add the Market field to the Rows drop zone and add the Sales Amount field to the Values drop zone.

5. Select the Market check box in the list, as demonstrated in Figure 6-8.

Now that you have regions in your pivot table, it’s time to add the dollar sales.

![Figure 6-8: Select the Market check box.](image)

6. Select the Sales Amount check box in the list, as demonstrated in Figure 6-9.

Selecting a check box that is nonnumeric (text or date) automatically places that field into the row area of the pivot table. Selecting a check box that is numeric automatically places that field in the values area of the pivot table.

What happens if you need fields in the other areas of the pivot table? Well, instead of selecting the field’s check box, you can drag any field directly to the different drop zones.
One more thing: When you add fields to the drop zones, you may find it difficult to see all fields in each drop zone. You can expand the PivotTable Fields dialog box by clicking and dragging the borders of the dialog box.

As you can see, you have just analyzed the sales for each market in only six steps! That’s an amazing feat, considering that you start with more than 60,000 rows of data. With a little formatting, this modest pivot table can become the starting point for a management dashboard or report.

**Changing and rearranging your pivot table**

Here’s the wonderful thing about pivot tables: You can add as many layers of analysis as made possible by the fields in your source data table. Say that you want to show the dollar sales each market earned by business segment. Because the pivot table already contains the Market and Sales Amount fields, all you have to add is the Business Segment field.

So simply click anywhere on the pivot table to reactivate the PivotTable Fields dialog box and then select the Business Segment check box. Figure 6-10 illustrates what the pivot table should look like now.

If clicking the pivot table doesn’t activate the PivotTable Fields dialog box, you can manually activate it by right-clicking anywhere inside the pivot table and selecting Show Field List from the menu that appears.
Imagine that your manager says that this layout doesn’t work for him. He wants to see business segments going across the top of the pivot table report. No problem. Simply drag the Business Segment field from the Rows drop zone to the Columns drop zone. As you can see in Figure 6-11, this instantly restructures the pivot table to his specifications.
Adding a report filter

Often, you’re asked to produce reports for one particular region, market, product, and so on. Instead of working hours and hours building separate reports for every possible analysis scenario, you can leverage pivot tables to help create multiple views of the same data. For example, you can do so by creating a region filter in your pivot table.

Click anywhere on the pivot table to reactivate the PivotTable Fields dialog box and then drag the Region field to the Filters drop zone. This adds a drop-down selector to the pivot table, as shown in Figure 6-12. You can then use this selector to analyze one particular region at a time.

Keeping your pivot table fresh

In Hollywood, it’s important to stay fresh and relevant. As boring as your pivot tables may seem, they’ll eventually become the stars of your reports and dashboards. So it’s just as important to keep your pivot tables fresh and relevant.

As time goes by, your data may change and grow with newly added rows and columns. The action of updating a pivot table with these changes is refreshing your data.

The pivot table report can be refreshed by simply right-clicking inside it and selecting Refresh from the menu that appears, as demonstrated in Figure 6-13.
Sometimes, you’re the data source that feeds your pivot table changes in structure. For example, you may have added or deleted rows or columns from your data table. These types of changes affect the range of your data source, not just a few data items in the table.

In these cases, performing a simple Refresh of the pivot table won’t do. You have to update the range being captured by the pivot table. Here’s how:

1. Click anywhere inside the pivot table to activate the PivotTable Tools contextual tab on the Ribbon.
2. Select the Analyze tab on the Ribbon.
3. Click the tab’s Change Data Source icon and choose Change Data Source from the menu that appears, as demonstrated in Figure 6-14. The Change PivotTable Data Source dialog box appears.

4. Change the range selection to include any new rows or columns. (See Figure 6-15.)
5. Click OK to apply the change.
Customizing Pivot Table Reports

The pivot tables you create often need to be tweaked to get the look and feel you’re looking for. In this section, I cover some of the options you can adjust to customize your pivot tables to suit your reporting needs.

Changing the pivot table layout

Excel gives you a choice in the layout of your data in a pivot table. The three layouts, shown side by side in Figure 6-16, are Compact Form, Outline Form, and Tabular Form. Although no layout stands out as better than the others, I prefer using the Tabular Form layout because it seems easiest to read, and it’s the layout that most people who have seen pivot tables are used to.
Chapter 6: The Pivotal Pivot Table

The layout you choose affects not only the look and feel of your reporting mechanisms but may also affect the way you build and interact with any dashboard models based on your pivot tables.

Changing the layout of a pivot table is easy. Follow these steps:

1. Click anywhere inside the pivot table to activate the PivotTable Tools context tab on the Ribbon.
2. Select the Design tab on the Ribbon.
3. Click the Report Layout icon and choose the layout you like from the menu that appears. (See Figure 6-17.)

Customizing field names

Notice that every field in your pivot table has a name. The fields in the row, column, and filter areas inherit their names from the data labels in the source table. The fields in the values area are given a name, such as Sum of Sales Amount.

Sometimes you might prefer the name Total Sales instead of the unattractive default name, like Sum of Sales Amount. In these situations, the ability to change your field names is handy. To change a field name, do the following:

1. Right-click any value within the target field.

For example, if you want to change the name of the field Sum of Sales Amount, you right-click any value under that field.

Figure 6-16: The three layouts for a pivot table report.
2. Select Value Field Settings from the menu that appears, as shown in Figure 6-18.

The Value Field Settings dialog box appears.

Note that if you were changing the name of a field in the row or column area, this selection is Field Settings.

3. Enter the new name in the Custom Name input box, shown in Figure 6-19.

4. Click OK to apply the change.
If you use the name of the data label used in your source table, you receive an error. For example, if you rename Sum of Sales Amount as Sales Amount, you get an error message because there’s already a Sales Amount field in the source data table. Well, this is kinda lame, especially if Sales Amount is exactly what you want to name the field in the your pivot table.

To get around this, you can name the field and add a space to the end of the name. Excel considers Sales Amount (followed by a space) to be different from Sales Amount. This way, you can use the name you want and no one will notice that it’s any different.

### Applying numeric formats to data fields

Numbers in pivot tables can be formatted to fit your needs — that is, formatted as currency, percentage, or number. You can easily control the numeric formatting of a field using the Value Field Settings dialog box. Here’s how:

1. **Right-click any value within the target field.**
   
   For example, if you want to change the format of the values in the Sales Amount field, right-click any value under that field.

2. **Select Value Field Settings from the menu that appears.**
   
   The Value Field Settings dialog box appears.

3. **Click the Number Format button.**
   
   The Format Cells dialog box opens.
Part II: Building Basic Dashboard Components

4. Apply the number format you desire, just as you typically would on your spreadsheet.

5. Click OK to apply the changes.

After you set the formatting for a field, the applied formatting will persist even if you refresh or rearrange the pivot table.

Changing summary calculations

When creating your pivot table report, Excel, by default, summarizes your data by either counting or summing the items. Instead of Sum or Count, you might want to choose functions, such as Average, Min, Max, and so on. In all, 11 options are available, including

- **Sum**: Adds all numeric data.
- **Count**: Counts all data items within a given field, including numeric-, text-, and date-formatted cells.
- **Average**: Calculates an average for the target data items.
- **Max**: Displays the largest value in the target data items.
- **Min**: Displays the smallest value in the target data items.
- **Product**: Multiplies all target data items together.
- **Count Nums**: Counts only the numeric cells in the target data items.
- **StdDevP** and **StdDev**: Calculates the standard deviation for the target data items. Use **StdDevP** if your dataset contains the complete population. Use **StdDev** if your dataset contains a sample of the population.
- **VarP** and **Var**: Calculates the statistical variance for the target data items. Use **VarP** if your data contains a complete population. If your data contains only a sampling of the complete population, use **Var** to estimate the variance.

You can easily change the summary calculation for any given field by taking the following actions:

1. Right-click any value within the target field.
2. Select Value Field Settings from the menu that appears.
   The Value Field Settings dialog box appears.
3. Choose the type of calculation you want to use from the list of calculations. (See Figure 6-20.)
4. Click OK to apply the changes.
Did you know that a single blank cell causes Excel to count instead of sum? That’s right. If all the cells in a column contain numeric data, Excel chooses Sum. If just one cell is either blank or contains text, Excel chooses Count.

Be sure to pay attention to the fields that you place into the values area of the pivot table. If the field name starts with Count Of, Excel’s counting the items in the field instead of summing the values.

**Suppressing subtotals**

Notice that each time you add a field to your pivot table, Excel adds a subtotal for that field. There may be times however, when the inclusion of subtotals either doesn’t make sense or just hinders a clear view of the pivot table report. For example, Figure 6-21 shows a pivot table in which the subtotals inundate the report with totals that hide the real data you’re trying to report.

**Removing all subtotals at one time**

You can remove all subtotals at one time by taking these actions:

1. Click anywhere inside the pivot table to activate the PivotTable Tools context tab on the Ribbon.
2. Select the Design tab on the Ribbon.
3. Click the Subtotals icon and select Do Not Show Subtotals from the menu that appears, as shown in Figure 6-22.

As you can see in Figure 6-23, the same report without subtotals is much more pleasant to review.
Figure 6-21: Subtotals sometimes muddle the data you're trying to show.

<table>
<thead>
<tr>
<th>Region</th>
<th>SubRegion</th>
<th>Market</th>
<th>Business Segment</th>
<th>Sum of Sales Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td>United States</td>
<td>Central</td>
<td>Accessories</td>
<td>46,551</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bikes</td>
<td>6,782,578</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clothing</td>
<td>155,874</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Components</td>
<td>947,440</td>
<td></td>
</tr>
<tr>
<td>Central Total</td>
<td></td>
<td></td>
<td></td>
<td>7,932,352</td>
</tr>
<tr>
<td>Northeast</td>
<td>Central</td>
<td>Accessories</td>
<td>51,346</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bikes</td>
<td>5,690,285</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clothing</td>
<td>163,442</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Components</td>
<td>1,051,702</td>
<td></td>
</tr>
<tr>
<td>Northeast Total</td>
<td></td>
<td></td>
<td></td>
<td>6,906,074</td>
</tr>
<tr>
<td>Northwest</td>
<td>Central</td>
<td>Accessories</td>
<td>53,308</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bikes</td>
<td>10,484,495</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clothing</td>
<td>201,052</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Components</td>
<td>1,784,207</td>
<td></td>
</tr>
<tr>
<td>Northwest Total</td>
<td></td>
<td></td>
<td></td>
<td>12,523,063</td>
</tr>
<tr>
<td>Southeast</td>
<td>Central</td>
<td>Accessories</td>
<td>45,716</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bikes</td>
<td>6,737,556</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clothing</td>
<td>165,689</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Components</td>
<td>939,187</td>
<td></td>
</tr>
<tr>
<td>Southeast Total</td>
<td></td>
<td></td>
<td></td>
<td>7,998,318</td>
</tr>
<tr>
<td>Southwest</td>
<td>Central</td>
<td>Accessories</td>
<td>116,080</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bikes</td>
<td>15,430,281</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clothing</td>
<td>364,099</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Components</td>
<td>2,693,368</td>
<td></td>
</tr>
<tr>
<td>Southwest Total</td>
<td></td>
<td></td>
<td></td>
<td>18,598,027</td>
</tr>
</tbody>
</table>

Figure 6-22: Use the Do Not Show Subtotals option to remove all subtotals at one time.
Chapter 6: The Pivotal Pivot Table

Removing the subtotals for only one field

Maybe you want to remove the subtotals for only one field? In such a case, you can take the following actions:

1. Right-click any value within the target field.
2. Select Field Settings from the menu that appears.
   
   The Field Settings dialog box appears.
3. Choose the None option under Subtotals, as demonstrated in Figure 6-24.
4. Click OK to apply the changes.

---

Figure 6-23: The report shown in Figure 6-21, without subtotals.
**Removing grand totals**

There may be instances when you want to remove the grand totals from your pivot table:

1. Right-click anywhere on the pivot table.
2. Select PivotTable Options from the menu that appears.
   The PivotTable Options dialog box appears.
3. Click the Totals & Filters tab.
4. Click the Show Grand Totals for Rows check box to deselect it.
5. Click the Show Grand Totals for Columns check box to deselect it.

**Showing and hiding data items**

A pivot table summarizes and displays all records in the source data table. There may be situations, however, when you want to inhibit certain data items from being included in the pivot table summary. In these situations, you can choose to hide a data item.

In terms of pivot tables, hiding doesn’t just mean preventing the data item from being shown on the report. Hiding a data item also prevents it from being factored into the summary calculations.

In the pivot table illustrated in Figure 6-25, you see sales amounts for all business segments by market. In this example, I want to show totals without taking into consideration sales from the Bikes segment. In other words, I want to hide the Bikes segment.

![Figure 6-25: To remove Bikes from this analysis . . .](image)
You can hide the Bikes business segment by clicking the Business Segment drop-down list arrow and deseleting the Bikes check box from the menu that appears, as shown in Figure 6-26.

After you choose OK to close the selection box, the pivot table instantly recalculates, leaving out the Bikes segment. As you can see in Figure 6-27, the Market total sales now reflect the sales without Bikes.

I can just as quickly reinstate all hidden data items for my field. I simply click the Business Segment drop-down list arrow and click the Select All check box from the menu that appears, as shown in Figure 6-28.
Part II: Building Basic Dashboard Components

Hiding or showing items without data

By default, the pivot table shows only data items that have data. This inherent behavior may cause unintended problems for your data analysis.

Look at Figure 6-29, which shows a pivot table with the SalesPeriod field in the row area and the Region field in the filter area. Note that the Region field is set to (All) and that every sales period appears in the report.

If I choose Europe in the filter area, only a portion of all the sales periods will show. (See Figure 6-30.) The pivot table will show only those sales periods that apply to the Europe region.
Displaying only those items with data could cause trouble if I plan to use this pivot table as the feeder for my charts or other dashboard components. From a dashboarding-and-reporting perspective, it isn’t ideal if half the year’s data disappeared every time customers selected Europe.

Here’s how you can prevent Excel from hiding pivot items without data:

1. **Right-click any value within the target field.**
   In this example, the target field is the SalesPeriod field.
2. **Select Field Settings from the menu that appears.**
   The Field Settings dialog box appears.
3. **Select the Layout & Print tab in the Field Settings dialog box.**
4. **Select the Show Items with No Data option, as shown in Figure 6-31.**
5. **Click OK to apply the change.**
As you can see in Figure 6-32, after you choose the Show Items with No Data option, all sales periods appear whether the selected region had sales that period or not.

After you’re confident that the structure of the pivot table is locked down, you can use it to feed charts and other components on the dashboard.

![Figure 6-32: All sales periods are now displayed, even if there is no data to be shown.](image)

**Sorting your pivot table**

By default, items in each pivot field are sorted in ascending sequence based on the item name. Excel gives you the freedom to change the sort order of the items in a pivot table.

As with many actions you can perform in Excel, there are lots of different ways to sort data within a pivot table. The easiest way, and the way that I use the most, is to apply the sort directly in the pivot table. Here’s how:

1. **Right-click any value within the target field — the field you need to sort.**
   
   In the example shown in Figure 6-33, I want to sort by sales amount.

2. **Select Sort from the menu that appears and then select the sort direction.**
   
   The changes take effect immediately and persist while you work with the pivot table.
Creating Useful Pivot-Driven Views

At this point in your exploration of pivot tables, you have covered enough of the fundamentals to start creating your own pivot table reports. In this last section, I share with you a few of the techniques I use to create some of the more useful report views. Although you could create these views by hand, creating them with pivot tables helps save you hours of work and allows you to more easily update and maintain them.

Producing top and bottom views

You’ll often find that managers are interested in the top and bottom of things: the top 50 customers, the bottom 5 sales reps, the top 10 products. Although you may think this is because managers have the attention span of a 4-year-old, there’s a more logical reason for focusing on the outliers.

Dashboarding and reporting is often about showing actionable data. If you, as a manager, know who the bottom ten revenue-generating accounts are, you could apply your effort and resources in building up those accounts. Because you most likely wouldn’t have the resources to focus on all accounts, viewing a manageable subset of accounts would be more useful.

Luckily, pivot tables make it easy to filter your data for the top five, the bottom ten, or any conceivable combination of top or bottom records.

Here’s an example. Imagine that in your company, the Accessories business segment is a high-margin business — you make the most profit for each dollar of sales in the Accessories segment. To increase sales, your manager wants to focus on the 50 customers who spend the least amount of money on
accessories. He obviously wants to spend his time and resources on getting those customers to buy more accessories. Here’s what to do:

1. Build a pivot table with Business Segment in the filter area, Customer in the row area, and Sales Amount in the values area; see Figure 6-34. For cosmetic value, change the layout to Tabular Form.

![Figure 6-34: Build this pivot table to start.](image)

See the earlier section “Changing the pivot table layout” to find out how to do that.

You can find the sample file for this chapter on this book’s companion website.

2. Right-click any customer name in the Customer field, select Filter, and then Top 10 — as demonstrated in Figure 6-35.

Don’t let the label Top 10 confuse you. You can use the Top 10 option to filter both top and bottom records.

![Figure 6-35: Select the Top 10 filter option.](image)
3. In the Top 10 Filter dialog box, as illustrated in Figure 6-36, you simply have to define the view you’re looking for.

![Figure 6-36: Specify the filter you want to apply.](image)

In this example, you want the bottom 50 items (customers), as defined by the Sum of Sales Amount field.

4. Click OK to apply the filter.

5. In the filter area, click the drop-down button for the Business Segment field and select the check box for the filter item Accessories in the menu that appears, as shown in Figure 6-37.

![Figure 6-37: Filter your pivot table report to show Accessories.](image)

At this point, you have exactly what your manager asked for — the 50 customers who spend the least amount of money on accessories. You can go a step further and format the report a bit by sorting on the Sum of Sales Amount and applying a currency format to the numbers. (See Figure 6-38.)

![Figure 6-38:](image)

Note that because you built this view using a pivot table, you can easily adapt the newly created report to create a whole new view. For example, you can add the SubRegion field — shown in Figure 6-39 — to the filter area to get the 50 United Kingdom customers who spend the least amount of money on accessories. This, my friends, is the power of using pivot tables for the basis of your dashboards and reports. Continue to play around with the Top 10 filter option to see what kind of reports you can come up with.
You may notice that in Figure 6-39, the Bottom 50 report is showing only 27 records. This is because there are fewer than 50 customers in the United Kingdom market that have accessories sales. Because I asked for the bottom 50, Excel shows as many as 50 accounts, but fewer if there are fewer than 50. If there’s a tie for any rank in the bottom 50, Excel shows you all the tied records.
You can remove the applied filters in your pivot tables by taking these actions:

1. Click anywhere inside your pivot table to activate the PivotTable Tools context tab on the Ribbon.
2. Select the Options tab on the Ribbon.
3. Click the Clear icon and select Clear Filters from the menu that appears, as demonstrated in Figure 6-40.

Creating views by month, quarter, and year

Raw transactional data is rarely aggregated by month, quarter, or year for you. This type of data is often captured by the day. However, managers often want reports by month or quarters instead of detail by day. Fortunately, pivot tables make it easy to group date fields into various time dimensions. Here’s how:

1. Build a pivot table with Sales Date in the row area and Sales Amount in the values area, similar to the one in Figure 6-41.
2. Right-click any date and select Group from the menu that appears, as demonstrated in Figure 6-42.
   The Grouping dialog box appears, as shown in Figure 6-43.
3. Select the time dimensions you want.
   In this example, select Months, Quarters, and Years.
4. Click OK to apply the change.
Figure 6-41: Build this pivot table to start.

Figure 6-42: Select the Group option.

Figure 6-43: Select the time dimensions that suit your needs.
Here are several interesting things to note about the resulting pivot table. First, notice that Quarters and Years have been added to the field list. Keep in mind that your source data hasn’t changed to include these new fields; instead, these fields are now part of the pivot table. Another interesting thing to note is that, by default, the Years and Quarters fields are automatically added next to the original date field in the pivot table layout, as shown in Figure 6-44.

After the date field is grouped, you can use each added time grouping just as you would any other field in your pivot table. In Figure 6-45, I use the newly created time groupings to show sales for each market by quarter for 2010.
Creating a percent distribution view

A percent distribution (or percent contribution) view allows you to see how much of the total is made up of a specific data item. This view is useful when you’re trying to measure the general impact of a particular item.

The pivot table, as shown in Figure 6-46, gives you a view into the percent of sales that comes from each business segment. Here, you can tell that bikes make up 81 percent of Canada’s sales, whereas only 77 percent of France’s sales come from bikes.

Here are the steps to create this type of view:

1. Right-click any value within the target field.
   
   For example, if you want to change the settings for the Sales Amount field, right-click any value under that field.

2. Select Value Field Settings from the menu that appears.

3. Click the Show Values As tab.

4. Select % of Row Total from the drop-down list.

5. Click OK to apply the change.

The pivot table in Figure 6-47 is formatted to give you the percent of sales for each market.

Again, remember that because you built these views in a pivot table, you have the flexibility to slice the data by region, bring in new fields, rearrange data, and, most important, refresh this view when new data comes in.
Chapter 6: The Pivotal Pivot Table

Creating a YTD totals view

Sometimes it’s useful to capture a running‐totals view to analyze the movement of numbers on a year‐to‐date (YTD) basis. Figure 6‐48 illustrates a pivot table that shows a running total of revenue by month for each year. In this view, you can see where the YTD sales stand at any given month in each year. For example, you can see that in August 2010, revenues were about a million dollars lower than at the same point in 2009.

In the sample data for this chapter, you don’t see Months and Years. You have to create them by grouping the SalesDate field. Feel free to review the section “Creating views by month, quarter, and year” earlier in this chapter to find out how.
To create this type of view, take these actions:

1. **Right-click any value within the target field.**
   For example, if you want to change the settings for the Sales Amount field, right-click any value under that field.

2. **Select Value Field Settings from the menu that appears.**
   The Value Field Settings dialog box appears.

3. **Click the Show Values As tab.**

4. **Select Running Total In from the drop-down list.**

5. **In the Base Field list, select the field that you want the running totals to be calculated against.**
   In most cases, this would be a time series such as, in this example, the SalesDate field. (Refer to Figure 6-48.)

6. **Click OK to apply the change.**

---

**Creating a month-over-month variance view**

Another commonly requested view is a month-over-month variance. How did this month’s sales compare to last month’s sales? The best way to create these types of views is to show the raw number and the percent variance together.

In that light, you can start creating this view by building a pivot table similar to the one shown in Figure 6-49. Notice that you bring in the Sales Amount field twice. One of these remains untouched, showing the raw data. The other is changed to show the month-over-month variance.

Figure 6-50 illustrates the settings that convert the second Sum of Sales Amount field into a month-over-month variance calculation.

As you can see, after the settings are applied, the pivot table gives you a nice view of raw sales dollars and the variance over last month. You can obviously change the field names (see the section “Customizing field names,” earlier in this chapter) to reflect the appropriate labels for each column.

In the sample data for this chapter, you don’t see Months and Years. You have to create them by grouping the SalesDate field. Feel free to review the section “Creating views by month, quarter, and year,” earlier in this chapter, to find out how.
Chapter 6: The Pivotal Pivot Table

To create the view in Figure 6-50, take these actions:

1. Right-click any value within the target field.
   In this case, the target field is the second Sum of Sales Amount field.

2. Select Value Field Settings from the menu that appears.
   The Value Field Settings dialog box appears.

3. Click the Show Values As tab.
4. Select % Difference From from the drop-down list.

5. In the Base Field list, select the field that you want the running totals to be calculated against.

   In most cases, this is a time series such as, in this example, the SalesDate field.

6. In the Base Item list, select the item you want to compare against when calculating the percent variance.

   In this example, you want to calculate each month's variance to the previous month. Therefore, select the (Previous) item.
Part III
Building Advanced Dashboard Components

Check out the advanced trick at http://www.dummies.com/extras/exceldashboardsreports, which enables you to add an extra dynamic layer of analysis to your charts.
In this part . . .

- Go beyond basic charting with a look at some advanced business techniques that can help make your dashboards more meaningful.
- Find out how to represent trending across multiple series and distinct time periods.
- Explore how best to use charts to group data into meaningful views.
- Uncover techniques that can help you display and measure performance against a target.
No matter what business you’re in, you can’t escape the tendency to trend. In fact, one of the most common concepts used in dashboards and reports is the concept of trending. A trend is a measure of variance over some defined interval — typically, periods such as days, months, or years.

The reason trending is so popular is that trending provides a rational expectation of what might happen in the future. If I know this book has sold 10,000 copies a month over the last 12 months (I wish), I have a reasonable expectation to believe that sales next month will be around 10,000 copies. In short, trending tells you where you’ve been and where you might be going.

In this chapter, you explore basic trending concepts and some of the advanced techniques you can use to take your trending components beyond simple line charts.

Trending Dos and Don’ts

Building trending components for your dashboards has some dos and don’ts. This section helps you avoid some common trending faux pas.
Using chart types appropriate for trending

It would be nice if you could definitively say which chart type you should use when building trending components. But the truth is, no chart type is the silver bullet for all situations. For effective trending, you want to understand which chart types are most effective in different trending scenarios.

Using line charts

Line charts are the kings of trending. In business presentations, a line chart almost always indicates movement across time. Even in areas not related to business, the concept of lines is used to indicate time — consider timelines, family lines, bloodlines, and so on. The benefit of using a line chart for trending is that it’s instantly recognized as a trending component, avoiding any delay in information processing.

Line charts are especially effective in presenting trends with many data points — as the top chart in Figure 7-1 shows. You can also use a line chart to present trends for more than one time period, as shown in the bottom chart in Figure 7-1.
Using area charts

An area chart is essentially a line chart that’s been filled in. So, technically, area charts are appropriate for trending. They’re particularly good at highlighting trends over a large time span. For example, the chart in Figure 7-2 spans 120 days of data.

![Figure 7-2: Area charts can be used to trend over a large time span.](image)

Using column charts

If you’re trending a single time series, a line chart is absolutely the way to go. However, if you’re comparing two or more periods on the same chart, columns may best bring out the comparisons.

An alternative option is to use a combination chart. A combination of line and column charts is an extremely effective way to show the difference in units sold between two time periods. For instance, Figure 7-3 demonstrates how a combination chart can instantly call attention to the exact months when 2010 sales fell below 2009 sales. (You’ll find out more about combination charts later in this chapter.)

![Figure 7-3: Using columns and lines emphasizes the trending differences between two time periods.](image)
Starting the vertical scale at zero

The vertical axis on a trending chart should almost always start at zero. The reason I say *almost* is because you may have trending data that contains negative values or fractions. In those situations, it’s generally best to keep Excel’s default scaling. However, if you have only non-negative integers, ensure that the vertical axis starts at zero.

This is because the vertical scale of a chart can have a significant impact on the representation of a trend. For instance, compare the two charts shown in Figure 7-4. Both charts contain the same data. The only difference is that in the top chart, I did nothing to fix the vertical scale assigned by Excel (it starts at 96), but in the bottom chart, I fixed the scale to start at zero.

Now, you may think the top chart is more accurate because it shows the ups and downs of the trend. However, if you look at the numbers closely, you see that the units represented went from 100 to 107 in 12 months. That’s not exactly a material change, and it certainly doesn’t warrant such a dramatic chart. In truth, the trend is relatively flat, yet the top chart makes it look as though the trend is way up.
Chapter 7: Charts That Show Trending

The bottom chart more accurately reflects the true nature of the trend. I achieved this effect by locking the Minimum value on the vertical axis to zero.

To adjust the scale of the vertical axis, follow these simple steps:

1. **Right-click the vertical axis and choose Format Axis from the menu that appears.**
   The Format Axis dialog box appears; see Figure 7-5.

   ![Format Axis dialog box](image)

   **Figure 7-5:** Always set the Minimum value of the vertical axis to zero.

2. **In the Format Axis dialog box, expand the Axis Options section and set the value in the Minimum box to 0.**
3. **(Optional) Set the Major bound value to twice the Maximum value in your data.**
   Setting this value ensures that the trend line gets placed in the middle of the chart.
4. **Click Close to apply your changes.**

Many would argue that the bottom chart shown in Figure 7-4 hides the small-scale trending that may be important. That is, a 7-unit difference may be significant in some businesses. Well, if that’s true, why use a chart at all? If each unit has an impact on the analysis, why use a broad-sweep representation like a chart? A table with conditional formatting would do a better job of highlighting small-scale changes than any chart ever could.
Leveraging Excel’s logarithmic scale

In some situations, your trending may start with very small numbers and end with very large numbers. In these cases, you end up with charts that don’t accurately represent the true trend. In Figure 7-6, for instance, you see the unit trending for both 2009 and 2010. As you can see in the source data, 2009 started with a modest 50 units. As the months progressed, the monthly unit count increased to 11,100 units through December 2010. Because the two years are on different scales, it’s difficult to discern a comparative trending for the two years together.

The solution is to use a logarithmic scale instead of a standard linear scale.

Without going into a discussion of high school math, a logarithmic scale allows the axis to jump from 1 to 10; to 100 to 1,000; and so on without changing the spacing between axis points. In other words, the distance between 1 and 10 is the same as the distance between 100 and 1,000.

Figure 7-7 shows the same chart as the one in Figure 7-6, but in a logarithmic scale. Notice that the trending for both years is now clear and accurately represented.
To change the vertical axis of a chart to logarithmic scaling, follow these steps:

1. **Right-click the vertical axis and choose Format Axis from the menu that appears.**
   
   The Format Axis dialog box appears.

2. **Expand the Axis Options section and select the Logarithmic Scale check box, as shown in Figure 7-8.**

Logarithmic scales work only with positive numbers.

---

**Figure 7-8:** Setting the vertical axis to logarithmic scale.

---

**Applying creative label management**

As trivial as it may sound, labeling can be one of the sticking points to creating effective trending components. Trending charts tend to hold lots of data points, whose category axis labels take up lots of room. Inundating users with a gaggle of data labels can definitely distract from the main message of the chart. In this section, you find a few tips to help manage the labels in your trending components.

**Abbreviating instead of changing alignment**

Month names look and feel very long when you place them in a chart — especially when that chart has to fit on a dashboard. However, the solution isn’t to change their alignment, as shown in Figure 7-9. Words placed on their sides inherently cause a reader to stop for a moment and read the labels. This isn’t ideal when you want them to think about your data and not spend time reading with their heads tilted.

Although it’s not always possible, the first option is always to keep the labels normally aligned. So rather than jump directly to the alignment option to squeeze them in, try abbreviating the month names. As you can see in Figure 7-9, even using only the first letter of the month name is appropriate.
Implying labels to reduce clutter

When you’re listing the same months over the course of multiple years, you may be able to *imply* the labels for months instead of labeling each and every one of them.

Take Figure 7-10, for example. The chart in this figure shows trending through two years. It has so many data points that the labels are forced to be vertically aligned. To reduce clutter, as you can see, only certain months are explicitly labeled. The others are implied by a dot. To achieve this effect, you can simply replace the label in the original source data with a dot (or whatever character you like).
Chapter 7: Charts That Show Trending

Going vertical when you have too many data points for horizontal

Trending data by day is common, but it does prove to be painful if the trending extends to 30 days or more. In these scenarios, it becomes difficult to keep the chart to a reasonable size and even more difficult to effectively label it.

One solution is to show the trending vertically using a bar chart. (See Figure 7-11 for an example.) On a bar chart, you have room to label the data points and keep the chart to a reasonable size. This isn’t something to aspire to, however. Trending vertically isn’t as intuitive and may not convey your information in an easy-to-read form. Nevertheless, this solution can be just the work-around you need when the horizontal view is impractical.

Figure 7-11: A bar chart can prove to be effective when trending days extend to 30 or more data points.

Nesting labels for clarity

Often, the data you’re trying to chart has multiple time dimensions. In these cases, you can call out these dimensions by nesting your labels. Figure 7-12 demonstrates how including a year column next to the month labels clearly partitions each year’s data. You would simply include the year column when identifying the data source for your chart.
Comparative Trending

Although the name *comparative trending* is fancy, it is a simple concept: You chart two or more data series on the same chart so that the trends from those series can be visually compared. In this section, I walk you through a few techniques to help you build components that present comparative trending.

Creating side-by-side time comparisons

Figure 7-13 shows a chart that presents a side-by-side comparison of three time periods. With this technique, you can show periods in different colors without breaking the continuity of the overall trending.
Here’s how to create this type of chart:

1. Structure your source data similar to the structure shown in Figure 7-14.

   Note that instead of placing all the data into one column, you’re staggering the data into respective years. This tells the chart to create three separate lines, allowing for the three colors.

![Figure 7-14: The source data needed to display side-by-side trends.](image)
2. Select the entire table and create a line chart.

This step creates the chart shown earlier, in Figure 7-13.

3. If you want to get fancy, click the chart to select it, and then right-click and select Change Chart Type from the contextual menu that opens.

4. When the Change Chart Type dialog box opens, select Stacked Column Chart.

As you can see in Figure 7-15, the chart now shows the trending for each year in columns.

Figure 7-15: Change the chart type to Stacked Column Chart to present columns instead of lines.

Would you like a space between the years? Adding a space in the source data (between each 12-month sequence) adds a space in the chart, as shown in Figure 7-16.

Figure 7-16: If you want to separate each year with a space, simply add a space into the source data.
Creating stacked time comparisons

The stacked time comparison places two series on top of each other instead of side by side. Although this removes the benefit of having an unbroken overall trending, it replaces it with the benefit of an at-a-glance comparison within a compact space. Figure 7-17 illustrates a common stacked time comparison.

To create a stacked time comparison, follow these steps:

1. Create a new structure and add data to it, like the one shown in Figure 7-18.
2. Highlight the entire structure and create a column chart.

3. Select and right-click any of the bars for the 2010 data series, and then choose Change Series Chart Type from the menu that appears.

The Change Chart Type dialog box appears.

4. In the Change Chart Type dialog box, select the line type in the Line section.

This technique works well with two time series. You generally want to avoid stacking any more than that. Stacking more than two series often muddies the view and causes users to continually reference the legend to keep track of the series they’re evaluating.

**Trending with a secondary axis**

In some trending components, you have series that trend two different units of measure. For instance, the table in Figure 7-19 shows a trend for People Count and a trend for % Labor Cost.

![Figure 7-19: You often need to trend two different units of measure, such as counts and percentages.]

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>People Count</td>
</tr>
<tr>
<td>2</td>
<td>J</td>
<td>145</td>
<td>20%</td>
</tr>
<tr>
<td>3</td>
<td>F</td>
<td>109</td>
<td>21%</td>
</tr>
<tr>
<td>4</td>
<td>M</td>
<td>105</td>
<td>23%</td>
</tr>
<tr>
<td>5</td>
<td>A</td>
<td>100</td>
<td>23%</td>
</tr>
<tr>
<td>6</td>
<td>M</td>
<td>145</td>
<td>24%</td>
</tr>
<tr>
<td>7</td>
<td>J</td>
<td>109</td>
<td>25%</td>
</tr>
<tr>
<td>8</td>
<td>J</td>
<td>130</td>
<td>24%</td>
</tr>
<tr>
<td>9</td>
<td>A</td>
<td>140</td>
<td>26%</td>
</tr>
<tr>
<td>10</td>
<td>S</td>
<td>150</td>
<td>24%</td>
</tr>
<tr>
<td>11</td>
<td>O</td>
<td>193</td>
<td>26%</td>
</tr>
<tr>
<td>12</td>
<td>N</td>
<td>185</td>
<td>28%</td>
</tr>
<tr>
<td>13</td>
<td>D</td>
<td>171</td>
<td>25%</td>
</tr>
</tbody>
</table>

These are two different units of measure that, when charted, produce the unimpressive chart you see in Figure 7-20. Because Excel builds the vertical axis to accommodate the largest number, the percentage of labor cost trending gets lost at the bottom of the chart. Even a logarithmic scale doesn’t help in this scenario.

Because the default vertical axis (or primary axis) doesn’t work for both series, the solution is to create another axis to accommodate the series that doesn’t fit into the primary axis. This other axis is the secondary axis.
To place a data series on the secondary axis, follow these steps:

1. **Right-click the data series and select Format Data Series from the menu that appears.**

   Doing so opens the Format Data Series dialog box.

2. **In the Format Data Series dialog box, expand the Series Options section (see Figure 7-21) and then click the Secondary Axis radio button.**

   Figure 7-22 illustrates the newly added axis to the right of the chart. Any data series on the secondary axis has its vertical axis labels shown on the right.

   Again, changing the chart type of any one of the data series can help in comparing the two trends. In Figure 7-23, the chart type for the People Count trend has been changed to a column. Now you can easily see that although the number of people has gone down in November and December, the percentage of labor cost continues to rise.
Technically, it doesn’t matter which data series you place on the secondary axis. A general rule is to place the problematic data series on the secondary axis. In this scenario, because the data series for percentage of labor cost seems to be the problem, I place that series on the secondary axis.

**Emphasizing Periods of Time**

Some trending components may contain certain periods in which a special event occurred, causing an anomaly in the trending pattern. For instance, you may have an unusually large spike or dip in the trend caused by some occurrence in your organization. Or maybe you need to mix actual data with forecasts in your charting component. In such cases, it could be helpful to emphasize specific periods in your trending with special formatting.
Chapter 7: Charts That Show Trending

Formatting specific periods

Imagine that you’ve just created the chart component illustrated in Figure 7-24 and you want to explain the spike in October. You could, of course, use a footnote somewhere, but that would force your audience to look for an explanation elsewhere on your dashboard. Calling attention to an anomaly directly on the chart helps give your audience context without the need to look away from the chart.

A simple solution is to format the data point for October to appear in a different color and then add a simple text box that explains the spike.

To format a single data point:

1. **Click the data point once.**
   This step places dots on all data points in the series.

2. **Click the data point again to ensure that Excel knows you’re formatting only that single data point.**
   The dots disappear from all but the target data point.

3. **Right-click and select Format Data Point from the menu that appears.**
   This step opens the Format Data Point dialog box, shown in Figure 7-25. The idea is to adjust the formatting properties of the data point as you see fit.

   The Format Data Point dialog box is for a column chart. Different chart types have different options in the Format Data Point dialog box. Nevertheless, the idea remains the same in that you can adjust the properties in the Format Data Point dialog box to change the formatting of a single data point.
After you change the fill color of the October data point and add a text box with some context, the chart nicely explains the spike, as shown in Figure 7-26.

To add a text box to a chart, click the Insert tab on the Ribbon and select the Text Box icon. Then click inside the chart to create an empty text box, which you can fill with your words.

**Using dividers to mark significant events**

Every now and then a particular event shifts the entire paradigm of your data permanently. A good example is a price increase. The trend shown in Figure 7-27 has been permanently affected by a price increase implemented in October. As you can see, a dividing line (along with some labeling) provides a distinct marker for the price increase, effectively separating the old trend from the new.
Although there are lots of fancy ways to create this effect, you’ll rarely need to get any fancier than manually drawing a line yourself. To draw a dividing line inside a chart, take the following steps:

1. Click the chart to select it.
2. Click the Insert tab on the Ribbon and click the Shapes button.
3. Select the line shape you want, go to your chart, and draw the line where you want it.
4. Right-click your newly drawn line and select Format Shape from the menu that appears.
5. Use the Format Shape dialog box to format your line’s color, thickness, and style.

### Representing forecasts in your trending components

It’s common to be asked to show both actual data and forecast data as a single trending component. When you do show the two together, you should ensure that your audience can clearly distinguish where actual data ends and where forecasting begins. Take a look at Figure 7-28.

The best way to achieve this effect is to start with a data structure similar to the one shown in Figure 7-29. As you can see, sales and forecasts are in separate columns so that when charted, you get two distinct data series. Also note the value in cell B14 is actually a formula referencing C14. This value serves to ensure a continuous trend line (with no gaps) when the two data series are charted together.
When you have the appropriately structured dataset, you can create a line chart. At this point, you can apply special formatting to the 2013 Forecast data series. Follow these steps:

1. **Click the data series that represents 2013 Forecast.**

   This step places dots on all data points in the series.
2. Right-click and select Format Data Series from the menu that appears.

This step opens the Format Data Series dialog box.

3. In this dialog box, you can adjust the properties to format the series color, thickness, and style.

**Other Trending Techniques**

In this section, I help you explore a few techniques that go beyond the basic concepts covered in this chapter so far.

**Avoiding overload with directional trending**

Do you work with a manager who is crazy for data? Are you getting headaches from trying to squeeze three years’ worth of monthly data into a single chart? Although it’s understandable to want to see a 3-year trend, placing too much information on a single chart can make for a convoluted trending component that tells you almost nothing.

When you’re faced with the need to display impossible amounts of data, step back and think about the true purpose of the analysis. When your manager asks for a “3-year sales trend by month,” what is he looking for? It could be that he’s asking whether current monthly sales are declining versus history. Do you really need to show each and every month, or can you show the directional trend?

A directional trend is one that uses simple analysis to imply a relative direction of performance. The key attribute of a directional trend is that the data used is often a set of calculated values as opposed to actual data values. For instance, rather than chart each month’s sales for a single year, you could chart the average sales for Q1, Q2, Q3, and Q4. With such a chart, you’d get a directional idea of monthly sales, without the need to look into detailed data.

Take a look at Figure 7-30, which shows two charts. The bottom chart trends each year’s monthly data in a single chart. You can see how difficult it is to discern much from this chart. It looks like monthly sales are dropping in all three years. The top chart shows the same data in a directional trend, showing average sales for key periods. The trend jumps at you, showing that sales have flattened out after healthy growth in 2011 and 2012.
Smoothing data

Certain lines of business lend themselves to wide fluctuations in data from month to month. For instance, a consulting practice may go months without a steady revenue stream before a big contract comes along and spikes the sales figures for a few months. Some call these ups and downs *seasonality,* or *business cycles.*

Whatever you call them, wild fluctuations in data can prevent you from effectively analyzing and presenting trends. Figure 7-31 demonstrates how highly volatile data can conceal underlying trends.

This is where the concept of smoothing comes in. *Smoothing* does just what it sounds like — it forces the range between the highest and lowest values in a dataset to smooth to a predictable range without disturbing the proportions of the dataset.

Now, you can use lots of different techniques to smooth a dataset. Take a moment to walk through two of the easier ways to apply smoothing.
Chapter 7: Charts That Show Trending

Excel has a built-in smoothing mechanism, in the form of a moving average trend line — that is, a trend line that calculates and plots the moving average at each data point. A *moving average* is a statistical operation used to track daily, weekly, or monthly patterns. A typical moving average starts calculating the average of a fixed number of data points, and then with each new day’s (or week’s or month’s) numbers, the oldest number is dropped and the newest number is included in the average. This calculation is repeated over the entire dataset, creating a trend that represents the average at specific points in time.

Figure 7-32 illustrates how Excel’s moving average trend line can help smooth volatile data, highlighting a predictable range.

**Smoothing with Excel’s moving average functionality**

Figure 7-31: The volatile nature of this data makes it difficult to see the underlying trend.
In this example, a 4-month moving average has been applied.

To add a moving average trend line, follow these steps:

1. Right-click the data series that represents the volatile data and then select Add Trendline from the menu that appears.
   The Format Trendline dialog box appears, shown in Figure 7-33.

2. In the Format Trendline dialog box, select Moving Average and then specify the number of periods.
   In this case, Excel will average a 4-month moving trend line.

Creating your own smoothing calculation
As an alternative to Excel's built-in trend lines, you can create your own smoothing calculation and simply include it as a data series in your chart. In Figure 7-34, a calculated column (appropriately named Smoothing) provides the data points needed to create a smoothed data series.
In this example, the second row of the Smoothing column contains a simple average formula that averages the first data point and the second data point. Note that the reference to the first data point (cell D2) is locked as an absolute value with dollar ($) signs. This ensures that when this formula is copied down, the range grows to include all previous data points.

After the formula is copied down to fill the entire smoothing column, it can simply be included in the data source for the chart. Figure 7-35 illustrates the smoothed data plotted as a line chart.

![Figure 7-35: Plotting the smoothed data reveals the underlying trend.](image-url)
Chapter 8

Grouping and Bucketing Data

In This Chapter
▶ Making top and bottom displays
▶ Using histograms to track groups
▶ Creating histograms with pivot tables
▶ Highlighting top and bottom values in charts

It’s often helpful to organize your analyses into logical groups of data. Grouping allows you to focus on manageable sets that have key attributes. For example, rather than look at all customers in one giant view, you can analyze customers who buy only one product. Then you can focus attention and resources on those customers who have the potential to buy more products.

The benefit of grouping data is that you can more easily pick out groups that fall outside the norm for your business.

In this chapter, I help you explore some of the techniques you can use to create components that group and bucket data.

Creating Top and Bottom Displays

When you look at the list of Fortune 500 companies, you often look for the top 20 companies. Then perhaps you look at who eked out a spot in the bottom 20 slots. It’s unlikely that you would check to see which company came in at number 251. It’s not necessarily because you don’t care about number 251; it’s just that you can’t spend the time or energy to process all 500 companies. So you process the top and bottom of the list.
This concept is the same one behind creating top and bottom displays. Your audience has only a certain amount of time and resources to dedicate to solving any issues you can emphasize on your dashboard. Showing them the top and bottom values in your data can help them pinpoint where and how they can have the most impact with the time and resources they possess.

**Incorporating top and bottom displays into dashboards**

The top and bottom displays you create can be as simple as source data that you incorporate into your dashboard. Typically placed to the right of a dashboard, this data can emphasize details that a manager may use to take action on a metric. For example, the simple dashboard shown in Figure 8-1 shows sales information with top and bottom sales reps.

![Figure 8-1: Top and bottom displays that emphasize certain metrics.](image)

To get a little fancier, you can supplement the top and bottom displays with some ranking information, some in-cell bar charts, or some conditional formatting; see Figure 8-2.

You can create the in-cell bar charts with the Data Bars conditional formatting function, covered in Chapter 5. The arrows are also simple conditional formatting rules that are evaluated against the variance in current and preceding months’ ranks.
Chapter 8: Grouping and Bucketing Data

Using pivot tables to get top and bottom views

If you’ve read Chapter 6, you know that a pivot table is an amazing tool that can help create interactive reporting. Take a moment now to look over an example of how pivot tables can help you build interactive top and bottom displays.

Open the Chapter 8 Samples file, found on this book’s companion website, to follow along.

Follow these steps to display Top and Bottom filters with a pivot table:

1. Start with a pivot table that shows the data you want to display with the top and bottom views.

   In this case, the pivot table shows Sales Rep and Sales_Amount; see Figure 8-3.

2. Right-click the field you want to use to determine the top values — in this example, use the Sales Rep field — and then choose Filter: Top 10 from the menu that appears, as shown in Figure 8-4.

   The Top 10 Filter (Sales Rep) dialog box appears, as shown in Figure 8-5.
3. In the Top 10 Filter (Sales Rep) dialog box, define the view you’re looking for.

In this example, you want the Top 10 Items (Sales Reps) as defined by the Sales_Amount field.
4. Click OK to apply the filter.

At this point, the pivot table is filtered to show the top ten sales reps for the selected region and market. You can change the Market filter to Charlotte and get the top ten sales reps for Charlotte only; see Figure 8-6.

5. To view the bottom ten Sales Rep list, copy the entire pivot table and paste it next to the existing one.

6. Repeat Steps 2 through 4 in the newly copied pivot table — except this time, choose to filter the bottom ten items as defined by the Sales_Amount field.

If all goes well, you now have two pivot tables similar to those in Figure 8-7: one that shows the top ten sales reps and one that shows the bottom ten. You can link back to these two pivot tables in the analysis layer of your data model using formulas. This way, when you update the data, the top and bottom values display the new information.

If there’s a tie for any rank in the top or bottom values, Excel shows you all tied records, so you may get more than the number you filtered for. If you filtered for the top 10 sales reps and there’s a tie for the number 5 rank, Excel shows you 11 sales reps. (Both reps ranked at number 5 are shown.)
Top Values in Charts

Sometimes a chart is indeed the best way to display a set of data, but you still want to call attention to the top values in that chart. In these cases, you can use a technique that highlights the top values in your charts. That is to say, you can use Excel to figure out which values in your data series are in the top $n$th value and then apply special formatting to them. Figure 8-8 illustrates an example in which the top five quarters are highlighted and given a label.

The secret to this technique is Excel’s obscure LARGE function. The LARGE function returns the $n$th largest number from a dataset. In other words, you tell it where to look and the number rank you want.
Chapter 8: Grouping and Bucketing Data

To find the largest number in the dataset, you enter the formula `LARGE(Data_Range, 1)`. To find the fifth largest number in the dataset, use `LARGE(Data_Range, 5)`. Figure 8-9 illustrates how the LARGE function works.

The idea is fairly simple: To identify the top five values in a dataset, you first need to identify the fifth largest number (`LARGE` function to the rescue) and then test each value in the dataset to see whether it’s bigger than the fifth largest number. Here’s what you do:

1. **Build a chart feeder that consists of formulas that link back to your raw data.**

   The feeder should have two columns: one to hold data that isn’t in the top five and one to hold data that is in the top five; see Figure 8-10.
2. In the first row of the chart feeder, enter the formulas shown in Figure 8-10.

The formula for the first column (F4) checks to see whether the value in cell C4 is less than the number returned by the \texttt{LARGE} formula (the fifth largest value). If it is, the value in cell C4 is returned. Otherwise, \texttt{NA} is used. The formula for the second column works in the same way, except the \texttt{IF} statement is reversed: If the value in cell C4 is greater than or equal to the number returned by the \texttt{LARGE} formula, the value is returned; otherwise, \texttt{NA} is used.

3. Copy down the formulas to fill the table.

4. Use the chart feeder table to plot the data into a stacked column chart.

You immediately see a chart that displays two data series: one for data points not in the top five and one for data points in the top five; see Figure 8-11.

Notice that the chart in Figure 8-11 shows some rogue zeros. You can complete the next few steps to fix the chart so that the zeros don’t appear.

5. Right-click any of the data labels for the “not in top 5” series and choose \texttt{Format Data Labels} from the menu that appears.

The \texttt{Format Data Labels} dialog box appears.

6. In this dialog box, expand the \texttt{Numbers} section and select \texttt{Custom} in the \texttt{Category} list.
7. Enter #,##0;; as the custom number format, as shown in Figure 8-12.
8. Click Add and then click Close.

When you go back to the chart, you see that the rogue zeros are now hidden and the chart is ready for colors, labels, and other formatting you want to apply.

You can apply the same technique to highlight the bottom five values in your dataset. The only difference is that instead of using the LARGE function, you use the SMALL function. Whereas the LARGE function returns the largest nth value from a range, the SMALL function returns the smallest nth value.

Figure 8-13 illustrates the formulas you use to apply the same technique outlined here for the bottom five values.

The formula for the first column (F22) checks to see whether the value in cell C22 is greater than the number returned by the SMALL formula (the fifth smallest value). If it is, the value in cell C22 is returned. Otherwise, NA is used. The formula for the second column works in the same way except the IF statement is reversed: If the value in cell C22 is greater than the number returned by the SMALL formula, NA is used; otherwise, the value is returned.
Using Histograms to Track Relationships and Frequency

A histogram is a graph that plots frequency distribution. A frequency distribution shows how often an event or category of data occurs. With a histogram, you can visually see the general distribution of a certain attribute.

Take a look at the histogram shown in Figure 8-14. This histogram represents the distribution of units sold in one month among your sales reps. As you can see, most reps sell somewhere between 5 and 25 units per month. As a manager, you want the hump in the chart to move to the right — more people selling a higher number of units per month. So you set a goal for a majority of the sales reps to sell between 15 and 25 units within the next three months. With this histogram, you can visually track the progress toward that goal.
This section discusses how to create a histogram using various methods available to you. These techniques allow for a level of automation and interactivity, which comes in handy when updating dashboards each month.

See how to develop a data model in Chapter 2.

**Creating a formula-driven histogram**

If you don’t have Excel 2016, or if you want a bit more involvement in creating your histogram charts, you can create a formula-driven histogram. This technique fits nicely in data models in which you separate data, analysis, and presentation information.

Follow these steps to create a formula-driven histogram:

1. **Before you create the histogram, you need a table that contains your raw data, and you need to create a bin table; see Figure 8-15.**

   The raw data should ideally consist of records that represent unique counts for the data you want to group. For instance, the raw data table in Figure 8-15 contains unique sales reps and the number of units each has sold.

   ![Figure 8-15: Start with your raw data table and a bin table.](image)

   The bin table dictates the grouping parameters used to break your raw data into the frequency groups. The bin table tells Excel to cluster all sales reps selling fewer than 5 units into the first frequency group, any sales reps selling 5 to 14 units in the second frequency group, and so on.
You can freely set your own grouping parameters when you build the bin table. However, you should generally keep parameters as equally spaced as possible. You typically want to end your bin tables with the largest number in the dataset. This gives you clean groupings that end in a finite number — not in an open-ended greater-than designation.

2. Create a new column in the bin table to hold the FREQUENCY formulas, and then name the new column Frequency Formulas, as shown in Figure 8-16.

Excel’s FREQUENCY function counts how often values occur within the ranges you specify in a bin table.

3. Select the cells in the newly created column.

4. Type the FREQUENCY formula you see in Figure 8-16 and then press Ctrl+Shift+Enter on the keyboard.

The FREQUENCY function has a quirk that often confuses first-time users. The FREQUENCY function is an array formula — a formula that returns many values at one time. For this formula to work properly, you have to press Ctrl+Shift+Enter on the keyboard after typing the formula. If you press only the Enter key, you don’t get the results you need.

At this point, you should have a table that shows the number of sales reps that fall into each of your bins. You could chart this table, but the data labels would come out wonky. For the best results, build a simple chart feeder table that creates appropriate labels for each bin. You do this in the next step.
5. Create a new table that feeds the charts a bit more cleanly; see Figure 8-17.

Use a simple formula that concatenates bins into appropriate labels. Use another formula to bring in the results of your FREQUENCY calculations.

In Figure 8-17, the formulas in the first record of the chart feeder table are visible. These formulas are essentially copied down to create a table that’s appropriate for charting.

<table>
<thead>
<tr>
<th>Bins</th>
<th>Frequency Formulas</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>10</td>
<td>13</td>
</tr>
<tr>
<td>15</td>
<td>3</td>
</tr>
<tr>
<td>20</td>
<td>5</td>
</tr>
<tr>
<td>25</td>
<td>2</td>
</tr>
<tr>
<td>30</td>
<td>2</td>
</tr>
<tr>
<td>35</td>
<td>1</td>
</tr>
<tr>
<td>40</td>
<td>1</td>
</tr>
<tr>
<td>45</td>
<td>1</td>
</tr>
<tr>
<td>50</td>
<td>1</td>
</tr>
<tr>
<td>55</td>
<td>1</td>
</tr>
<tr>
<td>60</td>
<td>1</td>
</tr>
<tr>
<td>65</td>
<td>1</td>
</tr>
<tr>
<td>70</td>
<td>1</td>
</tr>
<tr>
<td>75</td>
<td>1</td>
</tr>
<tr>
<td>80</td>
<td>1</td>
</tr>
<tr>
<td>85</td>
<td>1</td>
</tr>
<tr>
<td>90</td>
<td>1</td>
</tr>
<tr>
<td>95</td>
<td>1</td>
</tr>
<tr>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>105</td>
<td>1</td>
</tr>
<tr>
<td>110</td>
<td>1</td>
</tr>
<tr>
<td>115</td>
<td>1</td>
</tr>
<tr>
<td>120</td>
<td>1</td>
</tr>
<tr>
<td>125</td>
<td>1</td>
</tr>
</tbody>
</table>

6. Use the newly created chart feeder table to plot the data into a column chart.

Figure 8-18 illustrates the resulting chart. You can very well use the initial column chart as your histogram.

If you like your histograms to have spaces between the data points, you’re done. If you like the continuous, blocked look you get with no gaps between the data points, follow the next few steps.

7. Right-click any of the columns in the chart and choose Format Data Series from the menu that appears.

The Format Data Series dialog box appears.

8. Adjust the Gap Width property to 0%, as shown in Figure 8-19.

Adding a cumulative percent

A nice feature to add to your histograms is a cumulative percent series. With a cumulative percent series, you can show the percent distribution of the data points to the left of the point of interest.
Figure 8-20 shows an example of a cumulative percent series. At each data point in the histogram, the cumulative percent series tells you the percent of the population that fills all the bins up to that point. For instance, you can see that 25% of the sales reps represented sold 15 units or less. In other words, 75% of the sales reps sold more than 15 units.

Take another look at the chart in Figure 8-20 and find the point where you see 75% on the cumulative series. At 75%, look at the label for that bin range (you see 35–45). The 75% mark tells you that 75% of sales reps sold between 0 and 45 units. This means that only 25% of sales reps sold more than 45 units.
To create a cumulative percent series for the histogram, follow these steps:

1. Perform Steps 1 through 5 of creating a histogram (in the “Creating a formula-driven histogram” section) and then add a column to your chart feeder table that calculates the percent of total sales reps for the first bin; see Figure 8-21.

Note the dollar symbols ($) used in the formula to lock the references while you copy down the formula.

2. Copy down the formula for all bins in the table.

3. Use the chart feeder table to plot the data into a line chart.

As you can see in Figure 8-22, the resulting chart needs some additional formatting.
4. Right-click the series that makes up your histogram (Count of Sales Reps), select Change Chart Type from the menu that appears, and then change the chart type to a column chart.

5. Right-click any of the columns in the chart and choose Format Data Series.

6. Adjust the Gap Width property to 0%, as demonstrated earlier, in Figure 8-19.

7. Right-click Cumulative % series in the chart and choose Format Data Series.

8. In the Format Data Series dialog box, change the Plot Series On option to Secondary Axis.

9. Right-click Cumulative % series in the chart and choose Add Data Labels.

At this point, your base chart is complete. It should look similar to the one shown at the beginning of this section, in Figure 8-20. When you get to this point, you can adjust the colors, labels, and other formatting.
**Using a pivot table to create a histogram**

Did you know you can use a pivot table as the source for a histogram? That’s right. With a little-known trick, you can create a histogram that’s as interactive as a pivot table!

As in the formula-driven histogram, the first step in creating a histogram with a pivot table is to create a frequency distribution. Just follow these steps:

1. **Create a pivot table and plot the data values in the row area (not the data area).**

   As you can see in Figure 8-23, the SumOfSales_Amount field is placed in the ROWS drop zone. Place the Sales Rep field in the VALUES drop zone.

   ![Figure 8-23: Place your data values in the ROWS drop zone and the Sales Rep field in the VALUES drop zone as a Count.](image)

2. **Right-click any value in the ROWS area and choose Group from the menu that appears.**

   The Grouping dialog box appears, as shown in Figure 8-24.

3. **In this dialog box, set the Starting At and Ending At values and then set the interval.**

   This step creates the frequency distribution. In Figure 8-24, the distribution is set to start at 5,000 and to create groups in increments of 1,000 until it ends at 100,000.
Part III: Building Advanced Dashboard Components

4. Click OK to confirm your settings.

The pivot table calculates the number of sales reps for each defined increment, just as in a frequency distribution; see Figure 8-25. You can now leverage this result to create a histogram!

The obvious benefit to this technique is that after you have a frequency distribution and a histogram, you can interactively filter the data based on other dimensions, like region and market. For instance, you can see the histogram for the Canada market and then quickly switch to see the histogram for the California market.
Note that you can’t add cumulative percentages to a histogram based on a pivot table.

**Using Excel’s Histogram statistical chart**

If you’re using Excel 2016, you get the luxury of using Excel’s new statistical charts. *Statistical charts* help calculate and visualize common statistical analyses without the need to engage in brain-busting calculations. This new chart type lets you essentially point and click your way into a histogram chart, leaving all the mathematical heavy lifting to Excel.

To create a histogram chart with the new statistical chart type, follow these steps:

1. **Start with a dataset that contains values for a unique group you want to bucket and count.**

   For instance, the raw data table in Figure 8-26 contains unique sales reps and the number of units each has sold.

   ![Figure 8-26: Start with a raw data table.](image)

2. **Select your data, click the Statistical Charts icon found on the Insert tab and then select the Histogram chart from the drop-down menu that appears. (See Figure 8-27.)**

   Note, in Figure 8-27, that you can also have Excel create a histogram with a cumulative percentage. This would output a histogram with a supplemental line showing the distribution of values, similar to the chart illustrated earlier, in Figure 8-20.
Excel outputs a histogram chart based on the values in your source dataset. As you can see in Figure 8-28, Excel attempts to derive the best configuration of bins based on your data.

![Figure 8-27: Creating a histogram chart.](image)

![Figure 8-28: Excel auto-generates a histogram based on its own derived bins.](image)

You can always change the configuration of the bins if you’re not happy with what Excel has come up with. Simply right-click the x-axis and select Format Axis from the menu that appears. In the Axis Options section (see Figure 8-29), you see a few settings that allow you to override Excel’s automatic bins:

- **Bin width**: Select this option to specify how big the range of each bin should be. For instance, if you were to set the bin width to 12, each bin would represent a range of 12 numbers. Excel would then plot as many 12-number bins as it needs to account for all the values in your source data.

- **Number of bins**: Select this option to specify the number of bins to show in the chart. All data will then be distributed across the bins so that each bin has approximately the same population.
Overflow bin: Use this setting to define a threshold for creating bins. Any value above the number to set here will be placed into a kind of “all other” bin.

Underflow bin: Use this setting to define a threshold for creating bins. Any value below the number to set here will be placed into a kind of “all other” bin.

Figure 8-30 illustrates how the histogram would change when the following settings are applied:

- Number of bins: 10
- Overflow bin: 100
- Underflow bin: 10
Chapter 9

Displaying Performance against a Target

In This Chapter

▶ Using variance displays
▶ Using progress bars
▶ Creating bullet graphs
▶ Showing performance against a range

Hopefully, this is an easy one to grasp. Someone sets a target, and someone else tries to reach that target. The target can be anything from a certain amount of revenue to a number of boxes shipped or to phone calls made. The business world is full of targets and goals. Your job is to find effective ways to represent performance against those targets.

What do I mean by performance against a target? Imagine that your goal is to break the land speed record, which is now 763 miles per hour. That makes the target 764 miles per hour, which will break the record. After you jump into your car and go as fast as you can, you will have a final speed. That number is your performance against the target.

In this chapter, I explore some new and interesting ways to create components that show performance against a target.

Showing Performance with Variances

The standard way to display performance against a target is to plot the target and then plot the performance. This is usually done with a line chart or a combination chart, such as the one shown in Figure 9-1.
Although this chart allows you to visually pick the points where performance exceeded or fell below targets, it gives you a rather one-dimensional view and provides minimal information. Even if this chart offered labels that showed the actual percent of sales revenue versus target, you’d still get only a mildly informative view.

A more effective and informative way to display performance against a target is to plot the variances between the target and the performance. Figure 9-2 shows the same performance data you see in Figure 9-1 but includes the variances (sales revenue minus target) under the month label. This way, you see where performance exceeded or fell below targets, but you also get an extra layer of information showing the dollar impact of each rise and fall.
which you don’t have a target to measure against, it’s often helpful to measure performance against some organizational statistic.

For example, the component in Figure 9-3 measures the sales performance for each division against the median sales for all the divisions. You can see that divisions 1, 3, and 6 fall well below the median for the group.

Here’s how you’d create a median line similar to the one you see in Figure 9-3:

1. Start a new column next to your data and type the simple `MEDIAN` formula, as shown in Figure 9-4.

   Note that this formula can be any mathematical or statistical operation that works for the data you’re representing. Just make sure that the values returned are the same for the entire column. This gives you a straight line.
2. Copy the formula down to fill the table.
   Again, all numbers in the newly created column should be the same.

3. Plot the table into a column chart.

4. Right-click the Median data series and choose Change Series Chart Type from the menu that appears.

5. Change the chart type to a line chart.

**Using a Thermometer-Style Chart**

A thermometer-style chart offers a unique way to view performance against a goal. As the name implies, the data points shown in this type of chart resemble a thermometer. Each performance value and its corresponding target are stacked on top of one another, giving an appearance similar to that of mercury rising in a thermometer. In Figure 9-5, you see an example of a thermometer-style chart.

To create this type of chart, follow these steps:

1. Starting with a table that contains revenue and target data, plot the data into a new column chart.

2. Right-click the Revenue data series and choose Format Data Series from the menu that appears.

3. In the Format Data Series dialog box, select Secondary Axis.

4. Go back to the chart and delete the new vertical axis that was added.
   It’s the vertical axis to the right of the chart.
5. Right-click the Target series and choose Format Data Series.

6. In the dialog box, adjust the Gap Width property so that the Target series is slightly wider than the Revenue series — between 45% and 55% is typically fine.

**Using a Bullet Graph**

A *bullet graph* is a type of column/bar graph developed by visualization expert Stephen Few to serve as a replacement for dashboard gauges and meters. He developed bullet graphs to allow you to clearly display multiple layers of information without occupying a lot of space on a dashboard. A bullet graph, as shown in Figure 9-6, contains a single performance measure (such as YTD [year-to-date] revenue), compares that measure with a target, and displays it in the context of qualitative ranges, such as Poor, Fair, Good, and Very Good.
Figure 9-7 breaks down the three main parts of a bullet graph. The single bar represents the performance measure. The horizontal marker represents the comparative measure. The background color banding represents the qualitative ranges.

Creating a bullet graph

Creating a bullet graph in Excel involves quite a few steps, but the process isn’t necessarily difficult. Follow these steps to create your first bullet graph:

1. Start with a data table that gives you all the data points you need to create the three main parts of the bullet graph.

Figure 9-8 illustrates what that data table looks like. The first four values in the dataset (Poor, Fair, Good, and Very Good) make up the qualitative range. You don’t have to have four values — you can have as many or as few as you need. In this scenario, you want the qualitative range to span from 0 to 100%. Therefore, the percentages (70%, 15%, 10%, and 5%) must add up to 100%. Again, this can be adjusted to suit your needs. The fifth value in Figure 9-8 (Value) creates the performance bar. The sixth value (Target) makes the target marker.
2. Select the entire table and plot the data on a stacked column chart.
   The chart that’s created is initially plotted in the wrong direction.

3. To fix the direction, click the chart and select the Switch Row/Column button on the Ribbon, as shown in Figure 9-9.

4. Right-click the Target series and choose Change Series Chart Type from the menu that appears.
   Doing so calls up the Change Chart Type dialog box.

5. Use the Change Chart Type dialog box to change the Target series to Line with Markers and to place it on the secondary axis; see Figure 9-10.
   After your change is confirmed, the Target series appears on the chart as a single dot.

6. Right-click the Target series again and choose Format Data Series to open that dialog box.

7. Click Marker to expand the Marker options and then adjust the marker to look like a dash, as shown in Figure 9-11.

8. Still in the Format Data Series dialog box, expand the Fill section, and in the Solid Fill property, set the color of the marker to a noticeable color such as red.

9. Still in the Format Data Series dialog box, expand the Border section and set the Border to No Line.
10. Go back to your chart and delete the new secondary axis that was added to the right of your chart; see Figure 9-12.

This is an important step to ensure that the scale of the chart is correct for all data points.

11. Right-click the Value series and choose Format Data Series from the menu that appears.

12. In the Format Data Series dialog box, click Secondary Axis.

13. Still in the Format Data Series dialog box, under Series Options, adjust the Gap Width property so that the Value series is slightly narrower than the other columns in the chart — between 205% and 225% is typically okay.
14. Still in the Format Data Series dialog box, click the Fill icon (the paint bucket), expand the Fill section, and then select the Solid Fill option to set the color of the Value series to black.

15. All that’s left to do is change the color for each qualitative range to incrementally lighter hues.

At this point, your bullet graph is essentially done! You can apply whatever minor formatting adjustments to the size and shape of the chart to make it look the way you want. Figure 9-13 shows your newly created bullet graph formatted with a legend and horizontal labels.
Adding data to your bullet graph

After you’ve built your chart for the first performance measure, you can use the same chart for any additional measures. Take a look at Figure 9-14.

As you can see in Figure 9-14, you’ve already created this bullet graph with the first performance measure. Imagine that you add two more measures and want to graph those. Here’s how to do it:

1. Click the chart so that the blue outline appears around the original source data.

2. Hover the mouse pointer over the blue dot in the lower-right corner of the blue box.
   The cursor turns into an arrow, as shown in Figure 9-14.

3. Click and drag the blue dot to the last column in your expanded dataset.
   Figure 9-15 illustrates how the new data points are added without one ounce of extra work!

Final thoughts on formatting bullet graphs

Before wrapping up this introduction to bullet graphs, I discuss two final thoughts on formatting:

- Creating qualitative bands
- Creating horizontal bullet graphs
Chapter 9: Displaying Performance against a Target

Creating qualitative bands

First, if the qualitative ranges are the same for all performance measures in your bullet graphs, you can format the qualitative range series to have no gaps between them. For instance, Figure 9-16 shows a set of bullet graphs in which the qualitative ranges have been set to 0% Gap Width. This creates the clever effect of qualitative bands.

Here's how to do it:

1. **Right-click any one of the qualitative series and choose Format Data Series from the menu that appears.**
2. **In the Format Series dialog box, adjust the Gap Width property to 0%.**
Creating horizontal bullet graphs

For those of you waiting on the section about horizontal bullet graphs, I have good news and bad news. The bad news is that creating a horizontal bullet graph from scratch in Excel is a much more complex endeavor than creating a vertical bullet graph — one that doesn’t warrant the time and effort it takes to create them.

The good news is that there is a clever way to get a horizontal bullet graph from a vertical one — and in three steps, no less. Here’s how you do it:

1. **Create a vertical bullet graph.**
   For how to do this, see the “Creating a bullet graph” section, earlier in this chapter.

2. **To change the alignment for the axis and other labels on the bullet graph so that they’re rotated 270 degrees, right-click the axis labels, select Format Axis, go to the Alignment settings, and then adjust the Text Direction property to rotate the axis labels as seen in Figure 9-17.**

![Figure 9-17: Rotate all labels so that they’re on their sides.](image)
3. Use Excel’s Camera tool to take a picture of the bullet graph.

After you have a picture, you can rotate it to be horizontal. Figure 9-18 illustrates a horizontal bullet graph.

The nifty thing about this trick is that because the picture is taken with the Camera tool, the picture automatically updates when the source table changes.

Check out Chapter 5 to discover how to find and use the Camera tool.

**Figure 9-18:** A horizontal bullet graph.

---

**Showing Performance against a Target Range**

In some businesses, a target isn’t one value — it’s a range of values. That is to say, the goal is to stay within a defined target range. Imagine that you manage a small business selling boxes of meat. Part of your job is to keep the inventory stocked between 25 and 35 boxes in a month. If you have too many boxes of meat, the meat will go bad. If you have too few boxes, you’ll lose money.

To track how well you do at keeping the inventory of meat between 25 and 35 boxes, you need a performance component that displays on-hand boxes against a target range. Figure 9-19 illustrates a component you can build to track performance against a target range. The gray band represents the target range you must stay within each month. The line represents the trend of on-hand meat.
Obviously, the trick to this type of component is to set up the band that represents the target range. Here’s how you do it:

1. **Set up a limit table in which you can define and adjust the upper and lower limits of the target range.**

   Cells B2 and B3 in Figure 9-20 serve as the place to define the limits for the range.

   ![Figure 9-20: Create a chart feeder that contains formulas that define the data points for the target range.](image)

2. **Build a chart feeder that’s used to plot the data points for the target range.**

   This feeder consists of the formulas revealed in cells B8 and B9 in Figure 9-20. The idea is to copy these formulas across all data. The values you see in the Feb, Mar, and Apr columns are the results of these formulas.

3. **Add a row for the actual performance values, as shown in Figure 9-21.**

   These data points create the performance trend line.
4. Select the entire chart feeder table and plot the data on a stacked area chart.

5. Right-click the Values series and choose Change Series Chart Type from the menu that appears.

Doing so calls up the Change Chart Type dialog box.

6. Using the Change Chart Type dialog box, change the Values series to a line chart and place it on the secondary axis, as shown in Figure 9-22.

After your change is confirmed, the Values series appears on the chart as a line.

Figure 9-21: Add a row for the performance values.

Figure 9-22: Use the Change Chart Type dialog box to change the Values series to a line chart and place it on the secondary axis.
7. Go back to your chart and delete the new vertical axis that was added. It’s the vertical axis to the right of the chart.

8. Right-click the Lower Limit data series and choose Format Data Series from the menu that appears.

9. In the Format Data Series dialog, click the Fill icon and then choose the No Fill option under Fill and the No Line option under Border; see Figure 9-23.

10. Right-click the Upper Limit series and select Format Data Series.

11. In the Format Series dialog box, adjust the Gap Width property to 0%.

That’s it. All that’s left to do is apply the minor adjustments to colors, labels, and other formatting.
Part IV

Advanced Reporting Techniques

Visit www.dummies.com/extras/exceldashboardsreports to take a peek at various techniques you can use to create dynamic labels, allowing you to create a whole new layer of visualization.
In this part . . .

- Take an in-depth look at some of the key dashboarding concepts you can leverage to create cutting-edge presentations.
- Gain a clear understanding of how you can leverage macros to automate your reporting systems.
- Discover how interactive controls can provide your clients with simple interfaces, allowing them to easily navigate through, and interact with, your dashboard or report.
- Explore pivot slicers and see how to use them to add interactive filtering capabilities to your pivot reporting.
A macro is essentially a set of instructions or code that you create to tell Excel to execute any number of actions. In Excel, macros can be written or recorded. The key word here is recorded.

Recording a macro is like programming a phone number into your cellphone. You first manually dial and save a number. Then when you want, you can redial those numbers with the touch of a button. Just as on a cellphone, you can record your actions in Excel while you perform them. While you record, Excel gets busy in the background, translating your keystrokes and mouse clicks to written code, also known as Visual Basic for Applications (VBA). After you record a macro, you can play back those actions anytime you want.

In this chapter, you explore macros and see how you can use them to automate recurring processes to simplify your life.

**Why Use a Macro?**

The first step in using macros is admitting you have a problem. Actually, you may have several problems:

*Repetitive tasks.* As each new month rolls around, you have to make the doughnuts — that is, crank out those reports. You have to import that data. You have to update those pivot tables. You have to delete those columns, and so on. Wouldn’t it be nice if you could fire up a macro and have those more redundant parts of your dashboard processes done automatically?
You're making mistakes. When you enter into hand-to-hand combat with Excel, you're bound to make mistakes. When you're repeatedly applying formulas, sorting, and moving things around manually, you always run the risk of catastrophe. Add to that the looming deadlines and endless change requests, and your error rate goes up. Why not calmly record a macro, ensure that everything is running correctly, and then forget it? The macro is sure to perform every action the same way every time you run it, reducing the chance of errors.

Awkward navigation. Remember that you're creating these dashboards and reports for an audience that probably has a limited knowledge of Excel. If your reports are a bit too difficult to use and navigate, you'll find that you slowly lose support for your cause. It's always helpful to make your dashboard more user-friendly.

Here are some ideas for macros that make things easier for everyone:

-✓ A macro that formats and prints a worksheet or range of worksheets at the touch of a button
-✓ Macros that navigate a multisheet worksheet with a navigation page or with a go-to button for each sheet in a workbook
-✓ A macro that saves the open document in a specified location and then closes the application at the touch of a button

Obviously, you can perform each of these examples in Excel without the aid of a macro. However, your audience will appreciate these little touches that help make perusal of your dashboard a bit more pleasant.

Recording Your First Macro

If you're a beginner to dashboard automation, you're unlikely to be able to write the VBA code by hand. Without full knowledge of Excel's object model and syntax, writing the needed code would be impossible for most beginning users. This is where recording a macro comes in handy. The idea is that you record an action and then run the macro every time you want that action performed.

To get started in creating your first macro, open the Chapter 10 Samples file found on this book's companion website. After the file is open, select the Recording Your First Macro tab.

To begin, you first need to unhide the Developer tab. You can find the full macro toolset in Excel on the Developer tab, which is initially hidden. You have to explicitly tell Excel to make it visible. To enable the Developer tab, follow these steps:
1. Go to the Ribbon and click the File button.
2. Open the Excel Options dialog box by clicking the Options button.
3. Click the Customize Ribbon button.

   In the list box on the right, you see all available tabs.
4. Select the Developer tab, as shown in Figure 10-1.
5. Click OK.

Now that you have the Developer tab visible on the Ribbon, select it and click the Record Macro command. This opens the Record Macro dialog box, as shown in Figure 10-2.
Here are the four fields in the Record Macro dialog box:

- **Macro Name**: Excel gives a default name to your macro, such as Macro1, but it’s best practice to give your macro a name more descriptive of what it actually does. For example, you might name a macro that formats a generic table as AddDataBars.

- **Shortcut Key**: This field is optional. Every macro needs an event, or something to happen, for it to run. This event can be a button click, a workbook opening, or in this case, a keystroke combination. When you assign a shortcut key to your macro, entering that combination of keys triggers the macro to run. You need not enter a shortcut key to run the macro.

- **Store Macro In**: This Workbook is the default option. Storing your macro in This Workbook simply means that the macro is stored along with the active Excel file. The next time you open that particular workbook, the macro will be available to run. Similarly, if you send the workbook to another user, that user can run the macro as well, as long as the macro security is properly set by your user — but more on that later.

- **Description**: This field is optional, but it’s useful if you have numerous macros in a spreadsheet or if you need to give a user a more detailed description about what the macro does.

In this first example, enter AddDataBars into the Macro Name field and select This Workbook from the Store Macro In drop-down menu; see Figure 10-3. Click OK.

![Figure 10-3: Start recording a new macro called AddDataBars.](image)

Excel is now recording your actions. While Excel is recording, you can perform any actions you want. In this scenario, you record a macro to add Data Bars to a column of numbers.
Follow along using these steps:

2. Go to the Home tab and select Conditional Formatting ➪ New Rule.
3. In the New Formatting Rule dialog box, select Data Bar from the Format Style drop-down menu.
4. In the new dialog box that appears, select the Show Bar Only check box.
5. Click OK to apply your change.
6. Go to the Developer tab and click the Stop Recording command.
   At this point, Excel stops recording. You now have a macro that replaces the data in C1:C21 with Data Bars. Now you record a new macro to remove the Data Bars.
7. Go to the Developer tab and click the Record Macro command.
8. Enter RemoveDataBars into the Macro Name field and select the This Workbook option from the Store Macro In drop-down menu; see Figure 10-4.
9. Click OK.
12. Go to the Developer tab and click the Stop Recording command.
   Again, Excel stops recording. You now have a new macro that removes conditional formatting rules from cells C1:C21.
**Running Your Macros**

To see your macros in action, select the Macros command from the Developer tab. The dialog box in Figure 10-5 appears, allowing you to select the macro you want to run. Select the AddDataBars macro and click the Run button.

If all goes well, the macro plays back your actions to a T and applies the Data Bars as designed; see Figure 10-6.

You can now call up the Macro dialog box again and test the RemoveDataBars macro shown in Figure 10-7.

When you create macros, you want to give your audience a clear and easy way to run each macro. A button, used directly on the dashboard or report, can provide a simple but effective user interface.

Excel Form controls enable you to create user interfaces directly on your worksheets, simplifying work for your users. Form controls range from buttons (the most commonly used control) to scroll bars and check boxes.

For a macro, you can place a Form control in a worksheet and then assign that macro to it — that is, a macro you’ve already recorded. When a macro is assigned to the control, that macro is executed, or played, every time the control is clicked.
Take a moment to create buttons for the two macros (AddDataBars and RemoveDataBars) that you create earlier in this chapter. Here’s how:

1. Click the Insert drop-down list under the Developer tab.
2. Select the Button Form control, as shown in Figure 10-8.
3. **Click the location where you want to place your button.**

When you drop the Button control into the worksheet, the Assign Macro dialog box, as shown in Figure 10-9, opens and asks you to assign a macro to this button.

4. **Select the macro that you want to assign.**

In this case, select the AddDataBars macro and click OK.

5. **Repeat Steps 1 through 4 for the RemoveDataBars macro.**

The buttons you create come with a default name, such as Button3. To rename a button, right-click the button and then click the existing name. Then you can delete the existing name and replace it with a name of your choosing.
Keep in mind that all controls on the Form Controls menu work in the same way as the command button, in that you assign a macro to run when the control is selected.

Notice the Form Controls and ActiveX Controls shown earlier, in Figure 10-8. Although they look similar, they’re quite different. Form controls are designed specifically for use on a worksheet, and ActiveX controls are typically used on Excel UserForms. As a general rule, you should always use Form controls when working on a worksheet. Why? Form controls need less overhead, so they perform better, and configuring Form controls is far easier than configuring their ActiveX counterparts.

**Enabling and Trusting Macros**

With the release of Office 2007, Microsoft introduced significant changes to its Office security model. One of the most significant changes is the concept of trusted documents. Without getting into the technical minutia, a **trusted document** is essentially a workbook you have deemed safe by enabling macros.

**Understanding macro-enabled file extensions**

It’s important to note that Microsoft has created a separate file extension for workbooks that contain macros.

Workbooks created in Excel 2010 and later versions have the default file extension `.xlsx`. Files with the `.xlsx` extension cannot contain macros. If your workbook contains macros and you then save that workbook as an `.xlsx` file, your macros are removed automatically. Of course, Excel warns you that macro content will be disabled when saving a workbook with macros as an `.xlsx` file.

If you want to retain the macros, you must save your file as an Excel macro-enabled workbook. This gives your file an `.xlsm` extension. All workbooks with an `.xlsm` file extension are automatically known to be safe, whereas you can recognize `.xlsm` files as a potential threat.
Enabling macro content

When you open a workbook that contains macros in Excel, you get a message in the form of a yellow bar under the Ribbon stating that macros (active content) have in effect been disabled.

If you click Enable Content, it automatically becomes a trusted document. You are then no longer prompted to enable the content as long as you open that file on your computer. If you told Excel that you trust a particular workbook by enabling macros, it’s highly likely that you will enable macros every time you open it. Thus, Excel remembers that you’ve enabled macros before and inhibits any further messages about macros for that workbook.

This is great news for you and your clients. After enabling your macros just one time, they won’t be annoyed at the constant messages about macros, and you won’t have to worry that your macro-enabled dashboard will fall flat because macros have been disabled.

Setting up trusted locations

If the thought of any macro message coming up (even one time) unnerves you, you can set up a trusted location for your files. A trusted location is a directory deemed a safe zone where only trusted workbooks are placed. A trusted location allows you and your clients to run a macro-enabled workbook with no security restrictions as long as the workbook is in that location.

To set up a trusted location, follow these steps:

1. Select the Macro Security button on the Developer tab.
2. Click the Trusted Locations button.
   
   This step opens the Trusted Locations menu shown in Figure 10-10. There, you see all the directories that Excel considers trusted.

3. Click the Add New Location button.
4. Click Browse to find and specify the directory that will be considered a trusted location.
   
   After you specify a trusted location, any Excel file that’s opened from this location will have macros automatically enabled. Have your clients specify a trusted location and use your Excel files from there.
Chapter 10: Macro-Charged Dashboarding

Examining Some Macro Examples

Covering the fundamentals of building and using macros is one thing. Coming up with good ways to incorporate them into your reporting processes is another. Take a moment to review a few examples of how you can implement macros in your dashboards and reports.

Open the Chapter 10 Samples.xslm file found on this book’s companion website to follow along in the next section.

Building navigation buttons

The most common use of macros is navigation. Workbooks that have many worksheets or tabs can be frustrating to navigate. To help your audience, you can create some sort of a switchboard, like the one shown in Figure 10-11. When users click the Example 1 button, they’re taken to the Example 1 sheet.
Creating a macro to navigate to a sheet is quite simple:

1. **Start at the sheet that will become your switchboard, or starting point.**
2. **Start recording a macro.**
3. **While recording, click the destination sheet — the sheet this macro will navigate to.**
4. **After you click in the destination sheet, stop recording the macro.**
5. **Assign the macro to a button.**

   If you need help assigning a macro to a button, check out the “Running Your Macros” section, earlier in this chapter.

Excel has a built-in hyperlink feature, allowing you to convert the contents of a cell into a hyperlink that links to another location. That location can be a separate Excel workbook, a website, or even another tab in the current workbook. Although using a hyperlink may be easier than setting up a macro, you can’t apply a hyperlink to Form controls (like buttons). Instead of a button, you use text to let users know where they’ll go when they click the link.

**Dynamically rearranging pivot table data**

In the example illustrated in Figure 10-12, macros allow a user to change the perspective of the chart simply by selecting any one of the buttons shown.

Figure 10-13 reveals that the chart is actually a pivot chart tied to a pivot table. The recorded macros assigned to each button are doing nothing more than rearranging the pivot table to slice the data using various pivot fields.

Here are the high-level steps needed to create this type of setup:

1. **Create the pivot table and then add a pivot chart by clicking inside the pivot table and selecting Insert ➤ Charts ➤ Bar.**
2. **Start recording a macro.**
3. While recording, move a pivot field from one area of the pivot table to the other. When you're done, stop recording the macro.

4. Record another macro to move the data field back to its original position.

5. After both macros are set up, assign each one to a separate button.

You can fire your new macros in turn to see the pivot field dynamically move back and forth.

Offering one-touch reporting options

The two earlier macro examples demonstrate that you can record any action that you find of value. That is, if you think users would appreciate a certain feature being automated for them, why not record a macro to do so?
In Figure 10-14, notice that you can filter the pivot table for the top or bottom 20 customers. Because the steps to filter a pivot table for the top and bottom 20 have been recorded, anyone can get the benefit of this functionality without knowing how to do it themselves. Also, recording specific actions allows you to manage risk a bit. That is to say, you'll know that your users will interact with your reports in a method that has been developed and tested by you. 

This not only saves them time and effort, but also allows users who don’t know how to take these actions to benefit from them.

Figure 10-15 demonstrates how you can give your audience a quick and easy way to see the same data on different charts. Don’t laugh too quickly at the uselessness of this example. It’s not uncommon to be asked to see the same data different ways. Rather than take up real estate, just record a macro that changes the chart type. Your clients can switch views to their hearts’ content.
In This Chapter
▶ Introducing Form controls
▶ Using a Button control
▶ Using a Check Box control to toggle a chart series
▶ Using an Option Button control to filter your views
▶ Using a combo box to control multiple pivot tables
▶ Using a list box to control multiple charts

Today, business professionals increasingly want to be empowered to switch from one view of data to another with a simple list of choices. For those who build dashboards and reports, this empowerment comes with a whole new set of issues. The overarching question is — how do you handle a user who wants to see multiple views for multiple regions or markets?

Fortunately, Excel offers a handful of tools that enable you to add interactivity into your presentations. With these tools and a bit of creative data modeling, you can accomplish these goals with relative ease. In this chapter, you discover how to incorporate various controls, such as buttons, check boxes, and scroll bars, into your dashboards and reports. Also, I present you with several solutions that you can implement.

Getting Started with Form Controls

Excel offers a set of controls called Form controls, designed specifically for adding user interface elements directly onto a worksheet. After you place a Form control on a worksheet, you can then configure it to perform a specific task. Later in this chapter, I demonstrate how to apply the most useful controls to a presentation.
Finding Form controls

You can find Excel’s Form controls on the Developer tab, which is initially hidden in Excel. To enable the Developer tab, follow these steps:

1. Go to the Ribbon and click the File button.
2. In the menu that appears, click the Options button.
3. In the Excel Options dialog box that appears, click the Customize Ribbon button.
   In the list box on the right, you see all available tabs.
4. Select the check box next to the Developer tab; see Figure 11-1.
5. Click OK.

Now click the Developer tab and choose the Insert command, as shown in Figure 11-2. Here, you find two sets of controls: Form controls and ActiveX controls. Form controls are designed specifically for use on a spreadsheet, whereas ActiveX controls are typically used on Excel UserForms. Because Form controls can be configured far more easily than their ActiveX counterparts, you generally should use Form controls.

Here are the nine Form controls that you can add directly to a worksheet, as shown in Figure 11-3:

- **Button**: Executes an assigned macro when a user clicks the button.
- **Combo Box**: Gives a user an expandable list of options from which to choose.
Check Box: Provides a mechanism for a select/deselect scenario. When selected, it returns a value of True. Otherwise, it returns False.

Spin Button: Enables a user to easily increase or decrease a value by clicking the up and down arrows.

List Box: Gives a user a list of options from which to choose.

Option Button: Enables a user to toggle through two or more options, one at a time. Selecting one option automatically deselects the others.

Scroll Bar: Enables a user to scroll to a value or position using a sliding scale that can be moved by clicking and dragging the mouse.

Label: Allows you to add text labels to your worksheet. You can also assign a macro to the label, effectively using it as a button of sorts.

Group Box: Typically used for cosmetic purposes, this control serves as a container for groups of other controls.
Adding a control to a worksheet

To add a control to a worksheet, simply click the control that you require and click the approximate location where you want to place the control. You can easily move and resize the control later, just as you would a chart or shape.

After you add a control, you configure it to define its look, behavior, and utility. Each control has its own set of configuration options that allow you to customize it for your purposes. To get to these options, right-click the control and select Format Control from the menu that appears. This opens the Format Control dialog box, illustrated in Figure 11-4, with all the configuration options for that control.

Each control has its own set of tabs that allow you to customize everything from formatting to security to configuration arguments. You see different tabs based on which control you’re using, but most Form controls have the Control tab, where the meat of the configuration lies. There, you find the variables and settings that need to be defined for the control to function.

The Button and Label controls don’t have the Control tab. They have no need for one. The button simply fires whichever macro you assign it. As for the label, it’s not designed to run macro events.

Throughout the rest of this chapter, you walk through a few exercises that demonstrate how to use the most useful controls in a reporting environment. At the end of this chapter, you’ll have a solid understanding of Form controls and how they can enhance your dashboards and reports.
Using the Button Control

The Button control gives your audience a clear and easy way to execute the macros you’ve recorded. To insert and configure a Button control, follow these steps:

1. Click the Insert drop-down list under the Developer tab.
2. Select the Button Form control.
3. Click the location in your spreadsheet where you want to place the button.

   The Assign Macro dialog box appears and asks you to assign a macro to this button, as shown in Figure 11-5.

4. Edit the text shown on the button by right-clicking the button, highlighting the existing text, and then overwriting it with your own.

To assign a different macro to the button, simply right-click and select Assign Macro from the menu that appears in order to reactivate the Assign Macro dialog box. (Refer to Figure 11-5.)

When you add macros to a workbook, you have to save that workbook as an .xlsm file in order to share your macros with others. If you save the workbook as a standard .xlsx file, Excel strips your macros out of the workbook.
Using the Check Box Control

The Check Box control provides a mechanism for selecting and deselecting options. When a check box is selected, it returns a value of `True`. When it isn’t selected, `False` is returned. To add and configure a Check Box control, follow these steps:

1. Click the Insert drop-down list on the Developer tab.
2. Select the Check Box Form control.
3. Click the location in your spreadsheet where you want to place the check box.
4. After you drop the Check Box control onto your spreadsheet, right-click the control and select Format Control from the menu that appears.
5. Click the Control tab to see the configuration options shown in Figure 11-6.
6. Select the state in which the check box should open.
   The default selection (Unchecked) typically works for most scenarios, so it’s rare that you’d have to change this selection.
7. In the Cell Link box, enter the cell to which you want the check box to output its value.
   By default, a Check Box control outputs either `True` or `False`, depending on whether it’s checked. Notice in Figure 11-6 that this particular check box outputs to cell A5.
8. (Optional) You can select the 3-D Shading check box if you want the control to have a three-dimensional appearance.

9. Click OK to apply your changes.

To rename the Check Box control, right-click the control, select Edit Text from the menu that appears, and then overwrite the existing text with your own.

As Figure 11-7 illustrates, the check box outputs its value to the specified cell. If the check box is selected, a value of True is output. If the check box isn’t selected, a value of False is output.

If you’re having a hard time figuring out how this could be useful, take a stab at the exercise in the following section, which illustrates how you can use a check box to toggle a chart series on and off.

**Toggling a Chart Series On and Off**

Figure 11-8 shows the same chart twice. Notice that the top chart contains only one series, with a check box offering to show 2011 trend data. The bottom chart shows the same chart with the check box selected. The on/off nature of the Check Box control is ideal for interactivity that calls for a visible/not visible state.

To download the Chapter 11Samples.xlsx file, go to this book’s companion website.

You start with the raw data (in Chapter 11Samples.xlsx) that contains both 2011 and 2012 data; see Figure 11-9. The first column has a cell in which the Check Box control will output its value (cell A12 in this example). This cell will contain either True or False.

Next, create the analysis layer (staging table) that consists of all formulas, as shown in Figure 11-10. The chart actually reads from this data, not the raw data. This way, you can control what the chart sees.
Part IV: Advanced Reporting Techniques

Figure 11-8: A check box can help create the disappearing data series effect.

Figure 11-9: Start with raw data and a cell in which a Check Box control can output its value.

Figure 11-10: Create a staging table that will feed the chart. The values of this data are all formulas.
As you can see in Figure 11-10, the formulas for the 2012 row simply reference the cells in the raw data for each respective month. You do that because you want the 2012 data to appear at all times.

For the 2011 row, test the value of cell A12 (the cell that contains the output from the check box). If A12 reads True, you reference the respective 2011 cell in the raw data. If A12 doesn’t read True, the formula uses Excel’s NA() function to return an #N/A error. Excel charts can’t read a cell with the #N/A error. Therefore, they simply don’t show the data series for any cell that contains #N/A. This is ideal when you don’t want a data series to be shown at all.

Notice that the formula shown in Figure 11-10 uses an absolute reference with cell A12 — that is, the reference to cell A12 in the formula is prefixed with a $ sign ($A12). This ensures that the column references in the formulas don’t shift when they’re copied across.

Figure 11-11 illustrates the two scenarios in action in the staging tables. In the scenario shown at the bottom of Figure 11-11, cell A12 is True, so the staging table actually brings in 2011 data. In the scenario shown at the top of Figure 11-11, cell A12 is False, so the staging table returns #N/A for 2011.

Finally, create the chart that you saw earlier in this section (refer to Figure 11-8) using the staging table. Keep in mind that you can scale this to as many series as you like.
You can apply this technique to as many check boxes as you need. For instance, Figure 11-12 illustrates a chart that has multiple series whose visibility is controlled by Check Box controls. This allows you to make all but two series invisible so that you can compare those two series unhindered. Then you can make another two visible, comparing those.

Figure 11-12: You can use check boxes to control how much data is shown in your chart at one time.

Using the Option Button Control

Option buttons allow users to toggle through several options one at a time. The idea is to have two or more option buttons in a group. Then selecting one option button automatically deselects the others. To add option buttons to your worksheet, follow these steps:

1. Click the Insert drop-down list under the Developer tab.
2. Select the Option Button Form control.
3. Click the location in your spreadsheet where you want to place the option button.
4. After you drop the control onto your spreadsheet, right-click the control and select Format Control from the menu that appears.
5. Click the Control tab to see the configuration options shown in Figure 11-13.
6. Select the state in which the option button should open.

The default selection (Unchecked) typically works for most scenarios, so it's rare that you'd have to change this selection.
7. In the Cell Link box, enter the cell to which you want the option button to output its value.

By default, an Option Button control outputs a number that corresponds to the order it was put on the worksheet. For instance, the first option button you place on the worksheet outputs a number 1, the second outputs a number 2, the third outputs a number 3, and so on. Notice in Figure 11-13 that this particular control outputs to cell A1.

8. (Optional) You can select the 3-D Shading check box if you want the control to have a three-dimensional appearance.

9. Click OK to apply these changes.

10. To add another option button, simply copy the button you created and paste as many option buttons as you need.

The nice thing about copying and pasting is that all the configurations you made to the original persist in all copies.

To give your option button a meaningful label, right-click the control, select Edit Text from the menu that appears, and then overwrite the existing text with your own.

---

**Showing Many Views through One Chart**

One of the ways you can use option buttons is to feed a single chart with different data, based on the option selected. Figure 11-14 illustrates an example. When each category is selected, the single chart is updated to show the data for that selection.
Now, you could create three separate charts and show them all on your dashboard at the same time. However, using option buttons as an alternative saves valuable real estate by not having to show three separate charts. Plus it’s much easier to troubleshoot, format, and maintain one chart than three.

To create this example, start with three raw datasets — as shown in Figure 11-15 — that contain three categories of data: Income, Expense, and Net. Near the raw data, reserve a cell where the option buttons output their values (cell A8, in this example). This cell contains the ID of the option selected: 1, 2, or 3.

You then create the analysis layer (the staging table) that consists of all formulas, as shown in Figure 11-16. The chart reads from this staging table, allowing you to control what the chart sees. The first cell of the staging table contains the following formula:

=IF(A$8=1, B9, IF(A$8=2, B13, B17))
Chapter 11: Giving Users an Interactive Interface

This formula tells Excel to check the value of cell A8 (the cell where the option buttons output their values). If the value of cell A8 is 1, which represents the value of the Income option, the formula returns the value in the Income dataset (cell B9). If the value of cell A8 is 2, which represents the value of the Expense option, the formula returns the value in the Expense dataset (cell B13). If the value of cell A8 is not 1 or 2, the value in cell B17 is returned.

Notice that the formula shown in Figure 11-16 uses absolute references with cell A8. That is, the reference to cell A8 in the formula is prefixed with dollar ($) signs (\$A\$8). This ensures that the cell references in the formulas don’t shift when they’re copied down and across.

To test that the formula is working fine, you could change the value of cell A8 manually, from 1 to 3. When the formula works, you simply copy the formula across and down to fill the rest of the staging table.

When the setup is created, all that’s left to do is create the chart using the staging table. Again, the major benefits you get from this type of setup are that you can

- Make any formatting changes to one chart and then easily add another dataset by adding another option button.
- Edit your formulas easily.
Using the Combo Box Control

The Combo Box control allows users to select from a drop-down list of pre-defined options. When an item from the Combo Box control is selected, an action is taken with that selection. To add a combo box to your worksheet, follow these steps:

1. Click the Insert drop-down list under the Developer tab.
2. Select the Combo Box Form control.
3. Click the location in your spreadsheet where you want to place the combo box.
4. After you drop the control onto your spreadsheet, right-click the control and select Format Control from the menu that appears.
5. Click the Control tab to see the configuration options shown in Figure 11-17.

![Figure 11-17: Formatting the Combo Box control.]

6. In the Input Range setting, identify the range that holds the pre-defined items you want to present as choices in the combo box.
7. In the Cell Link box, enter the cell to which you want the combo box to output its value.

A Combo Box control outputs the index number of the selected item. This means that if the second item on the list is selected, the number 2 will be output. If the fifth item on the list is selected, the number 5 will be output. Notice in Figure 11-17 that this particular control outputs to cell E15.
8. In the Drop Down Lines box, enter the number of items you want shown at one time.

You see in Figure 11-17 that this control is formatted to show 12 items at one time. When users expand the combo box, they’ll see 12 items.

9. (Optional) You can select the 3-D Shading check box if you want the control to have a three-dimensional appearance.

10. Click OK to apply your changes.

Changing Chart Data with a Drop-Down Selector

You can use Combo Box controls to give your users an intuitive way to select data via a drop-down selector. Figure 11-18 shows a thermometer chart that’s controlled by the combo box above it. When a user selects the Southwest region, the chart responds by plotting the data for the selected region.

To create this example, start with the raw dataset shown in Figure 11-19. This dataset contains the data for each region. Near the raw data, reserve a cell where the combo box will output its value (cell M7, in this example). This cell will catch the index number of the combo box entry selected.
You then create the analysis layer (the staging table) that consists of all formulas, as shown in Figure 11-20. The chart reads from this staging table, allowing you to control what the chart sees. The first cell of the staging table contains the following INDEX formula:

\[ =\text{INDEX}(P7:P14, M7) \]

The INDEX function converts an index number to a value that can be recognized. An INDEX function requires two arguments to work properly. The first argument is the range of the list you’re working with. The second argument is the index number.

In this example, you’re using the index number from the combo box (in cell M7) and extracting the value from the appropriate range (2012 data in P7:P14). Again, notice the use of the absolute dollar signs ($). This ensures that the cell references in the formulas don’t shift when they’re copied down and across.
Take another look at Figure 11-20 to see what’s happening. The **INDEX** formula in cell P2 points to the range that contains the 2012 data. It then captures the index number in cell M7 (which traps the output value of the combo box). The index number happens to be 7. So the formula in cell P2 will extract the seventh value from the 2012 data range (in this case, Southwest).

When you copy the formula across, Excel adjusts the formula to extract the seventh value from each year’s data range.

After your **INDEX** formulas are in place, you have a clean staging table that you can use to create your chart; see Figure 11-21.

![Figure 11-21: Create a chart using this clean staging table.](image)

### Using the List Box Control

The List Box control allows users to select from a list of predefined choices. When an item from the List Box control is selected, an action is taken with that selection. To add a list box to your worksheet, follow these steps:

1. Select the Insert drop-down list under the Developer tab.
2. Select the List Box Form control.
3. Click the location in your spreadsheet where you want to place the list box.
4. After you drop the control onto your worksheet, right-click the control and select Format Control from the menu that appears.
5. Click the Control tab to see the configuration options shown in Figure 11-22.
6. In the Input Range setting, identify the range that holds the predefined items you want to present as choices in the list box.

As you can see in Figure 11-22, this list box is filled with region selections.

7. In the Cell Link box, enter the cell where you want the list box to output its value.

By default, a List Box control outputs the index number of the selected item. This means that if the second item on the list is selected, the number 2 will be output. If the fifth item on the list is selected, the number 5 will be output. Notice in Figure 11-22 that this particular control outputs to cell P2. The Selection Type setting allows users to choose more than one selection in the list box. The choices here are Single, Multi, and Extend.

Always leave this setting on Single because Multi and Extend work only in the VBA environment.

8. (Optional) You can select the 3-D Shading check box if you want the control to have a three-dimensional appearance.

9. Click OK to apply your changes.

Controlling Multiple Charts with One Selector

One of the more useful ways to use a list box is to control multiple charts with one selector. Figure 11-23 illustrates an example of this. As a region selection is made in the list box, all three charts are fed the data for that region, adjusting the charts to correspond with the selection made. Happily, all this is done without VBA code; all it takes is a handful of formulas and a list box.
Chapter 11: Giving Users an Interactive Interface

To create this example, start with three raw datasets — as shown in Figure 11-24 — that contain three categories of data: Revenues, Net Income %, and Gross Margin. Each dataset contains a separate line for each region, including one for All Regions.

You then add a list box that outputs the index number of the selected item to cell P2; see Figure 11-25.

Next, create a staging table that consists of all formulas. In this staging table, you use the Excel’s \texttt{CHOOSE} function to select the correct value from the raw data tables based on the selected region.
In Excel, the `CHOOSE` function returns a value from a specified list of values based on a specified position number. For instance, the formula `CHOOSE(3,"Red", "Yellow", "Green", "Blue")` returns Green because Green is the third item in the list of values. The formula `CHOOSE(1, "Red", "Yellow", "Green", "Blue")` returns Red. See Chapter 2 to get a detailed look at the `CHOOSE` function.

As you can see in Figure 11-26, the `CHOOSE` formula retrieves the target position number from cell P2 (the cell where the list box outputs the index number of the selected item) and then matches that position number to the list of cell references given. The cell references come directly from the raw data table.

In the example shown in Figure 11-26, the data that will be returned with this `CHOOSE` formula is 41767. Why? Because cell P2 contains the number 3, and the third cell reference within the `CHOOSE` formula is cell B9 — the cell containing January revenues for the North region.
Chapter 11: Giving Users an Interactive Interface

You enter the same type of `CHOOSE` formula into the Jan column and then copy it across; see Figure 11-27.

![Figure 11-27: Create similar `CHOOSE` formulas for each row/category of data, and then copy the `CHOOSE` formulas across months.]

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
</table>

To test that your formulas are working, change the value of cell P2 manually by entering 1, 2, 3, 4, or 5. When the formulas work, all that’s left to do is create the charts using the staging table.

If Excel functions such as `CHOOSE` or `INDEX` are a bit intimidating for you, don’t worry. You can use various combinations of Form controls and Excel functions in literally hundreds of ways to achieve interactive reporting. The examples I give in this chapter are designed to give you a sense of how you can incorporate Form controls into your dashboards and reports. There are no set rules on which Form controls or Excel functions you need to use in your model.

Start with basic improvements to your dashboard, using controls and formulas you’re comfortable with. Then gradually try to introduce some of the more complex controls and functions. With a little imagination and creativity, you can take the basics in this chapter and customize your own dynamic dashboards.
Adding Interactivity with Pivot Slicers

In This Chapter
▶ Understanding slicers
▶ Creating and formatting standard slicers
▶ Using Timeline slicers
▶ Using slicers as command buttons

Slicers allow you to filter your pivot table in a way that’s similar to the way Filter fields filter a pivot table. The difference is that slicers offer a user-friendly interface, enabling you to better manage the filter state of your pivot table reports. Happily, Microsoft has added another dimension to slicers with the introduction of Timeline slicers. Timeline slicers are designed to work specifically with date-based filtering.

In this chapter, you explore slicers and their potential to add an attractive and interactive user interface to your dashboards and reports.

Understanding Slicers

If you’ve worked your way through Chapter 6, you know that pivot tables allow for interactive filtering using Filter fields. Filter fields are the drop-down lists you can include at the top of a pivot table, allowing users to interactively filter for specific data items. As useful as Filter fields are, they have always had a couple of drawbacks.

First of all, Filter fields are not cascading filters — the filters don’t work together to limit selections when needed. Take, for example, Figure 12-1. You can see that the Region filter is set to the North region. However, the Market filter still allows you to select markets that are clearly not in the North region.
(California, for example). Because the Market filter is not in any way limited based on the Region Filter field, you have the annoying possibility of selecting a market that could yield no data because it’s not in the North region.

Another drawback is that Filter fields don’t provide an easy way to tell what exactly is being filtered when you select multiple items. In Figure 12-2, you can see an example of this. The Region filter has been limited to three regions: Midwest, North, and Northeast. However, notice that the Region filter value shows (Multiple Items). By default, Filter fields show (Multiple Items) when you select more than one item. The only way to tell what has been selected is to click the drop-down menu. You can imagine the confusion on a printed version of this report, in which you can’t click down to see which data items make up the numbers on the page.

By contrast, slicers don’t have these issues. Slicers respond to one another. As you can see in Figure 12-3, the Market slicer visibly highlights the relevant markets when the North region is selected. The rest of the markets are muted, signaling that they are not part of the North region.

When selecting multiple items in a slicer, you can easily see that multiple items have been chosen. In Figure 12-4, you can see that the pivot table is being filtered by the Midwest, North, and Northeast regions. No more (Multiple Items).
Chapter 12: Adding Interactivity with Pivot Slicers

Figure 12-2: Filter fields show the text (Multiple Items) when multiple selections are made.

Figure 12-3: Slicers work together to show you relevant data items based on your selection.

Figure 12-4: Slicers do a better job of displaying multiple item selections.
Creating a Standard Slicer

Enough talk. It’s time to create your first slicer. Just follow these steps:

1. Place the cursor anywhere inside the pivot table.
   Doing so activates the PivotTable Tools contextual tabs on the Ribbon.
2. Click the Analyze tab and then click the Insert Slicer icon, as shown in Figure 12-5.

![Figure 12-5: Inserting a slicer.](image)

This step activates the Insert Slicers dialog box, shown in Figure 12-6.

![Figure 12-6: Select the dimensions for which you want slicers created.](image)
3. Using the Insert Slicers dialog box, select the dimensions you want to filter.

In this example, the Region and Market slicers are created.

4. After the slicers are created, simply click the filter values to filter the pivot table.

As you can see in Figure 12-7, not only does clicking Midwest in the Region slicer filter your pivot table, but the Market slicer also responds by highlighting the markets that belong to the Midwest region.

You can also select multiple values by holding down the Ctrl key on the keyboard while selecting the needed filters. In Figure 12-8, I held down the Ctrl key while selecting Baltimore, California, Charlotte, and Chicago. This highlights not only the selected markets in the Market slicer, but also their associated regions in the Region slicer.
To clear the filtering on a slicer, simply click the Clear Filter icon on the target slicer, as shown in Figure 12-9.

Getting Fancy with Slicer Customizations

If you’re going to use slicers on a dashboard, you should do a bit of formatting to have your slicers match the theme and layout of your dashboard. The following sections cover a few formatting adjustments you can make to your slicers.

**Size and placement**

A slicer behaves like a standard Excel shape object in that you can move it around and adjust its size by clicking it and dragging its position points; see Figure 12-10.
You can also right-click the slicer and select Size and Properties from the menu that appears. This brings up the Format Slicer pane, illustrated in Figure 12-11, allowing you to adjust the size of the slicer, how the slicer should behave when cells are shifted, and whether the slicer should appear on a printed copy of your dashboard.

**Data item columns**

By default, all slicers are created with one column of data items. You can change this by right-clicking the slicer and selecting Size and Properties from the menu that appears. This brings up the Format Slicer pane. Under the Position and Layout section, you can specify the number of columns in the slicer. Adjusting the number to 2, as demonstrated in Figure 12-12, forces the data items to be displayed in two columns, adjusting the number to 3 forces the data items to be displayed in three columns, and so on.
Other slicer settings

Right-clicking your slicer and selecting Slicer Settings from the menu that appears activates the Slicer Settings dialog box, shown in Figure 12-13. With this dialog box, you can control the look of the slicer's header, how the items in your slicer are sorted, and how filtered items are handled.

Creating your own slicer style

The default slicer styles are, let's face it, a bit of a drag. Oftentimes, the look and feel of slicers don’t match the aesthetic of your dashboard. Luckily, Excel provides a way for you to customize your slicers to fit into any reporting theme. With minimal effort, your slicers can be integrated nicely into your dashboard layout.

Figure 12-14 illustrates a few examples of how slicers can be customized to almost any style you can think of.

To change the look and feel of your slicer, you have to get into some style customizations. The following steps show you how:

1. Click the slicer to reveal the Slicer Tools Options tab on the Ribbon and then expand the tab’s Slicer Styles gallery.
2. Click the New Slicer Style button at the bottom of the gallery, as shown in Figure 12-15.

   Doing so brings up the New Slicer Style dialog box, shown in Figure 12-16.
3. Using the New Slicer Style dialog box, customize any (or all) of the following slicer elements:
   - Whole Slicer
   - Header
   - Selected Item with Data
   - Selected Item with no Data
   - Unselected Item with Data
The idea here is to select each slicer element and then format that element by clicking the format button. Sound easy enough, but it can be a bit difficult to know exactly which part of the slicer you are formatting.

Whole Slicer and Header are fairly self-explanatory, but what does the other junk mean?

Well, the other options refer to the values within the slicer. Some values have data associated with them, and others do not. The elements that are listed let you define what each value (values “with Data” and values “with no Data”) look like when selected, unselected, and hovered over. Figure 12-17 offers a visual map to help understand how each kind of value is typically represented in the slicer.

After you finish making the needed customizations to all the elements, you can apply your newly created style by clicking the slicer and then selecting your custom style in the Slicer Styles Gallery.

You can also right-click on your custom style to modify, duplicate, and delete it (see Figure 12-18), using the contextual menu that appears.
Chapter 12: Adding Interactivity with Pivot Slicers

Custom styles are saved at the workbook level, so your custom style is saved and travels with your workbook. However, other workbooks will not have your styles included.

**Controlling Multiple Pivot Tables with One Slicer**

Another advantage you gain with slicers is that each slicer can be tied to more than one pivot table; that is to say, any filter you apply to your slicer can be applied to multiple pivot tables.
To connect your slicer to more than one pivot table, simply right-click the slicer and select Report Connections from the menu that appears. This activates the Report Connections dialog box, shown in Figure 12-19. Place a check next to any pivot table that you want to filter using the current slicer.

![Report Connections](image)

Figure 12-19: Choose the pivot tables that will be filtered by this slicer.

At this point, any filter you apply to your slicer will be applied to all connected pivot tables. Controlling the filter state of multiple pivot tables is a powerful feature, especially in dashboards that run on multiple pivot tables.

**Creating a Timeline Slicer**

The Timeline slicer works in the same way a standard slicer does, in that it lets you filter a pivot table using a visual selection mechanism instead of the old Filter fields. The difference is the Timeline slicer is designed to work exclusively with date fields, providing an excellent visual method to filter and group the dates in your pivot table.

To create a Timeline slicer, your pivot table must contain a field where all data is formatted as a date. It’s not enough to have a column of data that contains a few dates. All values in the date field must be a valid date and formatted as such.

To create a Timeline slicer, follow these steps:

1. Place the cursor anywhere inside the pivot table and then click the Analyze tab on the Ribbon.
2. Click the tab’s Insert Timeline command, shown in Figure 12-20.
   
   The Insert Timelines dialog box shown in Figure 12-21 appears, showing you all available date fields in the chosen pivot table.
3. In the Insert Timelines dialog box, select the date fields for which you want to create the timeline.
After your Timeline slicer is created, you can filter the data in the pivot table and pivot chart using this dynamic data selection mechanism. Figure 12-22 demonstrates how selecting Mar, Apr, and May in the Timeline slicer automatically filters the pivot chart.

Figure 12-23 illustrates how you can expand the slicer range with the mouse to include a wider range of dates in your filtered numbers.

Want to quickly filter your pivot table by quarters? Well, that’s easy with a Timeline slicer. Simply click the time period drop-down menu and select Quarters. As you can see in Figure 12-24, you can also switch to Years or Days, if needed.

Timeline slicers are not *backward compatible*: They are usable only in Excel 2013 and Excel 2016. If you open a workbook with Timeline slicers in Excel 2010 or previous versions, the Timeline slicers will be disabled.
Figure 12-22: Click a date selection to filter your pivot table or pivot chart.

Figure 12-23: You can expand the range on the Timeline slicer to include more data in the filtered numbers.
Chapter 12: Adding Interactivity with Pivot Slicers

Using Slicers as Form Controls

In Chapter 11, you see how to add interactivity to a dashboard using data modeling techniques and Form controls. Although the techniques in that chapter are powerful, the one drawback is that Excel Form controls are starting to look a bit dated, especially when paired with the modern-looking charts that come with Excel 2016.

One clever way to alleviate this problem is to hijack the Slicer feature for use as a proxy Form control of sorts. Figure 12-25 demonstrates this with a chart that responds to the slicer on the left. When you click the Income selection, the chart fills with income data. When you click Expense, the chart fills with expense data. Keep in mind that the chart itself is in no way connected to a pivot table.
To build this basic model, follow these steps:

1. Create a simple table that holds the names you want for your controls, along with some index numbering.

   In this case, the table should contain three rows under a field called Metric. Each row should contain a metric name and an index number for each metric (Income, Expense, and Net).

2. Create a pivot table using that simple table, as illustrated in Figure 12-26.

![Figure 12-26: Create a simple table that holds the names you want for your controls, along with some index numbering. After you have that, create a pivot table from it.](image)

3. Place the cursor anywhere inside your newly created pivot table, click the Analyze tab, and then click the Insert Slicer icon.

4. In the Insert Slicers dialog box that appears, create a slicer for the Metric field.

   At this point, you have a slicer with the three metric names.

5. Right-click the slicer and choose Slicer Settings from the menu that appears, in order to activate the Slicer Settings dialog box.

6. In the Slicer Settings dialog box, deselect the Display Header check box, shown in Figure 12-27.
Chapter 12: Adding Interactivity with Pivot Slicers

Each time you click the Metric slicer, the associated pivot table is filtered to show only the selected metric. Figure 12-28 demonstrates that this also filters the index number for that metric. The filtered index number will always show up in the same cell (N8, in this case). So this cell can now be used as a trigger cell for VLOOKUP formulas, index formulas, IF statements, and so on.

7. Use the slicer-fed trigger cell (N8) to drive the formulas in your staging area, as demonstrated in Figure 12-29.

This formula tells Excel to check the value of cell N8. If the value of cell N8 is 1, which represents the value of the Income option, the formula returns the value in the Income dataset (cell G9). If the value of cell N8 is 2, which represents the value of the Expense option, the formula returns the value in the Expense dataset (cell G13). If the value of cell N8 is not 1 or 2, the value in cell G17 is returned.
8. Copy the formula down and across to build out the full staging table; see Figure 12-30.

9. The final step is to simply create a chart using the staging table as the source.

With this simple technique, you can provide your customers with an attractive interactive menu that more effectively adheres to the look and feel of their dashboards.
Part V

Working with the Outside World

See a demonstration of OneDrive at www.dummies.com/extras/exceldashboardsreports and find out how you can leverage the Microsoft Office Web platform to share your reports over the web.
In this part . . .

- Gain an understanding of some of the ways to incorporate data that does not originate in Excel.
- Discover how to import data from external sources, such as Microsoft Access and SQL Server.
- Dive into Power Query to automate the data transformation processes.
- Understand the various methods for protecting your dashboards and reports before distributing.
- Explore the different ways to distribute and present your work in a safe and effective way.
Chapter 13
Using External Data for Your Dashboards and Reports

In This Chapter
▶ Importing from Microsoft Access
▶ Importing from SQL Server
▶ Leveraging Power Query to get external data

Wouldn’t it be wonderful if all the data you come across could be neatly packed into one easy-to-use Excel table? The reality is that sometimes the data you need comes from external data sources. External data is exactly what it sounds like: data that isn’t located in the Excel workbook in which you’re operating. Some examples of external data sources are text files, Access tables, SQL Server tables, and even other Excel workbooks.

This chapter explores some efficient ways to get external data into your Excel data models. Before jumping in, however, this humble author wants to throw out one disclaimer: There are numerous ways to get data into Excel. In fact, between the functionality found in the user interface and the VBA/code techniques, Excel has too many techniques to focus on in one chapter. Instead, then, in this chapter I focus on a handful of techniques that can be implemented in most situations and don’t come with a lot of pitfalls and gotchas.

Importing Data from Microsoft Access

Microsoft Access is used in many organizations to manage a series of tables that interact with each other, such as a Customers table, an Orders table, and an Invoices table. Managing data in Access provides the benefit of a relational database in which you can ensure data integrity, prevent redundancy, and easily generate datasets via queries.

Excel offers several methods for getting your Access data into your Excel data model.
The drag-and-drop method

For simplicity, you just can’t beat the drag-and-drop method. You can simultaneously open an empty Excel workbook and an Access database from which you want to import a table or query. When both are open, resize each application’s window so that they’re both fully visible on your screen.

Hover the mouse pointer over the Access table or query you want to copy into Excel. Now click the table and drag it to the blank worksheet in Excel, as illustrated in Figure 13-1.

The drag-and-drop method comes in handy when you’re doing a quick one-time analysis in which you need a specific set of data in Excel. However, the method isn’t so useful under the following conditions:

- You expect this step to occur routinely, as part of a repeated analysis or report.
- You expect the users of your Excel presentation to get or update the data via this method.
- It’s not possible or convenient for you to simply open up Access every time you need the information.

In these scenarios, it’s much better to use another technique.
Chapter 13: Using External Data for Your Dashboards and Reports

The Microsoft Access Export wizard

Access has an Export wizard, and it’s relatively simple to use. Just follow these steps:

1. With your Access database open, click your target table or query to select it.
2. On the External Data tab on the Ribbon, select the Excel icon under the Export group.

The wizard that you see in Figure 13-2 opens.

As you can see in Figure 13-2, you can specify certain options in the Excel Export wizard. You can specify the file location, the file type, and some format preservation options.

3. In the Excel Export Wizard, select Export Data with Formatting and Layout and then select Open the Destination File After the Export Operation is Complete.
4. Click OK.

Excel opens to show you the exported data.
In Access, the last page in the Export wizard, shown in Figure 13-3, asks whether you want to save your export steps. Saving your export steps can be useful if you expect to frequently send that particular query or table to Excel. The benefit to this method is that unlike dragging and dropping, the ability to save export steps allows you to automate your exports by using Access macros.

You may export your Access table or query to an existing Excel file instead of creating a new file. But note that the name of the exported object will be the name of the table or query in Access. Be careful if you have an Excel object with that same name in your workbook, because it may be overwritten. For example, exporting an Access table named PriceMaster to an Excel worksheet that already has a worksheet named PriceMaster causes the original Excel PriceMaster worksheet to be overwritten. Also, make sure the workbook to which you’re exporting is closed. If you try to export to an open workbook, you’ll likely receive an error in Access.

**The Get External Data icon**

The option to pull data from Access has been available in Excel for many versions; it was just buried several layers deep in somewhat cryptic menu titles. This made getting Access data into Excel seem like a mysterious and tenuous
Chapter 13: Using External Data for Your Dashboards and Reports

proposition for many Excel analysts. With the introduction of the Ribbon in Excel 2007, Microsoft put the Get External Data group of commands right on the Ribbon under the Data tab, making it easier to import data from Access and other external data sources.

Excel allows you to establish an updatable data connection between Excel and Access. To see the power of this technique, walk through these steps:

1. **Open a new Excel workbook and click the Data tab on the Ribbon.**
2. **In the Get External Data group, select the From Access icon.**
   - The Select Data Source dialog box opens. If the database from which you want to import data is local, browse to the file’s location and select it. If your target Access database resides on a network drive at another location, you need the proper authorization to select it.
3. **Navigate to the sample database and click Open, as shown in Figure 13-4.**
   - In some environments, a series of Data Link Properties dialog boxes opens, asking for credentials (that is, username and password). Most Access databases don’t require logon credentials, but if your database does require a username and password, type them in the Data Link Properties dialog box.

4. **Click OK.**
   - The Select Table dialog box shown in Figure 13-5 opens. This dialog box lists all available tables and queries in the selected database.
The Select Table dialog box contains a column called Type. There are two types of Access objects you can work with: views and tables. VIEW indicates that the dataset listed is an Access query, and TABLE indicates that the dataset is an Access table. In this example, Sales_By_Employee is actually an Access query. This means that you import the results of the query. This is true interaction at work; Access does all the back-end data management and aggregation, and Excel handles the analysis and presentation!

5. Using the Select Table dialog box, select your target table or query and then click OK.

The Import Data dialog box shown in Figure 13-6 opens. There, you define where and how to import the table. You have the option to import the data into a Table, a PivotTable Report, a PivotChart, or a Power View Report. You also have the option to create only the connection, making the connection available for later use.

Note that if you choose PivotChart or PivotTable Report, the data is saved to a pivot cache without writing the actual data to the worksheet. Thus, the pivot table can function as normal without your having to import potentially hundreds of thousands of data rows twice (once for the pivot cache and once for the spreadsheet).

6. Select Table as the output view and define cell A1 as the output location. Refer to Figure 13-6.

7. Click OK.

The reward for all your work is a table similar to the one shown in Figure 13-7, which contains the imported data from your Access database.
Chapter 13: Using External Data for Your Dashboards and Reports

The incredibly powerful thing about importing data this way is that it’s refreshable. That’s right: If you import data from Access using this technique, Excel creates a table that you can update by right-clicking it and selecting Refresh from the pop-up menu, as shown in Figure 13-8. When you update your imported data, Excel reconnects to your Access database and imports the data again. As long as a connection to your database is available, you can refresh with a mere click of the mouse.

Again, a major advantage to using the Get External Data group is that you can establish a refreshable data connection between Excel and Access. In most cases, you can set up the connection one time and then just update the data connection when needed. You can even record an Excel macro to update the data on some trigger or event, which is ideal for automating the transfer of data from Access.
Managing external data properties

When you import external data into a table, you can control a few adjustable properties via the Properties dialog box. You can get to the properties of a particular external data table by clicking the target table and then clicking the Properties icon under the Data tab.

This activates the External Data Properties dialog box. The properties found in this dialog box allow you to further customize your query tables to suit your needs. Take a moment to familiarize yourself with some of the more useful options in this dialog box.

- **Include Row Numbers**: This property is deselected by default. Selecting this property creates a dummy column that contains row numbers. The first column of your data set will be this row number column upon refresh.

- **Adjust Column Width**: This property is selected by default, telling Excel to adjust the column widths every time the data is refreshed. Deselecting this option causes the column widths to remain the same.

- **Preserve Column/Sort/Filter/Layout**: If this property is selected, the order of the columns and rows of the Excel range remains unchanged. This way, you can rearrange and sort the columns and rows of the external data in your worksheet without worrying about blowing away your formatting every time you refresh. Deselecting this property makes the Excel range look like the query.

- **Preserve Cell Formatting**: This property is selected by default, telling Excel to keep the applied cell formatting when you refresh.

- **Insert Cells for New Data, Delete Unused Cells**: This is the default setting for data range changes. This option inserts cells (not rows) when the imported table grows and deletes cells (not rows) when it shrinks.

- **Insert Entire Rows for New Data, Clear Unused Cells**: This option inserts whole rows when the imported table grows and clears cells (not deletes rows) when it shrinks.

- **Overwrite Cells for New Data, Clear Unused Cells**: This option overwrites cells when the imported table grows and clears cells (not delete rows) when it shrinks.
Importing Data from SQL Server

In the spirit of collaboration, Excel vastly improves your ability to connect to transactional databases such as SQL Server. With the connection functionality found in Excel, creating a connected table or pivot table from SQL Server data is as easy as ever.

Start on the Data tab and follow these steps:

1. Click the From Other Sources icon to see the drop-down menu shown in Figure 13-9; then select From SQL Server.

   Selecting this option activates the Data Connection Wizard, as shown in Figure 13-10. There, you configure the connection settings so that Excel can establish a link to the server.

2. Provide Excel with some authentication information.

   Enter the name of your server as well as your username and password; see Figure 13-10. If you’re typically authenticated via Windows authentication, however, simply select the Use Windows Authentication option.
3. Select the database with which you’re working from a drop-down menu containing all available databases on the specified server.

As you can see in Figure 13-11, a database called AdventureWorks2012 is selected in the drop-down box. All the tables and views in this database are shown in the list of objects below the drop-down menu.

4. Choose the table or view you want to analyze and then click Next.

5. On the screen that appears in the wizard, enter descriptive information about the connection you’ve just created. (See Figure 13-12 for an example.)

This information is optional. If you bypass this screen without editing anything, your connection will work fine.

The fields that you use most often in this particular screen are

- **File Name**: In the File Name input box, you can change the filename of the ODC (Office Data Connection) file generated to store the configuration information for the link you just created.

- **Save Password in File**: Under the File Name input box, you have the option of saving the password for your external data in the file itself (via the Save Password in File check box). Selecting this check box actually enters your password in the file. This password is not encrypted, so anyone interested enough could potentially get the password for your data source by simply viewing the file with a text editor.

- **Description**: In the Description field, you can enter a plain description of what this particular data connection does.
• **Friendly Name:** The Friendly Name field allows you to specify a name of your own choosing for the external source. You typically enter a name that is descriptive and easy to read.

6. When you are satisfied with your descriptive edits, click Finish to finalize your connection settings.

You immediately see the Import Data dialog box, where you can choose how to import data. As you can see in Figure 13-13, this data will be shown in a pivot table.

When the connection is finalized, you can start building your pivot table.
Leveraging Power Query to Extract and Transform Data

Every day, millions of Excel users manually pull data from some source location, manipulate that data, and integrate it into their pivot table reporting.

This process of extracting, manipulating, and integrating data is called ETL. ETL refers to the three separate functions typically required in order to integrate disparate data sources: extract, transform, and load.

The extraction function involves reading data from a specified source and extracting a desired subset of data.

The transformation function involves cleaning, shaping, and aggregating data to convert it to the desired structure.

The loading function involves actually importing or using the resulting data.

In an attempt to empower Excel analysts to develop robust and reusable ETL processes, Microsoft created Power Query. Power Query enhances the ETL experience by offering an intuitive mechanism to extract data from a wide variety of sources, perform complex transformations on that data, and then load the data into a workbook or the internal Data Model.

In this section, you see how Power Query works and how you can use it to help save time and automate the steps for importing data into your reporting models.

Power Query is legitimately a part of Excel 2016

You may have previously installed the Power Query as an add-in when you were working with Excel 2010 or Excel 2013. However, Power Query is not an add-in Excel 2016. Starting with Excel 2016, Power Query is a native feature of Excel, just like charts and pivot tables are native features. Microsoft still offers the Power Query add-in for previous versions of Excel. Simply enter the search term Excel Power Query Add-in into your favorite search engine to find the free Excel 2010 and 2013 installation packages. But again, don’t expect to find an Excel 2016 version of the Power Query add-in, because it’s already built into Excel.
Reviewing Power Query basics

Although Power Query is relatively intuitive, it’s worth taking the time to walk through a basic scenario to understand its high-level features. To start this basic look at Power Query, pretend that your job entails creating reports that show trending for Microsoft stock prices. As a part of your job, you frequently need to pull stock data from the web.

Follow these steps to start a query to pull the needed stock data from Yahoo! Finance:

1. Select the New Query command on the Data tab and then select From Other Sources ➪ From Web, as shown in Figure 13-14.

Excel has another From Web command button on the Data tab under the Get External Data group. This unfortunate duplicate command is actually the legacy web-scraping capability found in all Excel versions going back to Excel 2000. The Power Query version of the From Web command (found under New Query ➪ From Other Sources ➪ From Web) goes beyond simple web scraping. Power Query is able to pull data from advanced web pages and is able to manipulate the data. Make sure you are using the correct feature when pulling data from the web.

2. In the dialog box that appears (see Figure 13-15), enter the URL for the data you need (in this case, http://finance.yahoo.com/q/hp?s=MSFT).

After a bit of gyrating, the Navigator pane shown in Figure 13-16 appears.
3. **Using the Navigator pane, select the data source you want extracted.**

   You can click each table to see a preview of the data. In this case, Table 4 holds the historical stock data you need, so click Table 4 and then click the Edit button.

   ![Figure 13-15: Enter the target URL containing the data you need.](image)

   ![Figure 13-16: Select the correct data source and then click the Edit button.](image)

   When you click the Edit button, Power Query activates a new Query Editor window, which contains its own Ribbon and a preview pane that shows a preview of the data. (See Figure 13-17.) Here, you can apply certain actions to shape, clean, and transform the data before importing.

   The idea is to work with each column shown in the Query Editor, applying the necessary actions that will give you the data and structure
you need. You’ll dive deeper into column actions later in this chapter. For now, you need to continue toward the goal of getting the last 30 days of stock prices for Microsoft Corporation.

You may have noticed that the Navigator pane shown in Figure 13-16 offers a Load button (next to the Edit button). The Load button allows you to skip any editing and import your targeted data as is. If you are sure you will not need to transform or shape your data in any way, you can opt to click the Load button to import the data directly into the Data Model or a spreadsheet in your workbook.

4. Right-click the Date field to see the available column actions, as shown in Figure 13-18, and then choose Change Type ➪ Date to ensure that the Date field is formatted as a proper date.

5. Remove all columns you do not need by right-clicking each one and selecting Remove from the menu that appears.

Besides the Date field, the only columns you need are the High, Low, and Close fields. Alternatively, you can hold down the Ctrl key on the keyboard, select the columns you want to keep, right-click any selected column, and then choose Remove Other Columns from the menu that appears. (See Figure 13-19.)
6. Ensure that the High, Low, and Close fields are formatted as proper numbers. To do this, hold down the Ctrl key on the keyboard, select the three columns, right-click, and then choose Change Type ➪ Decimal Number from the menu that appears.

After you do this, you may notice that some of the rows show the word Error. These are rows that contained text values that could not be converted.

7. Remove the Error rows by selecting Remove Errors from the Table Actions list (next to the Date field), as shown in Figure 13-20.

8. After all errors are removed, add a Week Of field that displays the week each date in the table belongs to. To do this, right-click the Date field and select the Duplicate Column option.

Doing so adds a new column to the preview.
9. Right-click the newly added column, select the Rename option from the menu that appears, and then rename the column Week Of.

10. Select the Transform tab on the Power Query ribbon and then choose Date ▶ Week ▶ Start of the Week, as shown in Figure 13-21.

   Excel transforms the date to display the start of the week for a given date.

11. When you’ve finished configuring your Power Query feed, save and output the results. To do this, click the Close & Load drop-down found on the Home tab of the Power Query ribbon to reveal the two options shown in Figure 13-22.
The Close & Load option saves your query and outputs the results as an Excel table to a new worksheet in your workbook.

The Close & Load To gives you the option of saving your output results to the internal data model.

![Image of Power Query interface](image)

**Figure 13-22:** Select the Close & Load option to output your results as a table on a new worksheet.

At this point, you should have a table similar to the one shown in Figure 13-23, which can be used to produce the pivot table you need.

Take a moment to appreciate what Power Query allowed you to do just now. With a few clicks, you searched the Internet, found some base data, shaped the data to keep only the columns you needed, and even manipulated that data to add an extra Week Of dimension to the base data. This is what Power Query is about: enabling you to easily extract, filter, and reshape data without the need for any programmatic coding skills.

**Understanding query steps**

Power Query uses its own formula language (known as the “M” language) to codify your queries. As with macro recording, each action you take when
working with Power Query results in a line of code being written into a query step. Query steps are embedded M code that allow your actions to be repeated every time you refresh your Power Query data.

You can see the query steps for your queries by activating the Query Settings pane. Simply click the Query Settings command on the View tab of the Query Editor ribbon. You can also place a check in the Formula Bar option to enhance your analysis of each step with a formula bar that displays the syntax for the given step.

The Query Settings pane appears to the right of the Preview pane, as shown in Figure 13-24. The formula bar is located directly above the Preview pane.

Each query step represents an action you took to get to a data table. You can click any step to see the underlying M code in the Power Query formula bar. For example, clicking the step called Removed Errors reveals the code for that step on the formula bar.

When you click a query step, the data shown in the preview pane is a preview of what the data looked like up to and including the step you clicked. For example, in Figure 13-24, clicking the step before the Removed Other Columns step lets you see what the data looked like before you removed the nonessential columns.
You can right-click on any step to see a menu of options for managing your query steps. Figure 13-25 illustrates the following options:

- **Edit Settings:** Edits the arguments or parameters that define the selected step.
- **Rename:** Gives the selected step a meaningful name.
- **Delete:** Removes the selected step. Be aware that removing a step can cause errors if subsequent steps depend on the deleted step.
- **Delete Until End:** Removes the selected step and all following steps.
- **Move Up:** Moves the selected step up in the order of steps.
- **Move Down:** Moves the selected step down in the order of steps.

### Refreshing Power Query data

It’s important to note that Power Query data is not in any way connected to the source data used to extract it. A Power Query data table is merely a
snapshot. In other words, as the source data changes, Power Query doesn’t automatically keep up with the changes; you need to intentionally refresh your query.

If you chose to load your Power Query results to an Excel table in the existing workbook, you can manually refresh by right-clicking the table and selecting the Refresh option from the menu that appears.

If you chose to load your Power Query data to the internal Data Model, you need to open the Power Pivot window, select your Power Query data, and then click the Refresh command on the Home tab of the Power Query window.

To get a bit more automated with the refreshing of your queries, you can configure your data sources to automatically refresh your Power Query data. To do so, follow these steps:

1. **Go to the Data tab on the Excel ribbon and select the Connections command.**
   
   The Workbook Connections dialog box appears.

2. **Select the Power Query data connection you want to refresh and then click the Properties button.**
3. With the Properties dialog box open, select the Usage tab.

4. Set the following options to refresh the chosen data connection. (See Figure 13-26):

- **Refresh Every X Minutes**: Placing a check mark next to this option tells Excel to automatically refresh the chosen data every specified number of minutes. Note that Excel refreshes all tables associated with that connection.

- **Refresh Data When Opening the File**: Placing a check mark next to this option tells Excel to automatically refresh the chosen data connection upon opening the workbook. Excel refreshes all tables associated with that connection as soon as the workbook is opened.

These refresh options are useful when you want to ensure that your customers are working with the latest data. Of course, setting these options doesn’t preclude the ability to manually refresh the data using the Refresh command on the Home tab.

Managing existing queries

As you add various queries to a workbook, you need a way to manage them. Excel accommodates this need by offering the Workbook Queries pane,
which enables you to edit, duplicate, refresh, and generally manage all existing queries in the workbook. Activate the Workbook Queries pane by selecting the Show Queries command on the Data tab of the Excel ribbon.

The idea is to find the query you want to work with and then right-click the query to take any one of the actions shown in Figure 13-27.

![Figure 13-27: Right-click any query in the Workbook Queries pane to see the available management options.](image)

- **Edit**: Opens the Query Editor, where you can modify the query steps
- **Delete**: Deletes the selected query
- **Refresh**: Refreshes the data in the selected query
- **Load To**: Activates the Load To dialog box, where you can redefine where the selected query’s results are used
- **Duplicate**: Creates a copy of the query
- **Reference**: Creates a new query that references the output of the original query
- **Merge**: Merges the selected query with another query in the workbook by matching specified columns
Append: Appends the results of another query in the workbook to the selected query

Send to Data Catalog: Publishes and shares the selected query via a Power BI server that your IT department sets up and manages

Move to Group: Moves the selected query into a logical group you create for better organization

Move Up: Moves the selected query up in the Workbook Queries pane

Move Down: Moves the selected query down in the Workbook Queries pane

Show the Peek: Shows a preview of the query results for the selected query

Properties: Renames the query and adds a friendly description

The Workbook Queries pane is especially useful when your workbook contains several queries. Think of it as a kind of table of contents that allows you to easily find and interact with the queries in your workbook.

Examining Power Query connection types

Microsoft has invested a great deal of time and resources in ensuring that Power Query has the ability to connect to a wide array of data sources. Whether you need to pull data from an external website, a text file, a database system, Facebook, or a web service, Power Query can accommodate most, if not all, of your source data needs.

You can see all available connection types by clicking the New Query drop-down menu on the Data tab. As Figure 13-28 illustrates, Power Query offers the ability to pull from a wide array of data sources.

Clicking any of the connection types activates a set of dialog boxes for the selected connection. These dialog boxes ask for the basic parameters that Power Query needs in order to connect to the data source, parameters such as file path, URL, server name, and credentials.

Each connection type requires its own unique set of parameters, so each of their dialog boxes will be different. Luckily, Power Query rarely needs more than a handful of parameters to connect to any single data source, so the dialog boxes are relatively intuitive and hassle-free.
Power Query saves all connection and authentication parameters (such as username and password) for each data source connection you have used. You can view, edit, or delete any of the data source connections by selecting the Data Source Settings command found near the bottom of the New Query drop-down menu (refer to Figure 13-28). Click any of the connections in the Data Source Settings dialog box to edit or delete the selected connection.
Chapter 14

Sharing Your Workbook with the Outside World

In This Chapter

▶ Controlling access to your dashboards and reports
▶ Displaying your Excel dashboards in PowerPoint
▶ Saving your dashboards and reports to a PDF file
▶ Publishing your dashboards to the web

Let’s face it: You’re not making these dashboards and reports for your health. At some point, you’ll want to share your handiwork with others. The focus of this chapter is on preparing your dashboards for life outside your PC. Here, I help you explore the various methods of protecting your work from accidental and intentional meddling and show how you can distribute your dashboards via PowerPoint, PDF, and the web.

Protecting Your Dashboards and Reports

You’ve put in a ton of hours getting your dashboard and reports to work the way you want them to. The last thing you need is to have a clumsy client or an overzealous power user botching up your Excel file.

Before distributing any Excel-based work, you should always consider protecting your file using the protection capabilities native to Excel. Although none of Excel’s protection methods are hacker-proof, they do serve to prevent accidental corruption and to protect sensitive information from unauthorized users.
Securing access to the entire workbook

Perhaps the best way to protect your Excel file is to use Excel’s protection options for file sharing. These options enable you to apply security at the workbook level, requiring a password to view or make changes to the file. This method is by far the easiest to apply and manage because there’s no need to protect each worksheet one at a time. You can apply blanket protection to guard against unauthorized access and edits. Take a moment to review the file-sharing options, listed here:

- Set read-only access to a file until a password is given.
- Require a password to open an Excel file.
- Remove workbook-level protection.

The next few sections discuss these options in detail.

Permitting read-only access unless a password is given

You can set your workbook to read-only mode until the user types the password. This way, you can keep your file safe from unauthorized changes yet still allow authorized users to edit the file.

Here are the steps to force read-only mode:

1. With your file open, click the File button.
2. To open the Save As dialog box, click Save As and then double-click the Computer icon.
3. In the Save As dialog box, click the Tools button and select General Options, as shown in Figure 14-1.

   The General Options dialog box appears.

![Figure 14-1: The file-sharing options are hidden away in the Save As dialog box under General Options.](image)
4. Type an appropriate password in the Password to Modify input box, shown in Figure 14-2, and click OK.

Figure 14-2: Type the password needed to modify the file.

5. Excel asks you to reenter your password, so reenter your chosen password.

6. Save the file to a new name.

At this point, the file is password-protected from unauthorized changes. If you were to open it, you’d see something similar to Figure 14-3. Failing to type the correct password causes the file to go into read-only mode.

Note that Excel passwords are case-sensitive, so make sure Caps Lock on the keyboard is turned off when entering your password.

Figure 14-3: A password is now needed to make changes to the file.

Requiring a password to open an Excel file

You may have instances in which your Excel dashboards are so sensitive that only certain users are authorized to see them. In these cases, you can require users to enter a password to open the workbook. Here are the steps to set up a password for the file:

1. With the file open, click the File button.

2. To open the Save As dialog box, click Save As and then double-click the Computer icon.
3. In the Save As dialog box, click the Tools button and select General Options. (Refer to Figure 14-1.)

The General Options dialog box opens.

4. Type an appropriate password in the Password to Open text box, as shown in Figure 14-4, and click OK.

Excel asks you to reenter your password.

5. Save your file to a new name.

At this point, your file is password-protected from unauthorized viewing.

**Removing workbook-level protection**

Removing workbook-level protection is as easy as clearing the passwords from the General Options dialog box. Here’s how you do it:

1. With your file open, click the File button.

2. To open the Save As dialog box, click Save As.

3. In the Save As dialog box, click the Tools button and select General Options. (Refer to Figure 14-1.)

   The General Options dialog box opens.

4. Clear the Password to Open input box as well as the Password to Modify input box and then click OK.

5. Save your file.

When you select the Read-Only Recommended check box in the General Options dialog box (refer to Figure 14-4), you get a cute but useless message recommending read-only access upon opening the file. This message is only a recommendation and doesn’t prevent anyone from opening the file as read/write.
Limiting access to specific worksheet ranges

You may find that you need to lock specific worksheet ranges, preventing users from taking certain actions. For example, you may not want users to break your data model by inserting or deleting columns and rows. You can prevent this by locking those columns and rows.

Unlocking editable ranges

By default, all cells in a worksheet are set to be locked when you apply worksheet-level protection. The cells on that worksheet can’t be altered in any way. That being said, you may find you need certain cells or ranges to be editable even in a locked state, like the example shown in Figure 14-5.

Before you protect your worksheet, you can unlock the cell or range of cells that you want users to be able to edit. (The next section shows you how to protect your entire worksheet.) Here’s how to do it:

1. Select the cells you need to unlock.
2. Right-click and select Format Cells.
3. On the Protection tab, as shown in Figure 14-6, deselect the Locked check box.
4. Click OK to apply the change.
Applying worksheet protection

After you've selectively unlocked the necessary cells, you can begin to apply worksheet protection. Just follow these steps:

1. To open the Protect Sheet dialog box, click the Protect Sheet icon on the Review tab of the Ribbon; see Figure 14-7.

2. Type a password in the text box shown in Figure 14-8 and then click OK.

   This is the password that removes worksheet protection. Note that because you can apply and remove worksheet protection without a password, specifying one is optional.

3. In the list box shown in Figure 14-8, select which elements users can change after you protect the worksheet.

   When a check box is cleared for a particular action, Excel prevents users from taking that action.

4. If you provided a password, reenter the password.

5. Click OK to apply the worksheet protection.
Protecting sheet elements and actions

Take a moment to familiarize yourself with some of the other actions you can limit when protecting a worksheet. (Refer to Figure 14-8.) They are described in this list:

✓ **Select Locked Cells**: Allows or prevents the selection of locked cells.
✓ **Select Unlocked Cells**: Allows or prevents the selection of unlocked cells.
✓ **Format Cells**: Allows or prevents the formatting of cells.
✓ **Format Columns**: Allows or prevents the use of column formatting commands, including changing column width or hiding columns.
✓ **Format Rows**: Allows or prevents the use of row formatting commands, including changing row height or hiding rows.
✓ **Insert Columns**: Allows or prevents the inserting of columns.
✓ **Insert Rows**: Allows or prevents the inserting of rows.
✓ **Insert Hyperlinks**: Allows or prevents the inserting of hyperlinks.
✓ **Delete Columns**: Allows or prevents the deleting of columns. Note that if Delete Columns is protected and Insert Columns is not protected, you can technically insert columns you then can’t delete.
✓ **Delete Rows**: Allows or prevents the deleting of rows. Note that if Delete Rows is protected and Insert Rows is not protected, you can technically insert rows you then can’t delete.

Figure 14-8: Specify a password that removes worksheet protection.
Part V: Working with the Outside World

- **Sort**: Allows or prevents the use of Sort commands. Note that this doesn’t apply to locked ranges. Users can’t sort ranges that contain locked cells on a protected worksheet, regardless of this setting.

- **Use AutoFilter**: Allows or prevents the use of Excel’s AutoFilter functionality. Users can’t create or remove AutoFiltered ranges on a protected worksheet, regardless of this setting.

- **Use PivotTable Reports**: Allows or prevents the modifying, refreshing, or formatting of pivot tables found on the protected sheet.

- **Edit Objects**: Allows or prevents the formatting and altering of shapes, charts, text boxes, controls, or other graphics objects.

- **Edit Scenarios**: Allows or prevents the viewing of scenarios.

### Removing worksheet protection

Just follow these steps to remove any worksheet protection you may have applied to your worksheets:

1. Click the Unprotect Sheet icon on the Review tab.

2. If you specified a password while protecting the worksheet, Excel asks you for that password; see Figure 14-9. Type the password and click OK to immediately remove protection.

![Figure 14-9: The Unprotect Sheet icon removes worksheet protection.](image)

### Protecting the workbook structure

If you look under the Review tab on the Ribbon, you see the Protect Workbook icon next to the Protect Sheet icon. *Protecting* the workbook enables you to prevent users from taking any action that affects the structure of the workbook, such as adding or deleting worksheets, hiding or unhiding
worksheets, and naming or moving worksheets. Just follow these steps to protect a workbook:

1. To open the Protect Structure and Windows dialog box, shown in Figure 14-10, click the Protect Workbook icon on the Review tab of the Ribbon.

2. Choose which elements you want to protect: workbook structure, windows, or both. When a check box is cleared for a particular action, Excel prevents users from taking that action.

Selecting the Structure option prevents users from doing the following:

- Viewing worksheets you’ve hidden
- Moving, deleting, hiding, or changing the names of worksheets
- Inserting new worksheets or chart sheets
- Moving or copying worksheets to another workbook
- Displaying the source data for a cell in a pivot table Values area or displaying pivot table Filter pages on separate worksheets
- Creating a scenario summary report
- Using an Analysis ToolPak utility that requires results to be placed on a new worksheet
- Recording new macros

Choosing the Windows option prevents users from changing, moving, or sizing the workbook windows while the workbook is open.

3. If you provided a password, reenter the password.
4. Click OK to apply the worksheet protection.
Part V: Working with the Outside World

Linking Your Excel Dashboards to PowerPoint

You may find that your organization heavily favors PowerPoint presentations for periodic updates. Several methods exist for linking your Excel dashboards to a PowerPoint presentation. For current purposes, I focus on the method that is most conducive to presenting frequently updated dashboards and reports in PowerPoint — creating a dynamic link. A dynamic link allows your PowerPoint presentation to automatically pick up changes that you make to data in your Excel worksheet.

This technique of linking Excel charts to PowerPoint is ideal if you aren’t proficient at building charts in PowerPoint. Build the chart in Excel and then create a link for the chart in PowerPoint.

Creating a link between Excel and PowerPoint

When you create a link to a range in Excel, PowerPoint stores the location information to the source field and then displays a representation of the linked data. The net effect is that when the data in the source file changes, PowerPoint updates its representation of the data to reflect the changes.

You can find the Chapter 14Samples.xlsx file example for this chapter on this book’s companion website.

To test this concept of linking to an Excel range, follow these steps:

1. Open the Chapter 14Samples.xlsx file.
2. Click the chart to select it and press Ctrl+C on the keyboard to copy the chart.
3. Open a new PowerPoint presentation and place the cursor at the location that you want to display the linked table.
4. On the Home tab in PowerPoint, choose Paste → Paste Special, as shown in Figure 14-11.
   The Paste Special dialog box appears, illustrated in Figure 14-12.
5. Select the Paste Link radio button and choose Microsoft Excel Chart Object from the list of document types.
6. Click OK to apply the link.
   The chart on your PowerPoint presentation now links back to your Excel worksheet. See Figure 14-13 for an example.
If you’re copying multiple charts, select the range of cells that contains the charts and press Ctrl+C to copy. This way, you’re copying everything in that range of cells — charts and all.

**Figure 14-11:** Select Paste Special from the Home tab in PowerPoint.

**Figure 14-12:** Be sure to select Paste Link and set the link as an Excel Chart Object.

**Figure 14-13:** Your Excel chart is now linked into your new PowerPoint presentation.
Manually updating links to capture updates

The nifty thing about dynamic links is that they can be updated, enabling you to capture any new data in your Excel worksheets without re-creating the links. To see how this works, follow these steps:

1. Go back to your Excel file (from the example in the previous section) and change the values for Samsung and Nokia, as shown in Figure 14-14.

Note the chart has changed.

2. Return to PowerPoint, right-click the chart link in your presentation, and choose Update Link from the menu that appears, as demonstrated in Figure 14-15.

You see that your linked chart automatically captures the changes.

3. Save and close both your Excel file and your PowerPoint presentation and then open only the newly created PowerPoint presentation.

Now you see the message shown in Figure 14-16. Clicking the Update Links button updates all links in the PowerPoint presentation. Each time you open any PowerPoint presentation with links, it asks you whether you want to update the links.

Note the scary language warning you about potential security concerns. (See Figure 14-16.) This is just a reminder that opening untrusted documents can open the door to malicious viruses. Use your best judgment, and only open documents from trusted sources.
Automatically updating links

Having PowerPoint ask you whether you want to update the links each and every time you open your presentation quickly gets annoying. You can avoid this message by telling PowerPoint to automatically update your dynamic links upon opening the presentation file. Here’s how:

1. In PowerPoint, click the File button to get to the Backstage View.
2. In the Info Pane, go to the lower-right corner of the screen and select Edit Links to Files, as shown in Figure 14-17.

The Links dialog box opens, as shown in Figure 14-18.
3. Click each of your links and select the Automatic radio button at the bottom of the dialog box.

When your links are set to update automatically, PowerPoint automatically synchronizes with your Excel worksheet file and ensures that all your updates are displayed.

To select multiple links in the Links dialog box, press the Ctrl key on the keyboard while you select your links.
Distributing Your Dashboards via a PDF

Starting with Excel 2010, Microsoft has made it possible to convert Excel worksheets to a PDF (portable document format). A PDF is the standard document-sharing format developed by Adobe.

Although it may not seem intuitive to distribute dashboards with PDF files, some distinct advantages make PDF an attractive distribution tool:

- Distributing your reports and dashboards as PDF files allows you to share your final product without sharing all the formulas and back-end plumbing that come with the workbook.
- Dashboards appear in PDF files with full fidelity, which means that they appear consistently on any computer and screen resolution.
- PDF files can be used to produce high-quality prints.
- Anyone using the free Adobe Reader can post comments and sticky notes on the distributed PDF files.
- Unlike Excel’s security, the security in a PDF is generally better, allowing for multiple levels of security, including public-key encryption and certificates.

To convert your workbook to a PDF, follow these simple steps:

1. Click the File button and then choose the Export command.
2. In the Export pane, select Create PDF/XPS Document and then click the Create PDF/XPS button, as shown in Figure 14-19.

The Publish as PDF or XPS dialog box opens.
3. Click the Options button, as demonstrated in Figure 14-20.

![Figure 14-20: Select a location for your PDF; then click the Options button.]

4. In the Options dialog box, illustrated in Figure 14-21, you can specify what you want to publish.

![Figure 14-21: Excel allows you to define what gets sent to PDF.]

You have the option of publishing the entire workbook, specific pages, or a range that you’ve selected.

5. Click OK to confirm your selections.

6. Click Publish.

Distributing Your Dashboards to OneDrive

OneDrive is Microsoft’s answer to Google Docs. You can think of it as a Microsoft Office platform in the cloud, allowing you to save, view, and edit your Office documents on the web.

When you publish your Excel dashboards or reports to OneDrive, you can

- View and edit your workbooks from any browser, even if the computer you’re using doesn’t have Excel installed.
- Provide a platform where two or more people can collaborate on and edit the same Excel file at the same time.
- Share only specific sheets from your workbook by hiding sheets you don’t want the public to see. When a sheet in a published workbook is hidden, the browser doesn’t even recognize its existence, so there is no way for the sheet to be unhidden or hacked into.
- Offer up web-based interactive reports and dashboards that can be sorted and filtered.

To publish a workbook to OneDrive, follow these steps:

1. Click the File button on the Ribbon, click the Save As command, and choose OneDrive, as demonstrated in Figure 14-22.

   The OneDrive pane allows you to sign in to your OneDrive account.

   If you don’t have a OneDrive account, you can sign up for one using the Sign Up link.

2. Sign in to your OneDrive account.

   After you sign in, the Save As dialog box shown in Figure 14-23 appears.

3. Click Browser View Options to select which components of your workbook will be viewable to the public.

   The Browser View Options dialog box allows you to control what the public is able to see and manipulate in your workbook.
Part V: Working with the Outside World

Figure 14-22: Go to the OneDrive pane.

Figure 14-23: Click Browser View Options in the Save As dialog box.
Chapter 14: Sharing Your Workbook with the Outside World

4. Click the Show tab, illustrated in Figure 14-24.

Here, you can select and deselect sheets and other Excel objects. Removing the check next to any sheet or object prevents it from being viewable from the browser. Again, this is a fantastic way to share your dashboard interfaces without exposing the back-end calculations and data models.

![Figure 14-24: You have full control over which sheets and objects are available to the public when publishing to the web.]

5. After you confirm your Browser View options, save the file to your Documents folder.

At this point, you can sign in to OneDrive and navigate to your documents to see your newly published file.

There are several ways to share your newly published workbook:

- Copy the web link from the browser address bar and email the link to your cohorts.
- Click the File button in the web version of your file, choose Share, as shown in Figure 14-25, and then click the Share with People command to send an email to anyone you specify.
- Use the Embed command on the same Share pane to generate HTML code to embed your workbook in a web page or blog.
Limitations When Publishing to the Web

It’s important to understand that workbooks that run on the web are running in an Excel Web App that is quite different from the Excel client application you have on your PC. The Excel Web App has limitations on the features it can render in the web browser. Some limitations exist because of security issues, whereas others exist simply because Microsoft hasn’t had time to evolve the Excel Web App to include the broad set of features that come with standard Excel.

In any case, the Excel Web App has some limitations:

- **Data Validation doesn’t work on the web.** This feature is simply ignored when you publish your workbook to the web.
- **No form of VBA, including macros, will run in the Excel Web App.** Your VBA procedures simply will not transfer with the workbook.
- **Worksheet protection will not work on the web.** Instead, you need to plan for and use the Browser View options demonstrated earlier, in Figure 14-23 and 14-24.
- **Links to external workbooks will no longer work after publishing to the web.**
- **Array formulas work on the web, but you can’t create array formulas while editing a workbook online.** You need to create array formulas before publishing to the web.
✓ You can use any pivot tables with full fidelity on the web, but you cannot create any new pivot tables while your workbook is on the web. You need to create pivot tables in the Excel client on your PC before publishing to the web.

✓ You can create simple charts in the Excel Web App, but not all customization and formatting options are available on the web. Although you have a limited set of chart formatting options on the web, any chart created before publishing will retain all of its original look and feel.
Part VI
The Part of Tens

See ten examples of how a little imagination can turn basic Excel shapes into info-graphics at www.dummies.com/extras/exceldashboardsreports.
In this part . . .

- Take a look at a few chart-building best practices that can help you design more effective charts.
- Discover how to avoid common charting mistakes.
- Gain an understanding of the ten most common Excel chart types and when to use them.
I'm the first to admit that I've created my share of poorly designed charts — bar charts with every color known to man, line charts with ten or more lines slapped on top of each other, and pie charts with slices so thin they melded into a blob of black ink. When I look at these early disasters, I feel the shame of a Baby Boomer looking at pictures of himself in white bell-bottom jeans.

Excel makes charting so simple that it’s often tempting to accept the charts it creates no matter how bad the default colors or settings are. But I’m here to implore you to turn away from the glitzy lure of the default settings. You can easily avoid charting fiascos by following a few basic design principles.

In this chapter, I share a few of these principles and help you avoid some of the mistakes I’ve made in the past. (No thanks needed.)

**Avoid Fancy Formatting**

Excel makes it easy to apply effects that make everything look shiny, glittery, and oh-so-pretty. Now, don’t get me wrong; these new graphics are more than acceptable for charts created for sales and marketing presentations. However, when it comes to dashboards, you definitely want to stay away from them.

A *dashboard* is a platform to present your case with data. Why dress up your data with superfluous formatting when the data itself is the thing you want to get across? It’s like making a speech in a Roman general’s uniform. How well will you get your point across when your audience is thinking “What’s the deal with Tiberius?”

Take Figure 15-1, for instance — I created this chart (formatting and all) with just a few clicks. Excel makes it super easy to achieve these types of effects with its Layout and Style features. The problem is that these effects subdue
the very data you’re trying to present. Furthermore, if you include this chart on a page with five to ten other charts with the same formatting, you create a blinding mess that’s difficult to look at, much less read.

The key to communicating effectively with charts is to present data as simply as possible. I promise you: Your data is interesting on its own. There’s no need to wrap it in eye candy to make it more interesting.

Figure 15-2 shows the same data without the fancy formatting. I think you’ll find that not only is the chart easier to read, but you can also process the data more effectively.
Here are some simple “don’ts” to keep you from overdoing the fancy factor:

- **Don’t apply background colors to the Chart area or Plot area.** Colors in general should be reserved for key data points in your chart.
- **Don’t use 3D charts or 3D effects.** No one’s going to give you an Oscar for special effects. Nothing 3D belongs on a dashboard.
- **Don’t apply fancy effects such as gradients, pattern fills, shadows, glow, soft edges, and other formatting.** Again, the word of the day is focus, as in “Focus on the data and not on the shiny, happy graphics.”
- **Don’t try to enhance your charts with clip art or pictures.** They do nothing to further data presentation, and they often just look tacky.

**Skip the Unnecessary Chart Junk**

Data visualization pioneer Edward Tufte introduced the notion of *data-to-ink ratio*. Tufte’s basic idea is that a large percentage of the ink on a chart or dashboard should be dedicated to data. Very little ink should be used to present what he calls *chart junk*: borders, gridlines, trend lines, labels, backgrounds, and other elements.

Figure 15-3 illustrates the impact that chart junk can have on your ability to communicate your data. At first glance, the top chart in Figure 15-3 may look exaggerated in its ambition to show many chart elements at one time, but believe me, other charts out there also look like this. Notice how convoluted and cramped the data looks.

The bottom chart presents the same information as the top chart. However, the bottom chart more effectively presents the core message that driver registrations in Texas rose from more than 10 million in 1980 to almost 17 million in 2004 (a message that was diluted in the top chart). You can see from this simple example how a chart can be dramatically improved by simply removing the elements that don’t directly contribute to the core message of the chart.

Here are a few ways to avoid chart junk and ensure that your charts clearly present your data:

- **Remove gridlines.** Gridlines (both vertical and horizontal) are almost always unnecessary. The implied reason for gridlines is that they help to visually gauge the value represented by each data point. The truth is, however, that you typically gauge the value of a data point by comparing its position to the other data points in the chart. So gridlines become secondary reference points that simply take up ink.
✓ **Remove borders.** You’ll find that eliminating borders and frames gives your charts a cleaner look and helps avoid the dizzying lines you get when placing many charts with borders on a single dashboard. Instead of borders, use the white space between the charts as implied borders.

✓ **Skip the trend lines.** Seldom does a trend line provide insight that can’t be gained with the already plotted data or a simple label. In fact, trend lines often state the obvious and sometimes confuse readers into thinking that they’re another data series. Why place a trend line on a line chart when the line chart is itself a trend line of sorts? Why place a trend line on a bar chart when it’s just as easy to look at the top of the bars? In lieu of trend lines, add a simple label that states what you’re trying to say about the overall trend of the data.

✓ **Avoid data label overload.** Nothing says that you need to show the data label for every value on your chart. It’s okay to plot a data point and not display its value. You’ll find that your charts have more impact when you show only numbers relevant to your message. For example, the bottom chart in Figure 15-3 shows a trend that includes seven years of data. Although all the years are plotted to show the trend, only values of the first and last plotted years are shown. The first and last plotted years’ data is enough to fulfill the purpose of this chart, which is to show the trend and ultimate growth of driver registrations.

**Figure 15-3:** Charts with too many chart elements can become convoluted and hard to read. Removing the unnecessary elements clarifies the message.
Don’t show a legend if you don’t have to. When you’re plotting one data series, there’s no need to display a space-taking chart legend. If you allow the chart title to identify the lone data series in your chart, you can simply delete the legend.

Remove any axis that doesn’t provide value. The purpose of the x- and y-axes are to help a user visually gauge and position the values represented by each data point. However, if the nature and utility of the chart don’t require a particular axis, you should remove it. For the bottom chart in Figure 15-3, for example, there’s no real need for the y-axis because the two data points I’m trying to draw attention to are labeled already. Again, the goal here isn’t to hack away at your chart. The goal is to include only those chart elements that directly contribute to the core message of your chart.

Format Large Numbers Where Possible

It’s never fun to count the zeros in a large number, especially when you’re staring at 8-point font. When plotting very large numbers on a chart, consider formatting the values so that they’re truncated for easy reading.

For instance, in Figure 15-4, I’ve formatted the values to appear as 10M and 17M instead of the hard-to-read 10,475,000 and 16,906,714.

You can easily format large numbers in Excel by using the Format Cells dialog box. There, you can specify a custom number format by selecting Custom in the Category list and entering a number format code in the Type input box. In Figure 15-5, the code 0,, “M” ensures that the numbers are formatted to millions with an M appendage.
To get to the Format Cells dialog box, highlight the numbers you’re formatting, right-click, and then choose Format Cells from the menu that appears.

It’s generally good practice to format the source data that feeds your chart as opposed to the data labels on your chart. This way, your formatting persists even as you add and remove data labels.

The table in Chapter 3 lists common format codes and their effect on your numbers.

**Use Data Tables Instead of Data Labels**

Sometimes it’s valuable to show all the data values along with the plotted data points. However, earlier sections in this chapter show how data labels can inundate users with chart junk.

Rather than use data labels, you can attach a data table to your Excel chart. A *data table* allows you to see the data values for each plotted data point, beneath the chart. Figure 15-6 illustrates a data table, showing the data values for two series. As you can see, a lot of information is shown here without overcrowding the chart itself.
Chapter 15: Ten Chart Design Principles

Although data tables increase the space that your charts occupy on your dashboard, they respond well to formatting and can be made to meld nicely into your charts. Data tables come in particularly handy if your clients are constantly asking to see the detailed information behind your charts.

To add or remove data tables, select the chart and click the Chart Elements button next to the chart. This action expands a menu of chart elements that you can add to your chart. (See Figure 15-7.) Place a check next to Data Table to add a data table. Remove the check mark to remove the data table.

Figure 15-6: Data tables enable you to show data values without overloading your chart with data labels.

Figure 15-7: Adding a data table to a chart.
You can right-click the data table at any time to call up the Format Table dialog box and apply additional formatting to the table. (See Figure 15-8.)

![Format Data Table dialog box](image)

**Make Effective Use of Chart Titles**

A chart title doesn’t have to be limited to simple labeling and naming duties. You can use a chart title to add an extra layer of information, presenting analysis derived from the data presented in the chart. Figure 15-9 demonstrates this.

![Chart illustrating internet access](image)
**Sort Your Data before Charting**

Unless there’s an obvious natural order, such as age or time, it’s generally good practice to sort your data when charting. By *sorting*, I mean sort the source data that feeds your chart in ascending or descending order by data value.

As you can see in Figure 15-10, building a chart using a dataset sorted by values enhances its readability and somehow gives the chart a professional look and feel.

![Figure 15-10: Using sorted data in a chart improves readability and clarity.](image)

**Limit the Use of Pie Charts**

Although pie charts have long been considered a viable charting option for business reporting, they often aren’t well suited for dashboard reporting. There are a couple of reasons for this.

First, they typically take up more space than their cousins, the line and bar charts. Sure, you can make them small, but pixel for pixel, you get a lot less bang for your data-visualization buck with a pie chart.

Second, pie charts can’t clearly represent more than two or three data categories. Figure 15-11 demonstrates this fact.

The pie chart on the left does a good job visually of representing two data categories. You can easily distinguish the two categories and clearly get a sense of distribution for each category. The pie chart on the right is a different story. As you can see, when you go past two or three categories, a pie chart isn’t as effective in relaying the proper sense of percent distribution. The slices are too similar in size and shape to visually compare...
the categories. Plus the legend and data categories are disconnected, causing your eyes to jump back and forth from pie to legend. (Even in color, the legend doesn’t help.) Sure, you could add category labels, but that would cause the chart to take up more real estate without adding much value.

What’s the alternative? Instead of a pie chart, consider using a bar chart. With a bar chart, you can clearly represent the distribution percentages for many categories without taking up extra real estate. In Figure 15-12, you can see the dramatic improvement in clarity that you can achieve by using bar charts.

Don’t Be Afraid to Parse Data into Separate Charts

Be aware that a single chart can lose its effectiveness if you try to plot too much data into it. Take Figure 15-13, for example.
This chart has a couple of problems. First, the data is split into nine age groups, which forces you to use nine lines. When you start plotting more than three lines on a line chart, your chart begins to look jumbled. Second, the age groups have a wide range of data values. This causes the chart’s y-axis scale to be so spread out that each line essentially looks like a straight line.

In situations like this, step back and try to boil down what exactly the chart needs to do. What is the ultimate purpose of the chart? In this case, the ultimate purpose of this chart is to show the growth or decline of the workforce numbers for each age group. Now, you obviously can’t show every data point on the same chart, so you have to show each age group in its own chart. That means you want to make sure that you can see each age group alongside the other for comparison purposes.

Figure 15-14 shows just one of many solutions for this particular example.
Here, I’ve created a separate area chart for each age group and then lined them up side by side. Each chart individually shows a general trend from 2005 to 2010. Because they’re placed together, you can get an idea of the magnitude of each age group. Also, notice that I merged the last three age groups into one category called 65 & Up. This groups the three smallest categories into one that’s worthy of plotting. Finally, I used data labels to quickly show the growth or decline percentage from 2005 to 2010 for each group.

Again, this isn’t the only solution to this problem, but it does do the job of displaying the analysis I chose to present.

It’s not always easy to know exactly how to display your data in a chart — especially when the data is multilayered and complex. Rather than jam the world into one chart, step back and think about how to show the data separately but together.

**Maintain Appropriate Aspect Ratios**

In terms of charts, *aspect ratio* refers to the ratio of height to width. That is to say, charts should maintain an appropriate height-to-width ratio in order for the integrity of the chart to remain intact. Take a look at Figure 15-15 to see what I mean.

The chart at the top of Figure 15-15 is at an appropriate aspect ratio that correctly renders the chart. The bottom two charts display the same data, but the aspect ratios of these charts are skewed. The middle chart is too tall, and the bottom chart is too wide. This essentially distorts the visual representation, exaggerating the trend in the chart that’s too tall and flattening the trend in the chart that’s too wide.

I’ve seen lots of people contort their charts just to fit them into the empty space on their dashboards. If you want to avoid distorting your charts, you must keep them at an appropriate aspect ratio.

What is that ratio? Generally, the most appropriate aspect ratio for a chart is one in which the width of the chart is about twice as long as the height. For example, 1 inch tall by 2 inches wide is an appropriate ratio. And 1.5 inches tall by 3 inches wide is also appropriate. The actual height and width aren’t important. You can make your charts as small or as big as they need to be. What is important is the ratio of height to width.
Don’t Be Afraid to Use Something Other Than a Chart

Ask yourself whether a simple table will present the data just fine. If the data you’re reporting can be more effectively shared in a table, that’s how it should be presented. Remember that the goal of a dashboard is not to present everything in a chart — it’s to present key data in *the most effective way* possible.
Building a chart in Excel is not in and of itself a terribly difficult thing to do. The hard part is wrapping your mind around which types of chart to use in which situation. Excel has 11 major chart types, with variations on each type. For most business dashboards and reports, you need only a handful of the chart types available in Excel.

Here is a rundown of the chart types most frequently leveraged in dashboards and reports.

**Line Chart**

The line chart (see Figure 16-1) is one of the most frequently used chart types, typically used to show trends over a period of time. If you need to chart trends or changes over time, consider using a line chart.
Column Chart

A *column* chart is typically used to compare several items in a specific range of values. A column chart is ideal if you need to compare a single category of data between individual subitems. For example, you may want to compare revenue between regions, as shown in Figure 16-2.

![Column Chart](image)

Clustered Column Chart

A *clustered column* chart can be used if you need to compare multiple categories of data within individual subitems as well as between subitems. For instance, you can use a clustered column chart to compare revenue for each year within each region and between regions, as shown in Figure 16-3.

![Clustered Column Chart](image)
### Stacked Column Chart

A *stacked column* chart allows you to compare items in a specific range of values and to show the relationship of the individual subitems with the whole. For instance, a stacked column chart can show not only the overall revenue for each year, but also the proportion of the total revenue made up by each region, as shown in Figure 16-4.

![Stacked Column Chart](image)

---

### Pie Chart

Another frequently used chart is the standard pie chart. A *pie* chart represents the distribution or proportion of each data item over a total value (represented by the overall pie). A pie chart is most effective when plotting no more than three categories of data. (See Figure 16-5.)

![Pie Chart](image)
Bar Chart

Bar charts are typically used to compare several categories of data. Bar charts are ideal for visualizing the distribution or proportion of data items for more than three categories. For instance, a bar chart can be used to compare the overall revenue distribution for a given set of products, as shown in Figure 16-6.

Area Chart

An area chart is ideal for clearly illustrating the magnitude of change between two or more data points. For example, you can give your audience a visual feel for the degree of variance between the high and low price for each month, as shown in Figure 16-7.
Combination Chart

A combination chart is a visualization that combines two or more chart types into a single chart; this type is the ideal choice when you want to compare two categories of data for each individual subitem. A combination chart is commonly used to create visualizations that show the difference between targets versus actual results, as shown in Figure 16-8.

Figure 16-8: Use combination charts when you need to visually compare two or more metrics, such as performance versus goal.

XY Scatter Plot Chart

A scatter chart in Excel (also known as an XY scatter plot chart) is excellent for showing correlations between two sets of values. For example, an XY scatter plot can be used to illustrate the correlation between employee performance and competency, demonstrating that employee performance rises as competency improves, as shown in Figure 16-9. The x- and y-axes work together to represent data plots on the chart based on the intersection of x values and y values.

Figure 16-9: XY scatter-plots are fantastic for illustrating the correlation between two variables.
Bubble Chart

A bubble chart is a variation of an XY scatter plot. Just like the XY scatter plot, a bubble chart shows the correlation between two sets of data. The difference is the addition of a third dimension that is represented by the size of each bubble in the chart. This third dimension is typically used to show the relative impact of a quantitative data item. For instance, in addition to showing employee performance versus competency, you can have the size of each bubble represent years of service, allowing your audience to quickly get a sense of how years of service may affect the relationship between competence and performance. (See Figure 16-10.)

Figure 16-10: Use a bubble chart when you need to show both correlation and quantitative impact.
Index

• A •
abbreviations, of category names (on trending charts), 159–160
Above Average scenario, 88, 93–94
Access, 275–282
accuracy, of dashboard, 24
acronyms, avoiding use of, 20
ActiveX Controls, 227, 234
Add New Location button, 228
Adjust Column Width option, 282
Adobe PDFs, 315–317
alignment, 58, 59, 159–160
analysis, as separate from data and presentation, 26–28
Analyze tab, 258, 266, 270
anecdotal knowledge, 24
Append option, 298
area charts, 155, 342
arguments. See specific arguments
Arial font, 60
Array, 42
aspect ratios, 75, 336–337
Assign Macro dialog box, 226, 237
authentication information (SQL Server connection), 283
autofilters, 47, 48, 308
Automatic radio button, 314
Average option, 130
awkward navigation, use of macro to avoid, 220
axes, 78–79, 80–82, 156–157, 158–159, 166–168, 329
Axis command, 78
axis scaling, 78–79

• B •
backgrounds, 16–17, 327
backward compatible, 267
bar charts, 161, 180, 342
Below Average scenario, 88, 93–94
Between rule, 85
Bin Width option, 198
Border tab, 57
borders
as chart junk, 328
in dashboards, 18, 54, 55–57
Bottom 10 Items rule, 88
Bottom 10% rule, 88
Browser View Options dialog box, 317
bubble chart, 344
bullet graphs, 205–213
business cycles, 174
business intelligence (BI), 1
Business Objects, 1
Business Segment drop-down list, 135, 140–141
Button (Form control), 234, 237
downloads. See also specific buttons
macros for building navigation buttons, 229–230
for running macros, 226

• C •
Calibri font, 60
Camera tool, 108–114, 213
Camera tool icon, 109
cascading filters, 255
Change Chart Type dialog box, 164, 166, 207, 215
Change PivotTable Data Source dialog box, 125
chart feeder table/chart feeder, 186, 191, 193, 215
chart junk, 327–329
charts
about, 341
area charts, 155, 342
bar charts, 161, 180, 342
bubble chart, 344
changing chart data with drop-down selector, 247–249
clustered column chart, 340
column charts, 155, 340
combination chart, 343
controlling multiple charts with one selector, 250–253
design principles of, 325–337
effective use of titles in, 332
emphasizing top values in, 184–188
Excel tables as source of, 48
in-cell bar charts, 180
line charts, 154, 339
parsing data into separate charts, 334–336
pie chart, 341
pie charts, limiting use of, 333–334
showing many views through one chart, 243–245
skipping unnecessary chart junk, 327–329
sorting data before charting, 333
stacked column chart, 341
statistical, 197–199
thermometer-style, 204–205, 247
3D charts/3D effects, 327
types of, 154–155, 339–344
using something other than, 337
XY scatter plot chart, 343
Cheat Sheet (website), 6
Check Box (Form control), 235, 238–242
check boxes
Check Box (Form control), 235, 238–242
Check icon, 93, 96, 97
Choose Commands From drop-down list, 107
CHOOSE function, 44–46, 251–253
Clear Filter icon, 260
Clear icon, 143
clip art, 18
Close & Load option (Power Query), 292
clustered column chart, 340
code, Visual Basic for Applications (VBA), 219, 220
Col_index_num argument, 37
Color Scales, 84, 91–92
colors
applying custom format colors to numbers, 6667
changing of in sparklines, 77
in dashboards, overall, 16
to identify ranges in data model, 34
on labels, 20, 59
reserving of for key points in charts, 327
in tables, 54–55
use of to emphasize key data points in sparklines, 77–78
Visual Basic, 67
Colors and Lines tab, 109
column area (of pivot table), 117–118
column charts, 155, 340
Column sparklines, 71, 73, 77
combination chart, 343
Combo Box (Form control), 234, 246–249
commands. See specific commands
commas, 20
comments, use of, 315
Compact Form (pivot table layout), 126
comparative trending
creating side-by-side time comparisons, 162–164
creating stacked time comparisons, 165–166
trending with a secondary axis, 166–168
component question, 13
Computer icon, 302, 303
conditional formatting
adding rules manually, 92–96
application of pre-defined
scenarios, 84–92
defined, 83
representation of trends with Icon
Sets, 101–103
showing only one icon, 97–99
using symbols to enhance
reporting, 103–107
waffle charts and, 111–114
Conditional Formatting button,
84, 100, 103
Conditional Formatting Rules
Manager, 98
Control tab, 238, 242, 246, 249
Convert to Range button, 50
Count Nums option, 130
Count option, 130
Create PDF/XPS button, 315
Create PivotTable dialog box, 119
Create Rule by Hand tab, 94
Create Sparklines dialog box, 73–74
Create Table dialog box, 47–48
cumulative percent, adding of to
histogram, 191–194
Custom Name input box, 128
Custom Value option, 78
Customize Ribbon button, 221, 234

Dashboards
attributes of, 11
defined, 1, 9–10, 10–11
defining dimensions and filters for, 15
delineating measures for, 13–14
design principles of, 16–20
determining needs for drill-down
features, 1516
distribution of via OneDrive, 317–320
distribution of via PDF, 15–317
enhancing of with Camera
tool, 110–111
establishing audience/purpose
for, 12–13
establishing refresh schedule, 16
incorporating top and bottom
displays into, 180–181
linking of to PowerPoint, 310–314
mock layouts of, 13–14
optimal size for, 18
protection of, 301–309
data
converting Excel table back to
range, 49–50
converting range of to Excel
table, 47–49
extracting and transforming, 286–299
filtering of with SUMPRODUCT
function, 43–44
grouping/bucketing of, 179–199
hiding/showing items
without, 136–138
histograms, 188–199
parsing of into separate
charts, 334–336
refreshing of, 124
as separate from analysis and
presentation, 26–28
showing/hiding data items, in pivot
tables, 134–136
smoothing of (on trending
charts), 174–177
starting with appropriately
structured data, 29–32
top and bottom displays, 179–184
wild fluctuations in, 174
Data Bars, 84, 90–91, 99–101, 223, 224
Data Connection Wizard, 283
data delivery formulas, 35
data fields, applying numeric formats
to, 129–130
Data Link Properties dialog boxes, 279
data models
- avoiding turning into databases, 32–33
- best practices of, 25–35
- defined, 25
- documenting of, 34
- separating data, analysis, and presentation, 26–28
- testing of, 35
- data repository, avoiding turning dashboard into, 17

data sources
- Access tables, 275–282
- cataloging of, 14–15
- SQL Server tables, 275, 283–285
- Data tab, 39, 279, 282, 283, 287, 297
- data tables, use of instead of data labels, 330–332
- data to ink ratio, 327
- data validation, use of drop-down lists for, 38–39
- Data Validation button/dialog box/ functionality, 39
- data values, 330
- database, avoiding turning data model into, 32–33
- datasets, fundamental forms of in Excel, 29
- date axis, 80–82
- A Date Occurring rule, 86
- dates, formatting of, 67–68
- decimal places, 20
- default vertical axis, 166
- Delete Columns (worksheet protection), 307
- Delete option, 294, 297
- Delete Rows (worksheet protection), 307
- Delete Until End option (Power Query), 294
- Description field, 284
- design aspect, 16–17
- design principles of charts, 325–337

...
Protect Sheet, 306
Protect Structure and Windows, 309
Publish as PDF or XPS, 316
Record Macro, 221–222
Report Connections, 266
Save As, 302, 303–304, 317
Select Data Source, 279
Select Table, 279–280
Slicer Settings, 262, 271
Symbol, 105
Top 10%, 89
Top 10 Filter, 141, 181–183
Value Field Settings, 128, 131, 146, 148, 149–150
Workbook Connections, 295
dimensions, defined, 15
directional trending, avoiding overload with, 173–174
dividers, use of to mark significant events, 170–171
Do Not Show Subtotals option, 132
dollar symbol, 20
drag-and-drop method, for importing data from Access, 276
Dresner, Howard (Gartner Inc.), 1
drill-down features, determining need for, 15–16
drop zones, 120, 121, 123
drop-down lists/menus/boxes. See also specific drop down lists/menus/boxes
autofiler drop-down headers, 47
changing chart data with, 247–249
colors used for, 34
from Combo Box control, 246
for data validation, 38–39
Filter fields as, 255, 256
in Greater Than scenario, 86
from Other Sources icon, 284
from Show Values As tab, 148, 149–150
in Top 10% scenario, 89
from Value Field Settings dialog box, 146
Dummies (website), 6
Duplicate option, 297
Duplicate Values rule, 86
dynamic links, 310–314

\* E \*

Edit button (Power Query), 288
Edit Objects (worksheet protection), 308
Edit option, 297
Edit Rule button, 100, 103
Edit Scenarios (worksheet protection), 308
Edit Settings option (Power Query), 294
Edit Sparklines dialog box, 74, 82
effective visual design, 16
Embed command, 319
Ending At values, 195
Equal To rule, 85
errors, 42
Excel
flexibility of, 25
as part of enterprise BI tool portfolio, 1–2
pre-defined scenarios in, 84
Excel 2003, List feature, 47
Excel 2010
Sparklines, 70
.xlsx extension, 227
Excel 2013
Sparklines, 70
Timeline slicers enabled, 267
.xlsx extension, 227
Excel 2016
Power Query, 286–299
Timeline slicers disabled, 267
Excel Options dialog box, 107, 221, 234
Excel UserForms, 234
Excel Web App, limitations of, 320–321
Export wizards, Access, 277–278
external data, 265–299
External Data Properties
  dialog box, 282
External Data tab, 277
Eyetrack III project (Poynter Institute), 19

• F •

FALSE, 239, 241
Few, Stephen (author/visualization expert), 17
field names, customization of in pivot tables, 127–129
Field Settings dialog box, 133, 137
fields, columns as, 30
File button, 107, 221, 302, 303, 313, 317, 319
file extensions, 227–228
File Name input box, 284
file-sharing options, 302
Fill icon, 209, 216
filter area (of pivot table), 118
Filter fields, 255–256
filters, 15
filters, defined, 15
flat data files, as form of dataset, 29, 30–31
font size, 59
fonts, 60, 103
forecasts, representation of in trending components, 171–173
Form controls, 227, 233–236, 269–272
Format All Cells Based on Their Values, 95
Format Axis dialog box, 157, 159
Format Cells (worksheet protection), 307
format codes, for dates and times, 68
Format Columns (worksheet protection), 307
Format Data Labels dialog box, 186
Format Data Point dialog box, 169
Format Data Series dialog box, 167, 169, 173, 191, 194, 204–205, 207, 208, 211
Format Data Table dialog box, 332
Format Only Cells That Contain option, 95, 98
Format Only Top or Bottom Ranked Values option, 95
Format Picture dialog box, 109
Format Rows (worksheet protection), 307
Format Shape dialog box, 171
Format Slicer pane, 261
Format Trendline dialog box, 176
formatting
  applying numeric formats to data fields, 129–130
  avoiding fancy formatting, 17–18, 325–327
  of bullet graphs, 211–213
  conditional. See conditional formatting
  of dates and times, 67–68
  getting fancy with custom number formatting, 61–68
  of large numbers, 329–330
  of negative numbers, 62, 63, 65
  of numbers effectively, 19–20, 54, 58–59
  of percentages, 63
  of positive numbers, 62, 63
  of slicers, 260–265
  of specific periods of time, 169–170
  use of symbols to create custom number format, 106
formulas, in flat data files, 30–31
frequency distribution, 195
FREQUENCY function, 190–191
Friendly Name field, 285
From Access icon, 279
From Other Sources icon, 283
From SQL Server option, 283
functions
    CHOOSE, 44–46, 251–253
    FREQUENCY, 190–191
    HLOOKUP, 39–41
    INDEX, 248–249, 253
    LARGE, 184–187
    SMALL, 187–188
    SUMPRODUCT, 41–44
    VLOOKUP, 36–39

• G •

Gartner Inc., 1
General Options dialog box, 302, 303, 304
Get External Data icon, 278–282
glows, 18
Google Docs, 317
gradients, 18
grand totals, removal of, in pivot
tables, 134
graphs, bullet, 205–213
Greater Than rule, 85
gridlines, 56, 327
Group Box (Form control), 235
grouping, 179
Grouping dialog box, 143, 195

• H •

headers, 54, 59–60
Hidden and Empty Cell Settings
dialog box, 76
Highlight Cells Rules, 84–87
histograms, 188–199
HLOOKUP function, 39–41
horizontal bullet graphs, 210, 221

• I •

Icon Sets, 84, 92, 95, 99–103
icons
    Camera tool, 109
    Check, 93, 96, 97
    Clear, 143
    Clear Filter, 260
    Computer, 302, 303
    explained, 5
    Fill, 209, 216
    From Access, 279
    Get External Data, 278–282
    Insert Slicer, 258, 270
    From Other Sources, 283
    PivotTable, 119
    Properties, 296
    Protect Sheet, 306, 308
    Protect Workbook, 309
    Remember, 5
    Report Layout, 127
    showing of outside of cells in
    conditional formatting, 99–101
    showing only one in conditional
    formatting, 97–99
    Subtotals, 133
    Technical Stuff, 5
    Text box, 170
    Tip, 5
    Unprotect Sheet, 308
    Warning, 5
    X, 93, 97
    IF...THEN...ELSE statement, 85
    Import Data dialog box, 280
    in-cell bar charts, 180
    Include Row Numbers option, 282
    INDEX function, 248–249, 253
    Index_num argument, 45
    Insert button, 105
    Insert Cells for New Data, Delete
    Unused Cells option, 282
    Insert Columns (worksheet
    protection), 307
    Insert command, 234
    Insert drop-down list, 238, 242, 246, 249
    Insert Entire Rows for New Data, Clear
    Unused Cells option, 282
Insert Hyperlinks (worksheet protection), 307
Insert Rows (worksheet protection), 307
Insert Slicer icon, 258, 270
Insert Slicers dialog box, 258–259, 270
Insert tab, 47, 73, 105, 119, 171
Insert Timeline command, 266
Insert Timelines dialog box, 266
interactivity
adding control to worksheet, 236
adding of with pivot slicers, 255–272
check box example, 239–242
combo box example, 247–249
controlling multiple pivot tables with one slicer, 265–266
creating standard slicer, 258–260
creating Timeline slicer, 266–269
finding Form controls, 234–235
formatting slicers, 260–265
list box example, 250–253
option button example, 243–245
understanding slicers, 255–257
using Button control, 237
using Check Box control, 238–242
using Combo Box control, 246–249
using List Box control, 249–253
using Option Button control, 242–245
using slicers as Form controls, 269–272

• L •
Label (Form control), 235
labels
as chart junk, 328
effective use of, 20, 54, 59–60
on trending charts, 159–162
use of data tables instead of data labels, 330–332
LARGE function, 184–187
layout
changing of in pivot table, 126–127
mock layouts of dashboards, 13–14
use of to draw focus, 18–19
Layout & Print tab, 137
legends, 329
Less Than rule, 85
line charts, 154, 339
Line Color drop-down list, 109
Line sparklines, 71, 73, 77
Links dialog box, 313–314
List Box (Form control), 235, 249–253
List feature, 47
lists. See drop-down lists/menus/boxes
Load To option, 297
logarithmic option, 158–159
Lookup_value argument, 36, 40

• M •
Macro dialog box, 224
Macro Name field, 222
Macro Security button, 228
macros
for building navigation buttons, 229–230
defined, 219
for dynamically rearranging pivot table data, 230–231
enabling and trusting of, 227–229
examples of, 229–232

• J •
Joel, Billy (singer), 9

• K •
key performance indicators (KPIs), 13
Key Performance Indicators: Developing, Implementing, and Using Winning KPIs (Parmenter), 13
for offering one-touch reporting
options, 231–232
recording of, 219, 220–223
running of, 224–227
uses of, 219–220
Macros command, 224
Major Unit value, 157
Max option, 130
Maximum value, 157
memory (RAM), 32–33
Merge option, 297
Microsoft Access, 275–282
Microsoft Office, 2, 317
Microsoft OneDrive, 317–320
Min option, 130
Minimum value, 157
mistakes, making of, use of macro to
avoid, 220
mock layouts (of dashboards), 13–14
model map tab, 34
month, creating pivot-driven views
by, 143–145
month-over-month variance view (in
pivot table), 148–150
Move Down option, 298
Move Down option (Power Query), 294
Move to Group option, 298
Move Up option, 294, 298
moving average functionality, 175–176
Multiple Items, 256

• N •

#N/A errors, 241
native programming language, 2
Navigator pane, 287–288
negative numbers, formatting of,
62, 63, 65
New Formatting Rule dialog box, 95–96,
97–98, 223
New Query command, 287
New Rule button, 97
New Slicer Style button, 262
“New York State of Mind” (song), 9
nice-to-know data, 13, 17
No Fill option, 55, 216
non-numeric (text or date)
check box, 121
Number Format button, 129
Number of Bins option, 198
Number tab, 61–62
numbers
alignment of, 58–59
applying custom format
colors to, 66–67
applying numeric formats to data
fields, 129–130
effective formatting of,
19–20, 54, 58–59
formatting of large numbers, 329–330
formatting of negative numbers,
62, 63, 65
formatting of positive numbers,
62, 63
getting fancy with custom
formatting of, 61–68
in thousands and millions,
formatting of, 63–65
use of symbols to create custom
number format, 106
numeric check box, 121

• O •

object model, 2
OK button, 86
OneDrive, distribution of dashboards
via, 317–320
OneDrive account/pane, 317
one-touch reporting options, 231–232
Option Button (Form control),
235, 242–245
options
Adjust Column Width, 282
Append, 298
Average, 130
Bin Width, 198
Close & Load (Power Query), 292
Count, 130
Count Nums, 130
Custom Value, 78
Delete, 294, 297
Delete Until End (Power Query), 294
Do Not Show Subtotals, 132
Duplicate, 297
Edit, 297
Edit Settings (Power Query), 294
file-sharing, 302
file-sharing s, 302
Format Only Cells That
Contain, 95, 98
Format Only Top or Bottom Ranked
Values, 95
Include Row Numbers, 282
Insert Cells for New Data, Delete
Unused Cells, 282
Insert Entire Rows for New Data,
Clear Unused Cells, 282
Load To, 297
Max, 130
Merge, 297
Min, 130
Move Down, 294, 298
Move to Group, 298
Move Up, 298
Move Up (Power Query), 294
No Fill, 55, 216
Number of Bins, 198
one-touch reporting, 231–232
Overflow bin, 199
Overwrite Cells for New Data, Clear
Unused Cells, 282
Preserve Cell Formatting, 282
Preserve Column/Sort/Filter/
Layout, 282
Product, 130
Properties, 298
Reference, 297
Refresh, 297
Rename (Power Query), 294
Send to Data Catalog, 298
Show the Peek, 298
From SQL Server, 283
StdDev, 130
StedDevP, 130
Sum, 130
Top 10, 140
Underflow bin, 199
Value Field Settings, 129
Var, 130
VarP, 130
for worksheet protection, 307–308
Options button, 221, 234, 316
Options dialog box, 316
Options tab, 143
organizational trends, showing
performance against, 202–204
Outline Form (pivot table layout), 126
Overflow bin option, 199
Overwrite Cells for New Data, Clear
Unused Cells option, 282

Parmenter, David (author)
Key Performance Indicators:
Developing, Implementing, and
Using Winning KPIs, 13
passwords, 302–304, 305–308
Paste Link radio button, 310
Paste Special dialog box, 310
pattern fills, 18
PDF (portable document format),
distributing dashboards
via, 315–317
percent contribution, 146
percent distribution view, in pivot
tables, 146–147
percentages, formatting of, 63
performance
  showing of against organizational trends, 202–204
  showing of against target range, 213–216
  showing of with variances, 201–202
pictures, 18
pie chart, 333–334, 341
pivot cache, 126
pivot table reports, 115, 126–139
pivot tables
  adding report filter to, 124
  applying numeric formats to data fields, 129–130
  areas of, 116–118
  changing of layout in, 126–127
  changing/rearranging of, 122–123
  controlling multiple pivot tables with one slicer, 265–266
  creation of first one, 118–126
  creation of useful pivot-driven views, 139–150
  customization of field names in, 127–129
  defined, 115–116
  dynamically rearranging data in using macros, 230–231
  Excel tables as source of, 48
  hiding/showing items without data, 136–138
  keeping fresh, 124–126
  by month, quarter, and year, 143–145
  month-over-month-variance view in, 148–150
  percent distribution view in, 146–147
  removal of grand totals in, 1347
  removal of subtotals for one field in, 133
  showing/hiding data items, 134–136
  sorting in, 138–139
  space/memory implications of, 126
  summary calculations, 130–131
  suppression of subtotals in, 131–134
  tabular datasets as perfect for pivot table-driven data models, 31–32
  top and bottom views in, 139–143
  use of to create histogram, 195–197
  use of to get top and bottom views, 181–184
  YTD totals view in, 147–148
pivot-driven views, creation of ones that are useful, 139–150
PivotTable Field List, 120
PivotTable Fields dialog box, 120, 122–123, 124
PivotTable icon, 119
PivotTable Options dialog box, 134
PivotTable Tools context tab, 127, 131, 143
placement, use of to draw focus, 18–19
positive numbers, formatting of, 62, 63
Power Query, 286–299
PowerPoint, linking of dashboards to, 310–314
Poynter Institute’s Eyetrack III project, 19
pre-defined scenarios (conditional formatting), 84–92
presentation, as separate from data and analysis, 26–28
Preserve Cell Formatting option, 282
Preserve Column/Sort/Filter/Layout option, 282
primary axis, 166
principles, 325–337. See also design principles
priority zones, 19
Product option, 130
Properties dialog box/icon, 296
Properties option, 298
Protect Sheet dialog box, 306
Protect Sheet icon, 306, 308
Protect Structure and Windows dialog box, 309
Protect Workbook icon, 309
protection, of dashboards and reports
applying worksheet
protection, 306–307
limiting access to specific worksheet
ranges, 305–308
permitting read-only access unless
password is given, 302–303
protect sheet elements and
actions, 307–308
protecting workbook
structure, 308–309
removing workbook-level
protection, 304
removing worksheet protection, 308
requiring password to open Excel
file, 303–304
securing access to entire
workbook, 302–304
unlocking editable ranges, 305–306
Protection tab, 305
Publish as PDF or XPS dialog box, 316

• Q •

qualitative bands (on bullet
graphs), 210–211
quarter, creating pivot-driven views
by, 143–145
Query Settings command, 293
Quick Access toolbar, 107, 109
Quick Access Toolbar button, 107

• R •

RAM (memory), 32–33
Range_lookup argument, 37, 40
ranges
autoupdating sparkline ranges, 82
converting Excel tables back to, 49–50
converting of to Excel tables, 47–49
unlocking editable ranges, 305–306
read-only access, 302–303
Record Macro command, 221, 223
Record Macro dialog box, 221–222
Recording your First Macro tab, 220
records, rows corresponding to, 30
reference line, 79–80
Reference option, 297
Refresh option, 297
refresh schedule, 16
refreshing data. See also updating
on pivot tables, 124
Power Query data, 294–296
Remember icon, 5
Rename option (Power Query), 294
repetitive tasks, use of macro for, 219
Report Connections dialog box, 266
Report Layout icon, 127
reports
adding interactivity to. See
interactivity
avoiding fancy formatting. See
formatting
Camera tool as useful for, 107
Camera tool as way to enhance, 110
defined, 9, 10
enhancement of with conditional
formatting, 83–103
format codes for, 68
formatting numbers
effectively in, 19–20
by month and quarters, 143–145
one-touch reporting options, 231–232
pivot table reports, 115, 126–139
pivot tables as potential stars of, 124
problems with, 219–220
protection of, 301–309
report filters, 124
sparklines as adding dimension to
table-based reports, 69–70
spreadsheet reports, as form of
dataset, 29–30
that look “busy,” 17
use of macros to solve problems
with. See macros
using symbols to enhance, 103–107
using titles and labels
effectively in, 20
Review tab, 306, 308, 309
row area (of pivot table), 116–117
Row_index_num argument, 40
ROWS drop zone, 121
rules, 92–96. See also specific rules
Run button, 224

S

SAP, 1
Save As command, 317
Save As dialog box, 302, 303–304, 317
Save Password in File check box, 284
scales. See specific scales
scope, of dashboard, 22
Scroll Bar (Form control), 235
seasonality, 174
secondary axis, trending with, 166–168
Secondary Axis radio button, 167
Segoe UI font, 60
Select Data Source dialog box, 279
Select Locked Cells (worksheet protection), 307
Select Table dialog box, 279–280
Select Unlocked Cells (worksheet protection), 307
Send to Data Catalog option, 298
settings. See specific settings
Settings tab, 39
shadows, 18
Shapes button, 171
Share with People command, 319
shelf life, of dashboard, 22
Shortcut Key field (recording macros), 222
Show tab, 319
Show the Peek option, 298
Show Values As tab, 146, 148, 149–150
side-by-side time
comparisons, 162–164
single accounting underlines, 56
Slicer Settings dialog box, 262, 271
Slicer Style gallery, 262, 264
Slicer Tools Options tab, 262
slicers, 255–272
SMALL function, 187–188
smoothing (of data), 174–177
soft edges, 18
Sort (worksheet protection), 308
sorting
as key factor in readability of data, 60
in pivot tables, 138–139
sorting data before charting, 333
Sparkline Tools tab, 74, 75, 76, 77
sparklines
adjusting axis scaling, 78–79
autoupdating ranges in, 82
as available only with Excel 2010 and Excel 2013, 70
changing colors and line width of, 77
changing type of, 77
creation of, 72–74
customization of, 75–82
defined, 69
eexample showing trending, 70
faking reference lines in, 79–80
groups of, 74
handling hidden or missing
data in, 76
sizing and merging sparkline
cells, 75–76
specifying date axis, 80–82
types of, 71–72
Spin Button (Form control), 235
spreadsheet bloat, 126
spreadsheet reports, as form of dataset, 29–30
SQL Server tables, as external data source, 275
stacked time comparisons, 165–166
staging tables, 27, 248, 249, 253
standard linear scale, 158
Starting At values, 195
statistical charts, 197–199
StdDev option, 130
StdDevP option, 130
Stop Recording command, 223
Store Macro In drop-down menu, 222
Store Macro In field, 222
subtotals, removal/suppression of, 131–134, 133
Subtotals icon, 133
Sum option, 130
summary calculations, 130–131
SUMPRODUCT function, 41–44
Switch Row/Column button, 207
Symbol command, 105
Symbol dialog box, 105
symbols, use of to enhance reporting, 103–107

displaying performance with variances, 201–202
Technical Stuff icon, 5
Text box icon, 170
Text That Contains rule, 85
Theme Colors drop-down, 55
thermometer-style charts, 204–205, 247
3D charts/3D effects, 327
time, emphasizing periods of (in trending charts), 168–173
time comparisons, 162–164
Timeline slicers, 255, 266–269
times, formatting of, 67–68
Times New Roman font, 60
timestamps, 20
Tip icon, 5
titles, effective use of, 20, 332
Tools button, 302, 304
Top 10% dialog box, 89
Top 10 Filter dialog box, 141, 181–183
Top 10 Items rule, 88
Top 10 option, 140
Top 10% rule, 88
top and bottom displays, 179–184
top and bottom views, in pivot tables, 139–143
top values, emphasis of in charts, 184–188
Top/Bottom Rules, 84, 87–89
Totals & Filters tab, 134
trend, defined, 153
trend lines, as chart junk, 328
trending
comparative trending, 162–168
dos and don’ts, 153–162
emphasizing periods of time, 168–173
other techniques in, 173–177
trends, organizational, showing performance against, 202–204
TRUE, 239, 241
trusted document, 228
trusted locations, 228

• T •

Table button, 47
Table feature, 46–47
Table_array argument, 37, 40
tables, 53–60
tabs. See also specific tabs
analysis, 27
data, 27
keeping data model limited to one worksheet tab, 33–34
limitations of using one tab in data model, 33–34
model map, 34
representing months, 26
use of to document/organize data model, 33–34
tabular datasets, 29, 31–32
Tabular Form (pivot table layout), 126
target field, 137
targets
displaying performance against organizational trends, 202–204
displaying performance against target range, 213–216
Trusted Locations button/menu, 228
Tufte, Edward (data visualization pioneer), 327
Type drop-down boxes, 96
Type input box, 62, 63, 64, 67

**U**

Underflow bin option, 199
Underline drop-down menu, 57
underlines, single accounting compared to standard, 56
Unicode characters, 103
Unprotect Sheet icon, 308
Update Links button, 312
updates, book (website), 6
updating
autoupdating sparkline ranges, 82
dashboards, 16
between Excel and Access, 279–281
of pivot tables, 126, 127, 213
PowerPoint presentations
for, 310–314
use of Camera tool in, 213
Use AutoFilter (worksheet protection), 308
Use PivotTable Reports (worksheet protection), 308
user interfaces
interactivity in. See interactivity
interactivity of, 255–272
overly cluttered and ineffective, 16
user requirements, 12–13
UserForms, 227, 234
user-friendliness
of dashboard, 23–24

**V**

Value argument, 45
Value box, 96
Value Field Settings dialog box, 128, 131, 146, 148, 149–150
Value Field Settings option, 129
Value series, 208
values. See also specific values
above-average, 93–94
below-average, 93–948
bottom, 180
data values, 330
Duplicate Values rule, 86
minimum and maximum axis, 79
negative, 77, 80
performance, 213–216
Show Values As tab, 146, 148, 149–150
top, 180, 184–188
trigger, 86, 89
Value Field Settings dialog box, 128, 131, 146, 148, 149–150
Value Field Settings option, 129
VALUES drop zone, 121, 195
values area (of pivot table), 116
VALUES drop zone, 121, 195
#VALUE! error, 42
Var option, 130
variances, showing performance with, 201–202
VarP option, 130
vertical, going of on trending charts, 161
vertical axis (on trending charts), 156–157
Visual Basic colors, 67
Visual Basic for Applications (VBA) code, 219, 220
visualization, defined, 83
VLOOKUP function, 36–39

**W**

waffle charts, 111–114
Warning! icon, 5
Web, limitations when publishing to, 320–321
Web command button, 287
Webdings font, 103
websites
  book updates, 6
  Cheat Sheet, 6
  Dummies, 6
white space, 56
Wingdings font, 103
Win/Loss sparklines, 71, 73, 77, 80
Wizards, Access Export, 277–278
Workbook Connections dialog box, 295
  workbook-level protection, 302–303, 304
workbooks
  limitations when publishing of to Web, 320–321
  limiting access to specific worksheet ranges, 305–308
  protecting structure of, 308–309
  securing access to entire workbook, 302–304
  sharing of, 301–321
worksheet protection, 307–308
worksheet ranges, limiting access to, 305–308

• X •
X icon, 93, 97
xlsm extension, 227
xlsx extension, 227
XY scatter plot chart, 343

• Y •
year, creating pivot-driven views by, 143–145
year-to-date (YTD) totals view, in pivot tables, 147–148
Yes button, 50

• Z •
zeroes, hiding and suppressing of, 65–66
About the Author

Michael Alexander is a Microsoft Certified Application Developer (MCAD) with over 15 years’ experience in consulting and developing office solutions. He is the author of over a dozen books on business analysis using Microsoft Excel and Access. He has been named Microsoft Excel MVP for his contributions to the Excel community. Visit Michael at DataPigTechnologies.com, where he offers free Excel and Access training.
Dedication

To my family.
Author’s Acknowledgments

My deepest thanks go to the professionals at John Wiley & Sons, Inc., for all the hours of work put into bringing this book to life. Thanks also to Mike Talley for suggesting numerous improvements to the examples and text in this book. Finally, a special thank you goes out to Mary for putting up with all the time spent locked away on this project.
Publisher’s Acknowledgments

Acquisitions Editor: Katie Mohr
Senior Project Editor: Paul Levesque
Copy Editor: Becky Whitney
Technical Editor: Mike Talley
Editorial Assistant: Matthew Lowe
Sr. Editorial Assistant: Cherie Case

Production Editor: Selvakumaran Rajendiran
Cover Image: © Getty Images/instamatics
Math & Science
Algebra I For Dummies, 2nd Edition  
978-0-470-55964-2
Anatomy and Physiology For Dummies, 2nd Edition  
978-0-470-92326-9
Astronomy For Dummies, 3rd Edition  
978-1-118-37697-3
Biology For Dummies, 2nd Edition  
978-0-470-59875-7
Chemistry For Dummies, 2nd Edition  
978-1-118-00730-3
1001 Algebra II Practice Problems For Dummies  
978-1-118-44662-1

Music
Blues Harmonica For Dummies  
978-1-118-25269-7
Guitar For Dummies, 3rd Edition  
978-1-118-11554-1
iPod & iTunes For Dummies, 10th Edition  
978-1-118-50864-0

Programming
Beginning Programming with C For Dummies  
978-1-118-73763-7
Excel VBA Programming For Dummies, 3rd Edition  
978-1-118-49037-2
Java For Dummies, 6th Edition  
978-1-118-40780-6

Religion & Inspiration
The Bible For Dummies  
978-0-7645-5296-0
Buddhism For Dummies, 2nd Edition  
978-1-118-02379-2
Catholicism For Dummies, 2nd Edition  
978-1-118-07778-8

Self-Help & Relationships
Beating Sugar Addiction For Dummies  
978-1-118-54645-1
Meditation For Dummies, 3rd Edition  
978-1-118-29144-3

Seniors
Laptops For Seniors For Dummies, 3rd Edition  
978-1-118-71105-7
Computers For Seniors For Dummies, 3rd Edition  
978-1-118-11553-4
iPad For Seniors For Dummies, 6th Edition  
978-1-118-72826-0
Social Security For Dummies  
978-1-118-20573-0

Smartphones & Tablets
Android Phones For Dummies, 2nd Edition  
978-1-118-72030-1
Nexus Tablets For Dummies  
978-1-118-77243-0
Samsung Galaxy S 4 For Dummies  
978-1-118-64222-1

Samsung Galaxy Tabs For Dummies  
978-1-118-77294-2

Test Prep
ACT For Dummies, 5th Edition  
978-1-118-01259-8
ASVAB For Dummies, 3rd Edition  
978-0-470-63760-9
GRE For Dummies, 7th Edition  
978-0-470-88921-3
Officer Candidate Tests For Dummies  
978-0-470-59876-4
Physician’s Assistant Exam For Dummies  
978-1-118-11556-5
Series 7 Exam For Dummies  
978-0-470-09932-2

Windows 8
Windows 8.1 All-in-One For Dummies  
978-1-118-82087-2
Windows 8.1 For Dummies  
978-1-118-82121-3
Windows 8.1 For Dummies, Book + DVD Bundle  
978-1-118-82107-7

Available in print and e-book formats.

Available wherever books are sold. For more information or to order direct visit www.dummies.com
Take Dummies with you everywhere you go!

Whether you are excited about e-books, want more from the web, must have your mobile apps, or are swept up in social media, Dummies makes everything easier.
Leverage the Power

For Dummies is the global leader in the reference category and one of the most trusted and highly regarded brands in the world. No longer just focused on books, customers now have access to the For Dummies content they need in the format they want. Let us help you develop a solution that will fit your brand and help you connect with your customers.

Advertising & Sponsorships

Connect with an engaged audience on a powerful multimedia site, and position your message alongside expert how-to content.

Targeted ads • Video • Email marketing • Microsites • Sweepstakes sponsorship
Custom Publishing

Reach a global audience in any language by creating a solution that will differentiate you from competitors, amplify your message, and encourage customers to make a buying decision.

Apps • Books • eBooks • Video • Audio • Webinars

Brand Licensing & Content

Leverage the strength of the world’s most popular reference brand to reach new audiences and channels of distribution.

For more information, visit www.Dummies.com/biz
Dummies products make life easier!

- DIY
- Consumer Electronics
- Crafts

- Software
- Cookware
- Hobbies

- Videos
- Music
- Games
- and More!

For more information, go to Dummies.com® and search the store by category.
WILEY END USER LICENSE AGREEMENT

Go to www.wiley.com/go/eula to access Wiley’s ebook EULA.